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IMDPlus User 

Manual 

The IMDPlus modal dynamics software option calculates the modal response of a 

system to a given input using calculated eigenmodes and eigenvectors from an 

eigenvalue analysis. (Note that the eigenvalue analysis must have been performed with 

mass normalised eigenmodes.) 

IMDPlus Analysis Types 

There are three types of analysis that can be performed in IMDPlus. These are as 

follows: 

 Seismic Analysis 

A seismic analysis obtains the dynamic response of a structure to acceleration 

time histories of support motion. 

 Moving Load Analysis 

A moving load analysis obtains the dynamic response of a structure to moving 

loads. In a moving load analysis the load can either be explicitly defined or a 

vehicle configuration (composite axle definition) can be used. In both cases the 

magnitude and configuration of the load remains constant throughout the 

analysis. 

 Moving Mass Analysis 

A moving mass analysis obtains the dynamic response of a structure to moving 

masses. In a moving mass analysis spring-mass systems are used in a vehicle 

configuration. Each spring-mass system includes an unsprung mass and up to 

two sprung masses connected by springs and viscous dashpots. The 

configuration of the systems remains constant throughout the analysis but as they 

move across the structure, the dynamic response of the unsprung and sprung 

masses affects the forces acting on the underlying structure due to inertia effects. 

 
All solutions from IMDPlus are carried out in the time domain. 
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IMDPlus Assumptions 

The working assumptions for the IMDPlus modal dynamics facility are as follows: 

 Linear 

The system is linear in terms of geometry, material properties and boundary 

conditions. Therefore geometrically nonlinear eigenvalue results are not 

applicable. Nor are nonlinear joint and slideline analyses suitable for this type of 

post-processing treatment. 

 No Cross-Coupling 

There is no cross-coupling of modes caused by the damping matrix. This is 

reasonable for all but the most highly damped structures or applications. 

 Low Modes Dominant  

The response is dominated by the lowest few modes. 

 Damping Ratios Are Below Critical  

Damping ratios of 100% or more are not permitted due to the solution of the 

time domain response of the structure using either the Hilber–Hughes-Taylor 

(HHT) method or Duhamel’s Integral. 

 Moving Mass Analysis 

The working assumptions for the particular case of a moving mass analysis are 

as follows: 

 No Loss of Contact 

There is no loss of contact between the unsprung masses (wheels) of the spring–

mass systems and the structure at any time during a moving mass analysis. 

 Vertical Motion of Spring-Mass Systems Only 

Only vertical motion of the spring-mass systems is considered in a moving mass 

analysis. 

 Mass of Spring-Mass Systems Not Included in Eigenvalue Solution 

The mass of the spring-mass systems have no effect on the natural frequencies of 

the structure. 

 Recommended Limit on Total Mass of Spring-Mass Systems 

The accuracy of the moving mass solution reduces for light-weight structures or 

structures where the magnitude of the moving mass is similar to the magnitude 

of the structure mass. A literature search recommends that for most solutions of 

this type, the total mass of all the spring-mass systems that are actively 

interacting with the structure at any given time should not exceed 10% of the 

total mass of the underlying structure. 
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Performing IMDPlus Calculations in LUSAS 

The various stages of an IMDPlus analysis are initiated from the Utilities  IMDPlus 

menu or the IMDPlus Toolbar. The basic steps that need to be undertaken for each of 

the three analysis types are as follows: 

Seismic Analysis 

 Select the acceleration time histories 

 Select the eigenmodes to include in the solution 

 Specify the damping for the eigenmodes 

 If required, modify the advanced solution options 

 Specify the frequency interpolation technique and if required, the time step 

 Specify the nodes or elements to process along with the output requirements 

Moving Load Analysis 

 Generate the movement of a discrete load across the structure by using a number 

of distinct locations along the moving load path 

 Calculate the equivalent modal forces for each of these distinct locations 

 If the loading has not been explicitly defined in step 1, define moving load 

vehicle configuration(s) using the positions of the axles/bogies that form a 

vehicle together with the moving load factors to be applied at each position 

 If required, select the moving load vehicle configuration to be used in the 

analysis 

 Select the eigenmodes to include in the solution 

 Specify the damping for the eigenmodes 

 If required, modify the advanced solution options 

 Specify the speed ranges to analyse along with time stepping parameters 

 Specify the nodes or elements to process along with the output requirements 

Moving Mass Analysis 

 Generate the movement of a discrete unit load across the structure by using a 

number of distinct locations along the moving load path 

 Calculate the equivalent modal forces for each of these distinct locations 

 Define spring-mass system property attribute(s) 

 Define moving mass vehicle configuration(s) using the positions of the 

axles/bogies that form a vehicle together with the spring-mass system property 

attribute that is to be used at each position 

 Select the moving mass vehicle configuration to be used in the analysis 
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 If required, include a path surface profile that defines the surface irregularities 

along the length of the moving load path 

 Select the eigenmodes to include in the solution 

 Specify the damping for the eigenmodes 

 If required, modify the advanced solution options 

 If required, modify the path surface profile options 

 Specify the speed ranges to analyse along with time stepping parameters 

 Specify the nodes, elements or spring-mass systems to process and the output 

requirements 

IMDPlus Toolbar 

All of the IMDPlus dialogs can be launched from the Utilities  IMDPlus menu. 

Alternatively, the IMDPlus Toolbar can be activated from the View > Toolbars... 

menu, as shown in the following figure. 

 

The Toolbar has been split into four sections as follows: 

 Analysis Type 

This section allows the IMDPlus analysis type to be selected. Options available 

are as follows: 

 Seismic Analysis 

 Moving Load Analysis 

 Moving Mass Analysis 

Only one of the analysis types can be selected at any time. 
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 IMDPlus Vehicle Attributes 

This section allows IMDPlus attributes to be defined prior to an IMDPlus 

analysis. Options available are as follows: 

 Spring-Mass System Properties 

This button opens the spring-mass system properties dialog. It is only 

available when the analysis type is set to moving mass. 

 Vehicle Configurations 

This button opens either the moving load or moving mass vehicle 

configuration dialog. The dialog launched depends on the analysis type 

selected. The button is only available when the analysis type is set to 

moving load or moving mass. 

 Moving Load Generation and Modal Force Calculator 

This section allows the preliminary steps for a moving load or moving mass 

analysis to be performed. These are the generation of the moving load path and 

the calculation of the modal force history for use in the IMDPlus analysis, as 

follows: 

 Moving Load Generation 

This button opens the moving load generation dialog. It is only available 

when the analysis type is set to moving load or moving mass. 

 Modal Force Calculator 

This button opens the modal force calculator dialog. It is only available 

when the analysis type is set to moving load or moving mass and the 

moving load generation step has already been carried out. 

 Running an IMDPlus Analysis 

This section allows an IMDPlus analysis to be performed. Options available to 

the user are as follows. 

 Analysis Control 

This button opens either the seismic, moving load or moving mass 

analysis control dialog. The dialog launched depends upon the analysis 

type selected. For both moving load and moving mass analysis types the 

button is only available when the modal force calculation has been 

carried out. 
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 Output Control 

This button opens either the seismic, moving load or moving mass output 

control dialog. The dialog launched depends upon the analysis type 

selected. It is only available when an IMDPlus analysis has been carried 

out and results are still available on disk for graphing. 

Seismic Analysis 

The seismic analysis option calculates the response of the structure to an acceleration 

time history applied at the support nodes. Both 2D and 3D structures can be analysed 

but they are restricted to having the acceleration inputs applied in the global X-, Y-

directions and X-, Y- and Z-directions respectively. Only one acceleration time history 

can be specified for each excitation direction and therefore, all support nodes are 

accelerated with the same time history record in this direction. Different acceleration 

records can be applied to each global direction and these can be factored based on 

design code requirements. Up to seven earthquake combinations can be analysed in a 

single IMDPlus analysis. 

The IMDPlus seismic analysis control dialog is accessed from the Utilities > IMDPlus 

> Seismic... menu or from the IMDPlus Toolbar. Ensure the  button is selected to 

choose a seismic analysis and then select the  button to launch the seismic analysis 

control dialog. 
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Earthquake Input 

For two-dimensional structures, earthquake acceleration time history records can be 

applied in the global X- and Y-directions. For three-dimensional structures, an 

additional earthquake acceleration component in the global Z-direction can be applied. 

Permissible input formats for these acceleration records are space delimited, TAB 

delimited or Comma Separated Variable (CSV). 

For all of these input formats, the time step of the acceleration records must be identical 

in all of the earthquake acceleration files. IMDPlus supports the solution of up to seven 

earthquakes at a time with enveloping / averaging of the Secondary Response Spectra 

(SRS). For space or TAB delimited files the number of time steps in each directional 

record for multiple record files must be identical across each of the earthquakes. For 

Comma Separated Variable files, the number of time steps in each directional record 

can vary but the number of time steps in individual earthquakes must be identical. If 

more than one earthquake is present in the record files, the IMDPlus analysis will 

process all valid combinations. 

Sample Acceleration Time History Records 

Space Delimited Single Combination Space Delimited Two Combinations 

0.000  0.0000E+000   0.000  0.0000E+000  0.0000E+000 

0.005 -2.7459E-002   0.005 -2.7459E-002 -4.0070E-005 

0.010 -3.4127E-002   0.010 -3.4127E-002  8.2210E-004 

0.015 -4.0796E-002   0.015 -4.0796E-002  1.2618E-002 

0.020 -4.7464E-002   0.020 -4.7464E-002  1.4741E-002 

0.025 -5.4133E-002   0.025 -5.4133E-002  1.8604E-002 

Mode / Damping Control 

The modes to include in the analysis can be controlled either by the eigenmodes solved 

in the eigenvalue analysis or a subset defined in the mode control. The default option 

when first running an analysis is for all modes to be included in the analysis but 

individual modes can be included or excluded using the following dialog accessed via 

the Modify… button on the seismic analysis control dialog. 
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This dialog also calculates the total participating mass for the included modes. If a 

significant proportion of participating mass is missing, based on the selected modes of 

vibration, a warning will be issued when proceeding with the analysis. Omission of 

modes of vibration with significant mass contributions that can be excited by the input 

acceleration time histories will lead to unreliable solutions. Ideally, total mass 

participations in excess of 90% should be used unless it is guaranteed that the modes of 

vibration associated with any missing mass are at frequencies that cannot be excited. 

The Default damping option allows the user to control the amount of damping used in 

the IMDPlus analysis. If Default damping is selected, all of the modes of vibration 

included in the analysis are forced to have the current default value. The default value is 

set, via the Modify… button on the seismic analysis control dialog. 

 

The Default damping option can only be turned off when viscous damping has been 

included in the eigenvalue analysis. If Default damping is deselected the viscous 

damping present in the eigenvalue analysis is used in the IMDPlus analysis. When 

viscous damping is included in the eigenvalue solution additional options for the 

inclusion of overdamped modes of vibration in the IMDPlus analysis also become 

available. These options are as follows: 

 Ignore overdamped modes 

Modes of vibration with a damping ratio of 100% or more are omitted from the 

IMDPlus solution. 

 Limit overdamped modes to critically damped 

Modes of vibration with a damping ratio of 100% or more are limited to 

99.9999% to allow them to be included in the analysis. 

Frequency Interpolation 

Four interpolation options are available for the interpretation of the acceleration time 

histories in IMDPlus. These are as follows: 

 All frequencies included 

All modes of vibration are included in the analysis even if their frequencies are 

greater than the maximum frequency that may be reliably resolved based on the 

acceleration time history time step (the Nyquist frequency). 
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 Limit frequencies to Nyquist frequency 

All modes of vibration up to and including the Nyquist frequency are included in 

the analysis. Modes of vibration with frequencies in excess of this value are 

discarded. 

 Linear interpolation of records 

Allows for linear interpolation of the earthquake records. The required time step 

is specified by the user for the analysis. 

 Cubic spline interpolation of records 

Allows for cubic spline interpolation of the earthquake records. The required 

time step is specified by the user for the analysis. 

Note. For rapidly varying input acceleration time histories, such as real acceleration 

records measured on site that often have large reversals in acceleration over one or two 

time steps, the cubic spline interpolation should generally not be used. For synthetic 

acceleration time history records, the use of cubic spline interpolation is usually valid 

since the Fourier series used to generate the synthetic records tend to produce smoother 

responses. It is however up to the user to ensure that the method of interpolation used is 

suitable for the analysis being carried out. 

Note. The Nyquist frequency is equal to 1/(2*t) where t is the time step of the 

acceleration time history. 

Advanced Seismic Solution Options 

Advanced solution options can be set via the Modify... button on the seismic analysis 

control dialog. 

 

The options available in a seismic analysis are as follows. The Defaults button resets 

all of the options to the default values. 

 Time integration scheme for structure response 

The implicit time integration scheme used by IMDPlus to calculate the dynamic 

response of the structure. 

 Hilber Hughes Taylor (HHT) 

This is the default time integration scheme and is the same as the method 

used for an implicit transient dynamic analysis in LUSAS. 




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 HHT factor  

The integration constant  used in the HHT integration scheme. For an 

unconditionally stable, second order accurate scheme,  must lie between 

the limits -1/3    0.0. Values of  outside this range cannot be 

specified. The default value of  is 0.0, which reduces the method to the 

Newmark method. Further integration constants  and  are computed 

automatically by IMDPlus using the following equations: 

    
2

1 4      ,     1 2 2         

 Duhamel’s Integral 

This is the time integration method used by IMDPlus in LUSAS 14.7 (and 

earlier versions of LUSAS) and is available as an alternative to the HHT 

integration scheme. 

Moving Load Analysis 

The moving load analysis option obtains the dynamic response of the structure to the 

passage of a moving load along a user defined path. Both 2D and 3D structures can be 

analysed and the magnitude and configuration of the load remains constant throughout 

the entire analysis. Two methods are available for the definition of the moving load 

configuration. These are: 

 Explicit definition 

The complete load configuration is defined through a discrete load definition in 

Modeller. This can be used for analysing the passage of a single load 

configuration across the structure. 

 Composite axle definition 

The complete load configuration consists of a unit load single axle 

configuration, defined as a discrete load definition in Modeller, and a vehicle 

configuration is that is defined separately. The vehicle configuration (composite 

axle definition) method is the recommended approach, as it allows multiple load 

configurations (such as multiple train rolling stock configurations) to be 

analysed rapidly without having to repeat initial steps for the IMDPlus solution. 

Irrespective of the method used, two distinct steps are required to prepare the moving 

load input data for IMDPlus. These two steps are as follows: 

 Generation of the moving load path across the structure 

 Calculation of equivalent modal forces for the moving load path 
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Note. These two steps must be carried out before the first analysis but may be omitted 

from subsequent analyses, if and only if the moving load path, discrete load 

configuration and direction of the moving load do not change between analyses. If any 

of these are modified the moving load path and calculation of equivalent modal forces 

must be carried out again. 

Moving Load Generation 

The moving load generator is used to mimic the passage of a load across a structure by 

automatically setting up a number of static load cases at prescribed locations along a 

single line/arc/spline, or a collection of lines/arcs/splines, which define a single 

continuous path. These load cases can then be used to calculate the modal forces 

equivalent to the applied loading for import into IMDPlus. Before entering the moving 

load generator, the lines/arcs/splines defining the path must be selected and a discrete 

load representing the load configuration that is to be moved across the structure must 

have been defined. 

The definition requirements for this discrete load are governed by the type of moving 

load input that is going to be used in IMDPlus. If the discrete load is going to represent 

the whole load configuration (i.e. a vehicle configuration is not being used) then it must 

contain all of the loading associated with the configuration. However, if the composite 

axle definition method is being used in IMDPlus, this discrete load should represent a 

subset of the overall load configuration and will be used along with the vehicle 

configuration to build up the total load configuration in IMDPlus. 

Explicit Definition of United Kingdom HB Vehicle 

For the LUSAS Bridge option, HB vehicles can be defined from the Bridge > Bridge 

Loading > United Kingdom... menu entry. 

 

After defining a vehicle load, either the initial definition dialog (as shown above) or the 

resulting attribute data can be viewed. This is done by right-clicking on the Attribute 

name in the Attributes Treeview and selecting either the Edit Definition or Edit 

Attribute menu item. Selecting the latter will show the following discrete point load 

data for the above vehicle selection. 


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This discrete point load can now be used to define the passage of the HB vehicle across 

the structure. 

Note. The front of the moving load is always the location with the maximum discrete 

load X co-ordinate. 

Composite Axle Definition of United Kingdom HB Vehicle using a 

Moving Load Vehicle Configuration 

The equivalent composite axle definition of the above HB vehicle can be achieved by 

defining a unit axle of the across carriageway configuration and defining the vehicle 

configuration separately. The following discrete point load defines the unit axle for the 

HB vehicle. 


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The IMDPlus moving load vehicle configuration dialog is used to create or modify 

vehicle configuration attributes for use in a moving load analysis. It is accessed from 

the Utilities > IMDPlus > Moving Load > Vehicle Configuration... menu or from the 

IMDPlus Toolbar. Ensure the  button is selected to choose a moving load analysis 

and then select the  button to launch the moving load vehicle configuration dialog. 

In a moving load vehicle configuration the position (relative to the origin / front of the 

vehicle) of each of the applied loads is defined along with the value of the moving load 

factor to be applied at each position. For the United Kingdom HB vehicle the axle 

positions and load factors shown in the following figure data should be entered into the 

dialog. A meaningful name should be entered into the Name field, for example, 

45Unit_HB_Axles. 
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Note. Care should be taken when defining axle positions (X co-ordinates) in discrete 

load configurations. The path length should be sufficiently longer than the structure to 

ensure that the load configuration correctly arrives onto and departs from the structure. 

In the above example, the path should start at least 4.8 m before the structure and finish 

4.8 m after the structure. 

Note. The front of the moving load vehicle is always the position with the maximum 

co-ordinate. The rear of the vehicle is always the position with the minimum co-

ordinate. 

Note. The positions and loads that define the vehicle configuration can be copied and 

pasted from a Microsoft Excel spreadsheet. This method is demonstrated in the 

IMDPlus Worked Example: Train Induced Vibration of a Bridge. 

Note. Once created vehicle configurations will appear in the Utilities Treeview, from 

where they can be modified or deleted from the model. To modify a vehicle 

configuration either double-click or right-click on the Attribute name in the Utilities 

Treeview and select the Edit Attribute... menu item. 

Note. Vehicle configurations can be easily transferred from one model to another 

using an attribute library file, accessed from the menu File > Import/Export model 

data... 













Moving Load Analysis 

15 

Generation of the Moving Load Discrete Locations 

If a valid continuous path has been selected and a valid discrete load defined then the 

moving load generator can be used to create the static load cases at prescribed locations 

along the path. 

The IMDPlus moving load generation dialog is accessed from the Utilities > IMDPlus 

> Moving Load > Moving Load Generation... menu or from the IMDPlus Toolbar. 

Ensure the  button is selected to choose a moving load analysis and then select the 

 button to launch the moving load generation dialog. 

 

If a search area has been defined then this can be used to correctly assign the moving 

load if there are multiple planes to which the discrete load could be assigned. Project 

onto line or Project over area can be selected depending upon the geometry defining 

the search area. For single deck models, the default search area which encompasses the 

whole structure can be used. Parameters for the inclusion of the load can be accessed 

through the Advanced… button which provides the full application options available 

for discrete loads. These options consist of the inclusion of loads outside the search 

area and the load factor to be applied. 

Having defined the loading options, the load path options can be set based on the 

lines/arcs/splines selected to define the path. The incremental distance controls the 

separation of the discrete load locations used to define the passage of the load across 

the structure. This incremental distance should be positive and sufficiently small to 

capture the movement of the load.  
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Note. Due to the dynamic solution a sufficiently small distance should be used 

between the discrete locations defining the passage of the load to minimise 

oversampling for load locations between those defined. For static analyses, much larger 

distance increments can be used since the incremental movement does not need to be 

close to the time step of the analysis. 

Ideally, the distance increment used for the movement of the load along the path should 

obey the following equation: 

Dist ≤ 10  Minimum Speed  t 

to give a maximum oversample of 10. t is the minimum of the Nyquist time step and 

any user specified time step (t
Nyquist

 = 1/(2*fmax) where fmax is the maximum frequency 

included in the analysis). Larger distance increments can be used but warnings will be 

issued by IMDPlus since the accuracy of the dynamic solution decreases with 

increasing oversampling ratio. Oversampling ratio reduces with increasing speed and 

therefore it is possible that higher oversampling ratios can be used for lower speeds 

where the dynamic excitation is reduced. It is however up to the user to ensure that use 

of higher oversampling ratios for any speed does not adversely affect the solutions to 

the dynamic analysis. 

The moving load path forwards direction is defined by the order of selection of the 

lines, arcs or splines. The path starts at the first line that is connected to only one other 

selected line. If only a single line is selected, the forwards direction of the moving load 

path is defined by the line direction defined in Modeller (Line directions can be 

visualised through the Geometry layer in the Treeview). The direction that the moving 

load travels can be toggled between forwards and backwards relative to the original line 

selection for the generation of the discrete locations. The start and end of the path will 

be displayed along with the number of divisions / increments required for the full 

description. 

The number of load cases per analysis controls the number of load cases for each 

LUSAS analysis used to obtain the loading information. By default this is set to 100 but 

can be increased up to 1000. Options are available to perform a datacheck analysis 

instead of a full static solution. The advantage of using this option is in both speed and 

the amount of disk space required for the LUSAS analyses. IMDPlus itself only 

requires the loading vector information from the datacheck analysis but if static 

solutions are also required for the passage of the moving load this option can be 

switched off. An option is also available not to run the analyses immediately. By default 

the LUSAS analyses will be carried out once the OK button has been clicked. If 

however the user wishes to run a large number of analyses resulting from the moving 

load definition overnight, this option can be switched off and a batch file generated so 

the analyses can be run separately. The original model, associated eigenvalue results 

and static load cases must be loaded prior to proceeding to the next stage of the moving 

load analysis. 


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This can be carried out by running the following two VBScript files which will have 

been generated in the directory \<LUSAS Installation Folder>\Projects\<Model 

Name>\Associated Model Data\<Model Name> 

IMDPlus_Model_Reload.vbs 

Reloads the model and eigenvalue results 

IMDPlus_LoadVector_Load.vbs 

Loads the static results on top of the model and eigenvalue 

Note. If for any reason the model and static load cases need to be loaded for the 

current moving load path and configuration in the future, these two VBScript files can 

be used. 

Modal Force Calculator 

The path and configuration of the moving load should have been defined using the 

moving load generation described previously. The discrete loads at distances along the 

path now need to be converted into equivalent modal forces for import into IMDPlus. 

This is carried out using the modal force calculator.  

The IMDPlus modal force calculator dialog is accessed from the Utilities > IMDPlus > 

Moving Load > Modal Force Calculator... menu or from the IMDPlus Toolbar. 

Ensure the  button is selected to choose a moving load analysis and then select the 

 button to launch the modal force calculator dialog. 

 

On entry, the eigenvalue and static results will be identified and placed into the dialog. 

Multiple eigenvalue results files are supported which allows the solution of structures 

with large numbers of eigenvalues over multiple analyses with frequency / eigenvalue 

ranges. 


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The moving load path options allow the user to change the direction of the load 

movement along the path but this option should not be used unless the load 

configuration is symmetrical. 

Note. Once the moving load generation and modal force calculation have been carried 

out in a moving load analysis, these two steps may be omitted from subsequent 

analyses, even if the analysis type is switched from moving load to moving mass but 

only if the moving load path, discrete load configuration and direction of the moving 

load do not change between analyses. If any of these are modified the moving load path 

and calculation of equivalent modal forces must be carried out again. 

Running the Moving Load Analysis 

An IMDPlus moving load analysis can only be performed if the following steps have 

already been undertaken: 

 The equivalent modal forces have been successfully calculated using the moving 

load generator and the modal force calculator 

 If a composite axle definition is being used at least one moving load vehicle 

configuration has been defined in the model 
  
The IMDPlus moving load analysis control dialog is shown in the following figure. On 

entering moving load analysis control for the first time the dialog will be filled with 

default information shown. 

 

The IMDPlus moving load analysis control dialog is accessed from the Utilities > 

IMDPlus > Moving Load > Moving Load Analysis... menu or from the IMDPlus 
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Toolbar. Ensure the  button is selected to choose a moving load analysis and then 

select the  button to launch the moving load analysis control dialog. 

Moving Load Input 

If a composite axle definition is being used in the analysis a vehicle configuration can 

be included by selecting the checkbox marked Vehicle configuration (Composite axle). 

This will enable the drop-down list that will contain all of the moving load vehicle 

configurations in the model. The required vehicle configuration can be selected for use 

in the IMDPlus analysis, as shown by the example in the following figure. 

 

Note. Although a vehicle configuration (composite axle definition) is designed for 

internal construction of complex loading configurations from a single axle, for example 

defining a complete trainset from a single unit axle, it can also be used to model the 

passage of more than one load configuration across the structure. Each load 

configuration is restricted to having the same plan layout but can have different 

magnitudes governed by the load factors contained in the vehicle configuration. 

Mode / Damping Control 

The modes to include in the analysis can be controlled either by the eigenmodes solved 

in the eigenvalue analysis or a subset defined in the mode control. The default option 

when first running an analysis is for all modes to be included in the analysis but 

individual modes can be included or excluded using the following dialog accessed via 

the Modify… button on the moving load analysis dialog. 
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This dialog also calculates the total participating mass for the included modes. If a 

significant proportion of participating mass is missing based on the selected modes of 

vibration a warning will be issued when proceeding with the analysis. Omission of 

modes of vibration with significant mass contributions that can be excited during the 

analysis will lead to unreliable solutions. Ideally, total mass participations in excess of 

90% should be used unless it is guaranteed that the modes of vibration associated with 

any missing mass are at frequencies that cannot be excited. 

The Default damping option allows the user to control the amount of damping used in 

the IMDPlus analysis. If Default damping is selected, all of the modes of vibration 

included in the analysis are forced to have the current default value. The default value is 

set, via the Modify… button on the moving load analysis control dialog. 

 

The Default damping option can only be turned off when viscous damping has been 

included in the eigenvalue analysis. If Default damping is deselected the viscous 

damping present in the eigenvalue analysis is used in the IMDPlus analysis. When 

viscous damping is included in the eigenvalue solution additional options for the 

inclusion of overdamped modes of vibration in the IMDPlus analysis also become 

available. These options are as follows: 

 Ignore overdamped modes 

Modes of vibration with a damping ratio of 100% or more are omitted from the 

IMDPlus solution. 
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 Limit overdamped modes to critically damped 

Modes of vibration with a damping ratio of 100% or more are limited to 

99.9999% to allow them to be included in the analysis. 

Solution Control 

The speeds and time stepping information are input via the solution control section. The 

input includes a range of speeds for the solution defined using a minimum speed, 

maximum speed and a speed increment. If only a minimum or maximum speed is 

specified then one speed, equal to the value entered, will be analysed for the moving 

load. A quiet time can be specified which allows for the inclusion of a user defined 

length of time after the passage of the load along the path. This enables decay of the 

structural vibration to be analysed. By default, IMDPlus determines the time step 

required for the analysis from the Nyquist time step. This is calculated from the 

maximum frequency included in the analysis. User control over the time step for the 

solution is available by disabling this feature. 

Advanced Moving Load Solution Options 

Advanced solution options can be set via the Modify... button on the moving load 

analysis control dialog. 

 

The options available in a moving load analysis are as follows. The Defaults button 

resets all of the options to the default values. 

 Time integration scheme for structure response 

The implicit time integration scheme used by IMDPlus to calculate the dynamic 

response of the structure. 

 Hilber Hughes Taylor (HHT) 

This is the default time integration scheme and is the same as the method 

used for an implicit transient dynamic analysis in LUSAS. 

 HHT factor  

The integration constant  used in the HHT integration scheme. For an 

unconditionally stable, second order accurate scheme,  must lie between 

the limits -1/3    0.0. Values of  outside this range cannot be 
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specified. The default value of  is 0.0, which reduces the method to the 

Newmark method. Further integration constants  and  are computed 

automatically by IMDPlus using the following equations: 

    
2

1 4      ,     1 2 2         

 Duhamel’s Integral 

This is the time integration method used by IMDPlus in LUSAS 14.7 (and 

earlier versions of LUSAS) and is available as an alternative to the HHT 

integration scheme. 

 Interpolation method for modal forces 

The interpolation method used by IMDPlus to calculate the equivalent modal 

forces from the values obtained at the discrete path locations by the modal force 

calculator. 

 Cubic spline interpolation 

Equivalent modal forces are interpolated using a cubic spline interpolation 

technique. This is the default option. 

 Linear interpolation 

Equivalent modal forces are interpolated using a linear interpolation 

technique. 

Moving Mass Analysis 

The moving mass analysis option obtains the dynamic response of the structure to the 

passage of moving spring-mass systems along a user defined path. Both 2D and 3D 

structures can be analysed. The configuration of the spring-mass systems remains 

constant throughout the analysis but as they move across the structure, the dynamic 

response of the unsprung and sprung masses affects the forces acting on the underlying 

structure due to inertia effects. 

It is important to note the following working assumptions for the case of a moving mass 

analysis: 

 Only vertical motion of the spring-mass systems is considered 

 There is no loss of contact between the unsprung masses (wheels) of the spring–

mass systems and the structure at any time 

 The mass of the spring-mass systems have no effect on the natural frequencies of 

the structure 

 The accuracy of the moving mass solution reduces for light-weight structures or 

structures where the magnitude of the moving mass is similar to the magnitude 

of the structure mass. A literature search recommends that for most solutions of 
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this type, the total mass of all the spring-mass systems that are actively 

interacting with the structure at any given time should not exceed 10% of the 

total mass of the underlying structure. 
  
The following two steps are required to define the moving spring-mass systems that are 

to be used in the analysis: 

 Define the spring-mass system property attribute(s) 

 Define the moving mass vehicle configuration(s) using the positions of the 

axles/bogies that form a vehicle together with the spring-mass system property 

attribute that is to be used at each position 

Two further preliminary steps are required, in a similar manner to a moving load 

analysis, before a moving mass analysis can be undertaken. These generate equivalent 

modal forces by simulating the movement of a discrete unit load across the structure, 

using a number of distinct locations along a moving load path. The two steps are as 

follows: 

 Generation of the moving load path across the structure 

A discrete load representing the unit load configuration for the axles/bogies of 

the vehicle that is to be moved across the structure must be defined. The moving 

load generator is then used to mimic the path of this unit load across the 

structure by automatically setting up a number of static load cases at prescribed 

locations along the path that the vehicle configuration is to follow. 

 Calculation of equivalent modal forces for the moving load path 

The static load cases are used to calculate the modal forces equivalent to the 

applied unit loading for import into IMDPlus. The equivalent modal forces are 

used in IMDPlus together with the loading from the spring-mass systems of the 

vehicle to build up the complete loading configuration applied to the structure. 

Note. Steps 3 and 4 must be carried out before the first analysis but may be omitted 

from subsequent analyses, if and only if the moving load path, discrete unit load 

configuration and direction of the moving load do not change between analyses. If any 

of these are modified the moving load path and calculation of equivalent modal forces 

must be carried out again. 


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Spring-Mass System Properties 

A spring-mass system is represented by a single unsprung mass and up to two sprung 

masses, connected by springs and viscous dashpots, as shown in the following figure. A 

spring-mass system property attribute defines the masses, linear or nonlinear spring 

stiffnesses and viscous damping properties for a spring-mass system. Spring-mass 

system properties are assigned to different initial positions in a moving mass vehicle 

configuration in order to represent all of the axle/bogie locations of an entire vehicle or 

trainset. As these systems move across the structure, the motion of the unsprung and 

sprung masses affects the forces acting on the underlying structure due to inertia effects.  

 

Note. A vehicle or trainset may contain several axle/bogie positions with the same 

spring-mass system properties, that is, masses, spring stiffnesses and viscous damping 

constants. A spring–mass system property attribute can therefore be assigned to 

multiple axle/bogie positions when defining a vehicle configuration. 

 

Different spring behaviour can be modelled ranging from a simple linear elastic spring 

through to more complex nonlinear behaviour. Linear viscous dashpots can be 

optionally included for each of the sprung masses. Nonlinear spring behaviour allows 

for the inclusion of the following spring types. 

Piecewise linear springs 

Piecewise linear springs can be used to model bilinear springs or more general 

nonlinear spring behaviour.  

 







Moving Mass Analysis 

25 

K
s1

C
s1

M
s1

M
u

x
u

x'
s1

x'
s1

-x
u

F

 

Piecewise-linear spring: Nonlinear spring behaviour 

Piecewise linear springs can also be used to simulate stopper systems that limit the 

spring deflections through the inclusion of very high compressive spring stiffnesses 

after a given closure. 
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Piecewise-linear spring: Stopper system to limit deflections 

Polynomial Springs 

Polynomial springs can be used to represent nonlinear spring behaviour using the 

following function: 

  

 

N

a

a

a=1

F C dx
 

  
The total spring force, F, is expressed in terms of the total spring deflection, dx, where 

N is the order of the polynomial and Ca are the polynomial constants. This allows for 

the special cases of rubber springs and ‘C’ springs, as shown in the following figures, 

along with more general spring definitions. 



IMDPlus User Manual 

26 

Note. The polynomial function always passes through the origin of the spring force-

displacement curve. This ensures that the spring force is zero at zero spring 

displacement. 

 

 

Polynomial spring: Rubber Spring F = C1(x’s1-xu) + C3(x’s1-xu)
3 

  

 

Polynomial spring: 'C' Spring F = C1(x’s1-xu) + C2(x’s1-xu)
2
 

Spring Mass System Properties Dialog 

The IMDPlus moving mass spring-mass system properties dialog is used to create or 

modify spring-mass system property attributes for use in a moving mass analysis. It is 

accessed from the Utilities > IMDPlus > Moving Mass > Spring Mass Properties... 

menu or from the IMDPlus Toolbar. Ensure the  button is selected to choose a 

moving mass analysis and then select the  button to launch the moving mass spring-

mass system properties dialog. 


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Options for the spring-mass system are located in the upper left hand corner of the 

dialog. These define the number of sprung masses in the system and allow for the 

optional inclusion of damping and nonlinear spring behaviour. The number of sprung 

masses is controlled by selecting one of the following options from the drop-down list. 

 Unsprung mass only 

 Single sprung mass 

 Double sprung mass 
  
On the left hand side of the dialog a diagram of the chosen spring-mass system is 

displayed.  All property data is input on the right hand side of the dialog as follows: 

 Unsprung and sprung masses 

 Unsprung and sprung masses should be defined in the model mass units 

 If required, the unsprung mass can be set to 0.0 for a Single sprung mass or 

Double sprung mass system 

 If required, the 1st sprung mass can be set to 0.0 for a Double sprung mass 

system 
  
 Elastic spring stiffness 

 Elastic spring stiffnesses are only required if Nonlinear springs has not been 

selected 

 Elastic spring stiffnesses should be defined in the model stiffness units 
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 Viscosity coefficient 

 Viscosity coefficients are only required if Damping has been selected 

 Viscosity coefficients should be defined in the model force*time/length units 

 If required, the viscosity coefficients can be set to 0.0 
  
 Nonlinear springs 

If Nonlinear springs is selected the spring behaviour is defined using either 

polynomial constants or piecewise linear data. 
  

 Polynomial springs 

The spring force-displacement relationship is defined using a polynomial 

function 

 The polynomial constants Ca should be entered in the table where row 1 

defines the linear constant C1, row 2 defines the quadratic constant etc. 

 The polynomial function must have a positive value at a displacement of 

0.0 

 At least one of the polynomial constants must be non zero 

 IMDPlus requires the spring stiffness to always be a positive value. With 

higher order functions the gradient of the force-displacement relationship 

will generally reach a peak and become negative at a limiting 

compressive and/or tensile displacement. In these cases the IMDPlus 

analysis will terminate if the spring displacements ever reach these 

limiting values. 
  

 Piecewise linear springs 

The spring stiffness-deformation relationship is defined using a piecewise 

linear curve 

 Compressive and tensile data is input separately to ensure that the 

resulting force-displacement curves always pass through the origin 
  

 Stiffness 

 Spring stiffnesses should be defined in the model stiffness units 

 Spring stiffnesses must always be defined as a positive value 
  

 Deformation 

 Spring deformations should be defined in the model length units 

 The deformation of the first data point (row 1) of each piecewise 

linear curve must be set to 0.0 

 In compression all deformations must be negative and must be 

monotonically decreasing 

 In tension all deformations must be positive and must be 

monotonically increasing 
  
A meaningful name should be entered into the Name field. 
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Note. Once created spring-mass system properties will appear in the Utilities 

Treeview, from where they can be modified or deleted from the model. To modify a 

spring-mass system property either double-click or right-click on the Attribute name in 

the Utilities Treeview and select the Edit Attribute... menu item. 

Note. Spring-mass system properties can be easily transferred from one model to 

another using an attribute library file, accessed from the menu File > Import/Export 

model data... 

Moving Mass Vehicle Configuration 

The IMDPlus moving mass vehicle configuration dialog is used to create or modify 

vehicle configuration attributes for use in a moving mass analysis. It is accessed from 

the Utilities > IMDPlus > Moving Mass > Vehicle Configuration... menu or from the 

IMDPlus Toolbar. Ensure the  button is selected to choose a moving mass analysis 

and then select the  button to launch the moving mass vehicle configuration dialog. 

 

In an IMDPlus moving mass analysis a vehicle or trainset is represented by a number of 

spring-mass systems. A moving mass vehicle configuration includes the position 

(relative to the origin / front of the vehicle) of the axles/bogies that form the vehicle 

along with the spring-mass system attribute to be used at each position. Each row of the 

Spring-mass system column includes a drop-down list that contains all of the spring-

mass system property attributes in the model. The spring-mass system properties 

required at each position can be selected for use in the vehicle configuration. A spring–

mass system property attribute can be used at multiple positions in a vehicle. An 


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example of a moving mass vehicle configuration is shown in the figure. A meaningful 

name should be entered into the Name field. 

Note. Care should be taken with the definition of the spring-mass system positions. 

The path length should be sufficiently longer than the structure to ensure that the 

vehicle configuration correctly arrives onto and departs from the structure. 

Note. The front of the moving mass vehicle is always the position with the maximum 

co-ordinate. The rear of the vehicle is always the position with the minimum co-

ordinate. 

Note. The positions and spring-mass system identifiers that define the vehicle 

configuration can be copied and pasted from a Microsoft Excel spreadsheet. This 

method is demonstrated in the IMDPlus Worked Example: High Speed Train 

Modelling through Sprung Masses. 

Note. Once created vehicle configurations will appear in the Utilities Treeview, from 

where they can be modified or deleted from the model. To modify a vehicle 

configuration either double-click or right-click on the Attribute name in the Utilities 

Treeview and select the Edit Attribute... menu item. 

Note. Vehicle configurations can be easily transferred from one model to another 

using an attribute library file, accessed from the menu File > Import/Export model 

data... 

Moving Load Generation 

In a moving mass analysis the moving load generator is used to mimic the path of a unit 

load across a structure by automatically setting up a number of static load cases at 

prescribed locations along a single line/arc/spline, or a collection of lines/arcs/splines, 

which define a single continuous path. These load cases are subsequently used to 

calculate the unit modal forces equivalent to the applied unit loading for import into 

IMDPlus, where the unit modal forces are used together with the vertical loading from 

each of the spring-mass systems to obtain the total modal force applied to the structure. 

Note. In a moving mass analysis a discrete unit load must always be used in the 

moving load generator to ensure that the correct loads are applied to the structure 

during the IMDPlus analysis. The discrete unit load is used to calculate the unit modal 

forces that are applied to the structure as the discrete unit load moves along the moving 

load path. These unit modal forces are used in IMDPlus in conjunction with the vertical 

loading from the spring-mass systems of the vehicle configuration to calculate the total 

modal forces applied to the structure. 

Before entering the moving load generator, the lines/arcs/splines defining the path must 

be selected and a discrete load representing the unit load configuration for the 


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axles/bogies of the vehicle that is to be moved across the structure must have been 

defined. Examples of discrete unit loads are shown in the following figures. 

 

 

Generation of the Moving Load Discrete Locations 

The IMDPlus moving load generation dialog is accessed from the Utilities > IMDPlus 

> Moving Mass > Moving Load Generation... menu or from the IMDPlus Toolbar. 

Ensure the  button is selected to choose a moving mass analysis and then select the 

 button to launch the moving load generation dialog. 
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If a valid continuous path has been selected and a valid discrete unit load defined then 

the moving load generator can be used to create the static load cases at prescribed 

locations along the path. 

 

If a search area has been defined then this can be used to correctly assign the moving 

load if there are multiple planes to which the discrete unit load could be assigned. 

Project onto line or Project over area can be selected depending upon the geometry 

defining the search area. For single deck models, the default search area which 

encompasses the whole structure can be used. Parameters for the inclusion of the load 

can be accessed through the Advanced… button which provides the full application 

options available for discrete unit loads. These options consist of the inclusion of loads 

outside the search area and the load factor to be applied. The load factor for a moving 

mass analysis should always be set to 1.0. 

Note. In a moving mass analysis the load factor defined under the Advanced… 

options should always be set to 1.0 as the moving load generator needs to define the 

passage of a discrete unit load across the structure. Any factor other than 1.0 can cause 

the incorrect static and dynamic loads to be calculated during a moving mass analysis.  

Having defined the loading options, the load path options can be set based on the 

lines/arcs/splines selected to define the path. The incremental distance controls the 

separation of the discrete unit load locations used to define the passage of the unit load 

across the structure. This incremental distance should be positive and sufficiently small 

to capture the movement of the load.  

Note. Due to the dynamic solution a sufficiently small distance should be used 

between the discrete locations defining the passage of the unit load to minimise 

oversampling for load locations between those defined. 


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Ideally, the distance increment used for the movement of the unit load along the path 

should obey the following equation: 

Dist ≤ 10  Minimum Speed  t 

to give a maximum oversample of 10. t is the minimum of the Nyquist time step and 

any user specified time step (t
Nyquist

 = 1/(2*fmax) where fmax is the maximum frequency 

included in the analysis). Larger distance increments can be used but warnings will be 

issued by IMDPlus since the accuracy of the dynamic solution decreases with 

increasing oversampling ratio. Oversampling ratio reduces with increasing speed and 

therefore it is possible that higher oversampling ratios can be used for lower speeds 

where the dynamic excitation is reduced. It is however up to the user to ensure that use 

of higher oversampling ratios for any speed does not adversely affect the solutions to 

the dynamic analysis. 

The moving load path forwards direction is defined by the order of selection of the 

lines, arcs or splines. The path starts at the first line that is connected to only one other 

selected line. If only a single line is selected, the forwards direction of the moving load 

path is defined by the line direction defined in Modeller (Line directions can be 

visualised through the Geometry layer in the Treeview). The direction that the moving 

load travels can be toggled between forwards and backwards relative to the original line 

selection for the generation of the discrete locations. The start and end of the path will 

be displayed along with the number of divisions / increments required for the full 

description. 

The number of load cases per analysis controls the number of load cases for each 

LUSAS analysis used to obtain the loading information. By default this is set to 100 but 

can be increased up to 1000. It is recommended that the option to perform a datacheck 

analysis instead of a full static solution is always selected as an IMDPlus moving mass 

analysis only requires the unit loading vector information from the datacheck analysis. 

Note. In a moving mass analysis a full static solution will only take into account the 

loading from the discrete unit load and will not include the total static loading from the 

spring-mass systems of the vehicle configuration. The results of the static analysis will 

therefore not correspond to the total vehicle loading that is going to be applied to the 

structure. 

An option is also available not to run the analyses immediately. By default the LUSAS 

analyses will be carried out once the OK button has been clicked. If however the user 

wishes to run a large number of analyses resulting from the moving load definition 

overnight, this option can be switched off and a batch file generated so the analyses can 

be run separately. The original model, associated eigenvalue results and static load 

cases must be loaded prior to proceeding to the next stage of the moving mass analysis. 

This can be carried out by running the following two VBScript files which will have 

been generated in the directory \<LUSAS Installation Folder>\Projects\<Model 

Name>\Associated Model Data\<Model Name> 
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IMDPlus_Model_Reload.vbs 

Reloads the model and eigenvalue results 

IMDPlus_LoadVector_Load.vbs 

Loads the static results on top of the model and eigenvalue 

Note. If for any reason the model and static load cases need to be loaded for the 

current moving load path and configuration in the future, these two VBScript files can 

be used. 

Modal Force Calculator 

The path and configuration of the moving unit load should have been defined using the 

moving load generation described previously. The discrete unit loads at distances along 

the path now need to be converted into equivalent modal forces for import into 

IMDPlus. This is carried out using the modal force calculator.  

The IMDPlus modal force calculator dialog is accessed from the Utilities > IMDPlus > 

Moving Mass > Modal Force Calculator... menu or from the IMDPlus Toolbar. 

Ensure the  button is selected to choose a moving mass analysis and then select the 

 button to launch the modal force calculator dialog. 

 

On entry, the eigenvalue and static results will be identified and placed into the dialog. 

Multiple eigenvalue results files are supported which allows the solution of structures 

with large numbers of eigenvalues over multiple analyses with frequency / eigenvalue 

ranges. 

The moving load path options allow the user to change the direction of the unit load 

movement along the path but this option should not be used unless the load 

configuration is symmetrical. 

Note. Once the moving load generation and modal force calculation have been carried 

out in a moving mass analysis, these two steps may be omitted from subsequent 











Moving Mass Analysis 

35 

analyses, even if the analysis type is switched from moving mass to moving load but 

only if the moving load path, discrete load configuration and direction of the moving 

load do not change between analyses. If any of these are modified the moving load path 

and calculation of equivalent modal forces must be carried out again. 

Running the Moving Mass Analysis 

An IMDPlus moving mass analysis can only be performed if the following steps have 

already been undertaken: 

 The equivalent modal forces have been successfully calculated using the moving 

load generator and the modal force calculator. A discrete load representing the 

unit load configuration for the axles/bogies of the vehicle that is to be moved 

across the structure must be used in the calculation of the modal forces to ensure 

that the correct loads are applied to the structure during the moving mass 

analysis. 

 At least one moving mass vehicle configuration has been defined in the model 
  
  
The IMDPlus moving mass analysis control dialog is accessed from the Utilities > 

IMDPlus > Moving Mass > Moving Mass Analysis... menu or from the IMDPlus 

Toolbar. Ensure the  button is selected to choose a moving mass analysis and then 

select the  button to launch the moving mass analysis control dialog. 

On entering moving mass analysis control for the first time the dialog will be filled with 

default information, as shown by the example in the following figure. 
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Moving Mass Input 

Vehicle Configuration 

The vehicle configuration drop-down list will contain all of the moving mass vehicle 

configurations in the model. The required vehicle configuration can be selected for use 

in the IMDPlus analysis. 

Path Surface Profile 

The surface roughness of the structure along the path followed by the moving mass 

vehicle can be optionally included via a perturbation of the vertical displacement of the 

structure. This is termed the path surface profile displacement and it is added to the 

displacements of the unsprung masses during the analysis. The path surface profile 

velocity and acceleration vertical components are calculated during the IMDPlus 

analysis and also applied to the unsprung masses for dynamic consistency. 

The path surface profile displacements are defined in a path surface profile file. Select 

the checkbox marked Path surface profile to include a path surface profile file in the 

IMDPlus moving mass analysis. This will enable the Browse... button so that the file 

can be selected, as shown by the example in the following figure. 
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The path surface profile file can contain either space, Comma Separated Variable 

(CSV) or TAB delimited data and must include a piecewise linear displacement vs. 

distance relationship that defines the surface irregularities along the path traversed by 

the moving mass vehicle. An example of a path surface profile is shown in the 

following figure. There should be a total of NPSP lines of data (NPSP defined below) 

in the file. All input data must be valid integer or real numbers and each line of the file 

should contain two data records as follows: 
  
  
For i=1,NPSP 

Disti   PSPi 

End loop over NPSP 
  
  
The path surface profile data is defined as follows: 

 NPSP 

 The number of data points in the path surface profile 

 There must be a minimum of 2 data points in order to define a valid profile 
  
 Disti 

The distance relative to the origin of the moving load path 

 Distances should be defined in the model length units 

 The distance of the first data point must be 0.0 
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 The distances must be defined so that they are monotonically increasing 

 Care should be taken to ensure that the last distance point in the file is equal 

to or greater than the length of the path. If this is not the case an additional 

point is automatically introduced during the IMDPlus analysis with a 

distance equal to the path length and a displacement of 0.0 
  
 PSPi 

The surface irregularity vertical displacement at the distance Disti 

 Displacements should be defined in the model length units 

 The displacement of the first data point must be 0.0 
  
An example of a path surface profile file is shown in the following figure. 

 

  

Mode / Damping Control 

The modes to include in the analysis can be controlled either by the eigenmodes solved 

in the eigenvalue analysis or a subset defined in the mode control. The default option 

when first running an analysis is for all modes to be included in the analysis but 

individual modes can be included or excluded using the following dialog accessed via 

the Modify… button on the moving mass analysis dialog. 
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This dialog also calculates the total participating mass for the included modes. If a 

significant proportion of participating mass is missing based on the selected modes of 

vibration a warning will be issued when proceeding with the analysis. Omission of 

modes of vibration with significant mass contributions that can be excited during the 

analysis will lead to unreliable solutions. Ideally, total mass participations in excess of 

90% should be used unless it is guaranteed that the modes of vibration associated with 

any missing mass are at frequencies that cannot be excited. 

The Default damping option allows the user to control the amount of damping used in 

the IMDPlus analysis. If Default damping is selected, all of the modes of vibration 

included in the analysis are forced to have the current default value. The default value is 

set, via the Modify… button on the moving mass analysis control dialog. 

 

The Default damping option can only be turned off when viscous damping has been 

included in the eigenvalue analysis. If Default damping is deselected the viscous 

damping present in the eigenvalue analysis is used in the IMDPlus analysis. When 

viscous damping is included in the eigenvalue solution additional options for the 

inclusion of overdamped modes of vibration in the IMDPlus analysis also become 

available. These options are as follows: 

 Ignore overdamped modes 

Modes of vibration with a damping ratio of 100% or more are omitted from the 

IMDPlus solution. 
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 Limit overdamped modes to critically damped 

Modes of vibration with a damping ratio of 100% or more are limited to 

99.9999% to allow them to be included in the analysis. 

Solution Control 

The speeds and time stepping information are input via the solution control section. The 

input includes a range of speeds for the solution defined using a minimum speed, 

maximum speed and a speed increment. If only a minimum or maximum speed is 

specified then one speed, equal to the value entered, will be analysed for the vehicle 

configuration selected. A quiet time can be specified which allows for the inclusion of a 

user defined length of time after the passage of the vehicle along the path. This enables 

decay of the structural vibration to be analysed. By default, IMDPlus determines the 

time step required for the analysis from the Nyquist time step. This is calculated from 

the maximum frequency included in the analysis. User control over the time step for the 

solution is available by disabling this feature. 

Advanced Moving Mass Solution Options 

Advanced solution options can be set via the Modify... button on the moving mass 

analysis control dialog. 

 

The options available in a moving mass analysis are as follows. The Defaults button 

resets all of the options to the default values. 

 Time integration scheme for structure response 

The implicit time integration scheme used by IMDPlus to calculate the dynamic 

response of the structure. 

 Hilber Hughes Taylor (HHT) 

This is the default time integration scheme and is the same as the method 

used for an implicit transient dynamic analysis in LUSAS. 



Moving Mass Analysis 

41 

 HHT factor  

The integration constant  used in the HHT integration scheme. For an 

unconditionally stable, second order accurate scheme,  must lie between 

the limits -1/3    0.0. Values of  outside this range cannot be 

specified. The default value of  is 0.0, which reduces the method to the 

Newmark method. Further integration constants  and  are computed 

automatically by IMDPlus using the following equations: 

    
2

1 4      ,     1 2 2         

 Duhamel’s Integral 

This is the time integration method used by IMDPlus in LUSAS 14.7 (and 

earlier versions of LUSAS) and is available as an alternative to the HHT 

integration scheme.  

Note. When Duhamel’s Integral is selected the HHT factor  remains active and can 

still be modified.  In moving mass analysis the HHT scheme is always used to calculate 

the dynamic response of the spring-mass systems, irrespective of the time integration 

scheme selected. The value of  will therefore always have an effect on a moving mass 

analysis. 

 Interpolation method for modal forces 

The interpolation method used by IMDPlus to calculate the equivalent modal 

forces from the values obtained at the discrete path locations by the modal force 

calculator. 

 Cubic spline interpolation 

Equivalent modal forces are interpolated using a cubic spline interpolation 

technique. This is the default option. 

 Linear interpolation 

Equivalent modal forces are interpolated using a linear interpolation 

technique. 

 Control variables for spring-mass system solution 

The variables used to control the solution of the spring-mass systems as they 

move across the structure. 

 Maximum number of iterations 

The maximum number if iterations allowed for the spring-mass system and 

structural solution. The default is 100 iterations per solution attempt. If 

convergence problems occur this value may need to be increased. 


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 Maximum number of solution attempts 

The maximum number of solution attempts allowed during the spring-mass 

system and structural solution for each time step of the analysis. The default 

is 5. If convergence problems occur this value may need to be increased. 

 Convergence tolerance 

The convergence tolerance used for the spring-mass system and structural 

solution. The default is 0.1%. Increasing the convergence tolerance can 

reduce the time taken to perform an analysis but may produce inaccurate 

results. 

 Maximum constant for unsprung mass results update 

The maximum constant, CUSM, used in the calculation of the unsprung mass 

results. The default is 0.5 and the constant must lie between the limits 0.0 < 

CUSM  1.0. Larger values of CUSM can be used to reduce the time taken to 

perform an analysis but may result in convergence problems. If convergence 

problems do occur this value may need to be reduced. 

Path Surface Profile Options 

If a path surface profile has been included in the analysis advanced path surface profile 

options can be set via the Modify... button on the moving mass analysis control dialog. 

 

The path surface profile options are as follows. The Defaults button resets all of the 

options to the default values. 

 Interpolation method for displacements 

The interpolation method used by IMDPlus to calculate the path surface profile 

displacements from the discrete values defined in the path surface profile file. 

 Cubic spline interpolation 

Path surface profile displacements are interpolated using a cubic spline 

interpolation technique. 
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 Linear interpolation 

Path surface profile displacements are interpolated using a linear 

interpolation technique. This is the default option. 

 Start/end point method for velocities and accelerations 

IMDPlus calculates path surface profile velocities and accelerations from the 

displacement data defined in the path surface profile file. In order to calculate 

the complete velocity and acceleration profiles, displacement values beyond the 

extent of the user defined data are required. This option defines the method that 

is used to extrapolate the displacement profile at the start and end times of the 

analysis. 

 
 Use first and last values 

Displacement data is extrapolated using the path surface profile displacement 

values at the start and end of the analysis. This assumes that the displacement 

profile continues indefinitely with the first and last values. This is the default 

option and will be applicable in the majority of analyses. 

 Mirror values about vertical axis 

Displacement data is extrapolated by mirroring it about the vertical axis at 

the start and end of the analysis. For example, this option would be 

applicable where the path surface profile is defined using a cosine function 

which has peak values at the start and end of the analysis. 

 Mirror and reverse values about vertical axis 

Displacement data is extrapolated by mirroring it about the vertical axis at 

the start and end of the analysis and then multiplying the extrapolated data by 

-1. For example, this option would be valid where the path surface profile is 

defined using a sine function with zero displacement at the start and end of 

the analysis. 

Visualising the Results 

Results are extracted from IMDPlus through the output control dialog which is used for 

all of the seismic, moving load and moving mass analysis options. The IMDPlus output 

control dialog is accessed by selecting Next> from the seismic, moving load or moving 

mass analysis control dialogs or by selecting the  button from the IMDPlus 

Toolbar. 

Note. The  button will only be available for selection when an IMDPlus analysis 

has been performed and the results are still available on disk for graphing. 

For a seismic analysis the nodes or elements that are to be analysed are defined, 

together with the type of output that will be generated by IMDPlus. In addition, the 
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Earthquake to graph is selected using the drop-down list next to the Generate graphs 

in Modeller option. Examples of the appearance of the seismic output control dialog 

when processing an individual node or a selection of nodes are illustrated in the 

following figure.      

  

Individual Node Selected Nodes  

Seismic Analysis – Output Control Dialog 

For a moving load analysis the nodes or elements that are to be analysed are defined, 

together with the type of output that will be generated by IMDPlus. In addition, the 

moving load Speed to graph is selected via the list next to the Generate graphs in 

Modeller option. Examples of the appearance of the moving load output control dialog 

when processing an individual element or a selection of elements are illustrated in the 

following figure.      
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Individual Element Selected Elements 

Moving Load Analysis – Output Control Dialog 

For a moving mass analysis the nodes, elements or spring-mass systems that are to be 

analysed are defined, together with the type of output that will be generated by 

IMDPlus. In addition, the moving mass Speed to graph is selected via the list next to 

the Generate graphs in Modeller option. Examples of the appearance of the moving 

mass output control dialog when processing an individual node or an individual spring-

mass system are illustrated in the following figure.      

  

Individual Node Individual Spring-Mass System 

Moving Mass Analysis – Output Control Dialog 



IMDPlus User Manual 

46 

Node / Element Selection 

In this section of the output control dialog the nodes or elements that are to be analysed 

are defined, together with the result entity and component and the type of output that 

will be generated by IMDPlus. 

Processing Individual, Selected or All Nodes or Elements 

The Extent drop-down list includes the following options to determine whether 

individual or multiple, nodes or elements will be processed by IMDPlus. This enables 

results for a chosen set of nodes or elements to be obtained in a single IMDPlus 

analysis. 

 Individual 

Process a single node or element in IMDPlus. This option is always available for 

both Node and Element. With Individual the Node or Element lists are 

enabled and filled with the node numbers or valid IMDPlus element numbers 

selected in the model. Any of the node or element numbers listed can be chosen 

for the analysis or alternatively a valid node or element number can be manually 

specified by the user. 

 Selected 

Process the nodes or valid IMDPlus elements selected in the model. For Node 

this option will be available if nodes have been selected in the model. For 

Element the option will be available if valid IMDPlus elements have been 

selected in the model and they are all the same type. 

 All 

Process all of the nodes or valid IMDPlus elements in the model. For Node this 

option is always available. For Element the option will only be available if all of 

the elements in the model are the same type.  

Note. When analysing multiple elements, using Selected or All, only elements of the 

same type, that is, bar, thick beam, continuum, thick shell or thin shell elements, can be 

included in a set of IMDPlus elements. The element set can, however, contain elements 

with different numbers of Gauss points or nodes. 

Note. When Extent is set to Selected or All the Node, Element and Gauss 

Point/Node/End drop-down lists will not be available for selection. In addition the 

element Gauss Point/Node/End is automatically set to All as multiple elements are 

going to be processed in a single analysis. 

Note. Both Generate graphs in Modeller and Generate textfile output can be used 

when processing multiple node or element objects. With Generate textfile output a 

number of output file formats are supported by IMDPlus to allow import of results into 

graphing packages. These are discussed in the Output Control section presented later. 


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Entity and Component Output 

If Node output is selected, result entities supported are displacements, velocities, 

accelerations, and reactions plus, for moving load and moving mass analyses, dynamic 

amplification factors. The available components placed into the list will depend on the 

nodes chosen for the analysis. In addition to the standard single component output, 

options are also available to output all translational or rotational displacements, 

velocities, accelerations, reactions and dynamic amplification factors (when applicable) 

to the same graph. 

If Element output is selected, the result entities supported are governed by the element 

type chosen. For example, choosing a thick shell element allows selection of the Stress 

resultants (such as Nx, Mx and Sx), Stress (Top/Middle/Bottom) and Strain 

(Top/Middle/Bottom). Depending upon the element type either Gauss point, node or 

end results are available with the ability to select either a single location or All locations 

for an individual element. For a complete list of the output supported refer to the list of 

elements supported by IMDPlus. 

Results for Individual items, Sum of chosen items and Average of 

chosen items 

The Individual items, Sum of chosen items and Average of chosen items options 

determine the type of node or element output that will be generated by IMDPlus, see 

also Response time history and Peak response summary in the following section.  

 Individual items 

This option produces individual results for each of the chosen nodes or element 

Gauss points/nodes/ends. 

 Sum of chosen items 

This option adds together results from the chosen nodes or element Gauss 

points/nodes/ends to give summed node or element time histories from which 

peaks of the summed results are obtained. 

 Average of chosen items 

This option obtains results by first summing the time history results from the 

chosen nodes or element Gauss points/nodes/ends. A simple average of this 

summed result is obtained to give the node or element average time histories 

from which the peak average results are obtained. 

 
Sum of chosen items and Average of chosen items are only available for selection 

when Extent is set to Selected or All. 

Note. Any combination of the options Individual items, Sum of chosen items and 

Average of chosen items can be used in an IMDPlus analysis, although using the 

Individual items option when Extent is set to Selected or All (nodes or elements) may 
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produce a very large number of graphs, depending on the number of nodes or elements 

chosen for processing. 

Note. When processing reactions for a chosen set of nodes, Sum of chosen items and 

Average of chosen items only take into consideration nodes with supported freedoms. 

Note. When processing dynamic amplification factors only averaged results can be 

obtained for a chosen set of nodes as summed results are meaningless for this result 

entity. 

Spring-Mass System Selection (Moving Mass Only) 

This section of the output control dialog is only available in a moving mass analysis. It 

defines the spring-mass system, result and entity that will be processed by IMDPlus. 

Note. Only one of the Node, Element or Spring-mass system radio buttons can be 

selected at any given time. 

Processing Individual or All Spring-Mass Systems 

The Extent drop-down list includes the following options to determine which spring-

mass systems will be processed by IMDPlus. 

 Individual 

Process a single spring-mass system in IMDPlus. With Individual the System list 

is enabled and will contain, in sequential order, all of the system identifiers, 

together with the initial positions for each system and the spring-mass system 

property set used at each position, for the vehicle configuration selected in the 

IMDPlus moving mass analysis control dialog. Any of the spring-mass systems 

listed can be chosen for the analysis. 

 All 

Process all of the spring-mass systems for the vehicle configuration selected in 

the IMDPlus moving mass analysis control dialog. 

Note. When Extent is set to All the System drop-down list will not be available for 

selection. 

Note. Both Generate graphs in Modeller and Generate textfile output can be used 

when processing all of the spring-mass systems. With Generate textfile output a 

number of output file formats are supported by IMDPlus to allow import of results into 

graphing packages. These are discussed in the Output Control section presented later. 

Result and Entity Output 

The Result drop-down list contains the valid result types available for the system(s), 

selected using Extent and System. The result types available for selection depend on 
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number of sprung masses in the system, that is, unsprung mass only, single sprung mass 

or double sprung mass and whether a path surface profile has been included in the 

analysis. Results are generated as the spring-mass system moves across the structure 

and are available for the range of speeds defined in the IMDPlus moving mass analysis 

control dialog. 

 Unsprung mass 

The results for the unsprung mass of the spring-mass system(s). 

 Sprung mass 1 

The results for the 1
st
 sprung mass of the spring-mass system(s). 

 Sprung mass 2 

The results for the 2
nd

 sprung mass of the spring-mass system(s). 

 Contact point 

The structural results at the contact point(s) between the spring-mass system(s) 

and the structure. 

 Path surface profile 

The path surface profile followed by the system(s). These can be used to confirm 

that the user defined path surface profile has been interpreted correctly by 

IMDPlus. 

 
The Entity drop-down list contains the valid entities for the Result type selected. The 

entities available for selection are as follows; 

 Displacement 

The vertical component of displacement for the Result type of the spring-mass 

system(s). 

 Velocity 

The vertical component of velocity for the Result type of the spring-mass 

system(s). 

 Acceleration 

The vertical component of acceleration for the Result type of the spring-mass 

system(s). 

 Position 

The horizontal position of the unsprung mass of spring-mass system(s), relative 

to the initial position of the origin / front of the vehicle. This entity type is only 

available when Result is set to Unsprung mass 

 Force 
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The vertical force applied to the structure by the spring-mass system. This entity 

type is only available when Result is set to Contact point 

Output Control 

The output control section selects the types of results to visualise. Options are: 

 Response time history 

Response time history outputs node or element time history results for the 

selected Entity and Component or spring-mass system time history results for 

the selected Result and Entity. 

Results available include displacements, velocities, accelerations, dynamic 

amplification factors and reactions for nodes, forces/moments, stresses/stress 

resultants and strains/strain resultants for elements and vertical displacement, 

velocity, acceleration, position and force for spring-mass systems. 

For nodes or elements the type(s) of output generated depends on the options 

selected in the node / element selection section of the dialog as follows. 

 Individual items 

Individual time history results for all of the chosen nodes or elements are 

generated. 

 Sum of chosen items 

Summed time history results for the chosen set of nodes or elements are 

generated. 

 Average of chosen items 

Averaged time history results for the chosen set of nodes or elements are 

generated. 

When processing spring-mass systems individual time history results for the 

chosen system(s) are always generated. 

 Peak response summary 

Peak response summary outputs maximum, minimum and/or absolute peak 

results and times for the selected node / element Entity and Component or the 

selected spring-mass system Result and Entity. 

Results available include displacements, velocities, accelerations, dynamic 

amplification factors and reactions for nodes, forces/moments, stresses/stress 

resultants and strains/strain resultants for elements and vertical displacement, 

velocity, acceleration and force for spring-mass systems 

When processing nodes or elements an Envelope of the peak results can also be 

obtained for all components of the current result Entity. These highlight the 
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individual nodes or element Gauss points/nodes/ends in the chosen set of nodes 

or elements where peak results occur for each of the earthquakes or speeds 

analysed. 

For nodes or elements the type(s) of output generated depends on the options 

selected in the node / element selection section of the dialog as follows. 

 Individual output 

Individual peak results for all of the chosen nodes or elements are generated. 

 Sum of chosen items 

Peaks of the summed results for the chosen set of nodes or elements are 

generated. If Envelope has been selected an envelope of the individual peak 

results is also displayed in a Notepad application. 

 Average of chosen items 

Peaks of the averaged results for the chosen set of nodes or elements are 

generated. If Envelope has been selected an envelope of the individual peak 

results is also displayed in a Notepad application. 

When processing spring-mass systems individual peak summary results for the 

chosen system(s) are always generated. 

Note. The options Positive/Negative and Absolute are not available for selection in a 

seismic analysis. 

Note. Peak summaries are not available for spring-mass systems when Result is set to 

Path surface profile or Entity is set to Position 

Note. The option Envelope is only available for selection when either Sum of chosen 

items or Average of chosen items is selected. Envelope is not available when spring-

mass systems are being processed. 

 Secondary response spectra (SRS) 

Secondary response spectra (SRS) outputs secondary response spectra based on 

the acceleration response for nodes. SRS output is not available for 

displacements, velocities, dynamic amplification factors or reactions at nodes 

and is not a valid option for elements or spring-mass systems. SRS output can 

only be used when both Node and Individual items are selected. 

 Modal combination/factor history 

Modal combination/factor history outputs modal factors for the response of the 

structure at each time step of the analysis. The output takes the form of a 

VBScript file which can be imported into Modeller to define Modal 

Combinations of the modes of vibration. 

 Generate graphs in Modeller 


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Generate graphs in Modeller presents the results from the IMDPlus analysis as 

graphs immediately after completion of the analysis. The earthquake or speed to 

graph is selected from the list of available records. 

 Generate textfile output 

Generate textfile output saves the IMDPlus results to the \<LUSAS Installation 

Folder>\Projects\<Model Name>\Associated Model Data\<Model Name> 

directory in text format. These results can be archived or imported into 

additional graphing packages. 

  

Response Time History 

The time history results are computed by IMDPlus for the earthquake or speed 

specified in the output control dialogs shown in the preceding section. Examples of time 

history plots for an individual node and spring-mass system are shown in following 

figures. 

      

  

Seismic Analysis Time History Moving Load Analysis Time History  

  

Moving Mass Analysis Time Histories 

      

Peak Response Summary 

The peak response summaries are computed by IMDPlus for all of the earthquakes or 

speeds included in the analysis. Examples of peak output for an individual node and 

spring-mass system are shown in following figures. 
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Note. Peak response summary graphs can only be generated in a moving load or 

moving mass analysis. For a seismic analysis the results are presented in tabular format. 

     

  

Peak Response Text Output For 

Seismic Analysis 

Peak Response Plot For Moving 

Load Analysis 

  

Peak Response Plots For Moving Mass Analysis 

      

Secondary Response Spectra (SRS) 

Secondary Response Spectra (SRS) are computed for the selected nodes from the time 

history acceleration responses. The damping ratio range for the SRS calculations along 

with the frequency resolution are accessed via the Modify… button. In this dialog the 

minimum and maximum damping ratios can be entered along with the damping ratio 

increment. Control is also provided over the resolution of the SRS results computed.  
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Examples of SRS plots are shown in the following figures: 

      

  

SRS Plot For Seismic Analysis SRS Plot For Moving Load Analysis 

  

Modal Combination/Factor History 

Modal combinaton/factor history outputs modal factors for the response of the structure 

at each time step of the IMDPlus analysis. The modal combination history options are 

accessed via the Options… button. In this dialog the minimum mass participation 

factor percentage to include in the exported modal combinations can be defined. 

 

The output takes the form of a VBScript file which can be imported into Modeller to 

define modal combinations. These combinations can then be used to visualise the 

deformations and produce contour plots of entities other than velocities and 

accelerations, such as the examples shown in the following figures. 


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Note. Importing all modal combinations could take significant time. For inspecting 

key times during the analysis the required combination information can be extracted 

from the original VBScript file and placed into a user defined VBScript file. 

 

Vertical displacement plot for a time of 1.0s 

 

 

Vertical displacement plot for a time of 2.0s 

Generate Textfile Output 

If the option Generate textfile output is selected the results from the IMDPlus analysis 

will remain in the \<LUSAS Installation Folder>\Projects\<Model 

Name>\Associated Model Data\<Model Name> directory after completion of the 
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analysis. This allows the IMDPlus results to be archived and exported to additional 

graphing packages. If graphs are being generated in Modeller, the output format for 

these text files is the default IMDPlus format, which has all of the QA information 

placed in the header of the file and the results written in space delimited format. If 

however the option to Generate graphs in Modeller is switched off additional output 

formats become available via the Options… button which opens the following dialog. 

 

The formats supported are: 

 Fixed width space delimited format (IMDPlus default). Additional options are 

available to exclude the QA headers and set the QA information. 

 Comma Separated Variable (CSV) format. 

 TAB delimited format. 

For all text output formats, the extensions of the files indicate the results entity. The 

following list describes the output file extensions used by IMDPlus: 

*.dsp - Displacements/Rotations 

*.vel - Velocities/Rotational Velocities 

*.acc - Accelerations/Rotational Accelerations 

*.daf - Dynamic Amplification Factors 

*.rct - Force/Moment Reactions 

*.srs - Secondary Response Spectra 

*.fce - Forces/Forces and Moments 

*.str - Stresses/Stress Resultants 

*.stn - Strains/Strain Resultants 

*.pos - Positions of Spring-Mass Systems 

*.cfc - Vertical Forces for Spring-Mass Systems 
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*.sum - Peak response summary 

Elements Supported By IMDPlus 

Results for the following elements can be output and graphed directly from IMDPlus. 

Elements that are excluded from this list and are valid for 2D/3D eigenvalue analyses 

can still be used in an IMDPlus analysis but the results for these unsupported elements 

must be obtained through the modal combinations facility available in IMDPlus. All 

element output follows the default LUSAS Solver output directions (local or global) for 

the element types below. For further information please refer to the LUSAS Element 

Reference Manual. 

 Bar Elements (Gauss Point Results) 

BAR2 - 2D 2-noded Bar 

BRS2 - 3D 2-noded Bar 
  
 Beam Elements (End Results) 

BEAM - 2D Engineering Thick Beam 

BMS3 - 3D Engineering Thick Beam 

BTS3 - 3D Thick Beam 

BMI21 - 3D Thick Beam 

BMI22 - 3D Thick Beam 

BMI31 - 3D Thick Beam 

BMI33 - 3D Thick Beam 
  
 2D Continuum Elements (Gauss Point Results) 

TPM3, TPM6, QPM4, QPM8 - 2D Plane Stress 

QPM4M - 2D Plane Stress (Enhanced Strain) 

TPK6, QPK8 - 2D Plane Stress Crack Tip 

TPN3, TPN6, QPN4, QPN8 - 2D Plane Strain 

QPN4M - 2D Plane Strain (Enhanced Strain) 

TNK6, QNK8 - 2D Plane Strain Crack Tip 
  
 3D Continuum Elements (Gauss Point Results) 

TH4, TH10, PN6, PN12, PN15, 

HX8, HX16, HX20 - 3D Solid 

HX8M - 3D Solid (Enhanced Strain) 
  
 Thin Shell Elements (Nodal Results) 

TS3, QSI4 - 3D Flat Thin Shell 

SHI4 - 3D Flat Thin Box Shell 
  
 Thick Shell Elements (Gauss Point Results) 
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TTS3, TTS6, QTS4, QTS8 - 3D Thick Shell 
  
 Joint Elements (Gauss Point Results) 

JNT3 - 2D Joint Element for Bars, Plane Stress and Plane Strain 

JPH3 - 2D Joint Element for Engineering Beams 

JNT4 - 3D Joint Element for Bars and Solids 

JSH4 - 3D Joint Element for Engineering Beams and Shells 
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Seismic Analysis of 

a 2D Frame (Time 

Domain) 

For software product(s):  All 

With product option(s): IMDPlus 

Note: The example exceeds the limits of the LUSAS Teaching and Training Version. 

Description 

This example examines 

the seismic response of 

a 2D plane frame 

founded on an elastic 

medium. The model is 

an extension of the 

Seismic Response of a 

Plane Frame example. 

Units used are N, m, 

kg, s, C throughout. 

 

Objectives 

The output requirements of the analysis are: 

 Displacements, velocities and accelerations at the top of the tower 

 Secondary response spectra at the top of the tower 

 Forces and moments in a column at the base of the tower 

 Average forces/moments and peak forces/moments from all of the columns at 

the base of the tower 
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Keywords 

Seismic, time domain, response, mass participation, interactive modal dynamics, 

excitation, eigenvalue, Secondary Response Spectra. 

  

Associated Files 

 IMDPlus 2D Tower.mdl  Model file of the structure. 

 horizontal.prn and vertical.prn  define horizontal and vertical 

earthquake accelerations. These two files contain two earthquake records each; 

one for the 1940 El Centro earthquake and one for the 1994 Northridge 

earthquake. 
 

Discussion 

The Seismic Response of a Plane Frame is revisited in this example. The frame is 

founded in a plane strain elastic medium and the response of the structure is evaluated 

in the time domain using IMDPlus. 

The model is comprised of thick beam elements for the concrete columns, beam 

members, and steel diagonal bracing members, which have pinned end connections. 

The number of beam elements representing the components of the structure has been 

increased from 1 per line to 4 per line to provide greater definition of the deformed 

shapes. In addition to this modification, all support restraints have been removed from 

the frame and an additional 4.5 m length has been added to the base of each column to 

allow embedment of the column bases into the elastic medium. 

The elastic medium is modelled as a 108m by 20m block which is fully restrained along 

its base and with cyclic translation constraints assigned to the sides. These constraints 

provide support to the sides of the elastic medium without the need to apply physical 

restraints, thus allowing direct and shear behaviours in the elastic medium. 

The seismic response analysis is performed in two distinct stages. A natural frequency 

analysis is performed first. This is used to calculate the first 50 natural modes of 

vibration of the combined structure and elastic medium. The eigenvalues, frequencies 

and eigenvectors (mode shapes) are stored and used in the subsequent IMDPlus 

analysis. Although the natural frequencies are obtained from an eigenvalue analysis any 

information regarding the magnitudes of deformations or stresses / moments is non-

quantitative. 

The second phase of the analysis utilises the IMDPlus option which performs enhanced 

time domain solutions using Interactive Modal Dynamics (IMD). This is an alternative 

to performing a spectral response analysis and allows the excitation of the structure 

using acceleration time histories instead of spectral excitation curves. 

In the IMDPlus solution, the structure is subjected to a support condition excitation 

governed by time histories of acceleration in the model global axes. In this example this 
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is assumed to act along the base of the elastic medium in the form of horizontal and 

vertical accelerations. It should, however, be noted that no deconvolution of the records 

has been carried out to convert the surface responses recorded for these earthquakes to 

at-depth acceleration time histories to be input into the analysis. As a consequence, the 

ground level accelerations in the analysis will not correspond to the measured values. 

As stated previously, two earthquake records are used in the analysis, the first being the 

1940 El Centro earthquake and the second being the 1994 Northridge earthquake. The 

two earthquake responses are computed during a single analysis. Only the first 10 

seconds of each seismic event is analysed in this example. 

Modelling 

Running LUSAS Modeller 

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller 

in the Examples Manual Introduction. 

Building and loading the model 

 To create the model, open the file IMDPlus 2D Tower.mdl located in the 

\<LUSAS Installation Folder>\Examples\Modeller
 

directory. Click the OK 

button if the Open File From Previous Version dialog appears. 

After a short while the following view of the model of the building will be displayed. 

 

File 

Open… 
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 In the \<LUSAS Installation Folder>\Projects\ folder create a new directory 

called IMDPlus 2D Tower 

 Save the model into this new folder as IMDPlus 2D Tower. This helps keep all 

relevant IMDPlus created files separate from other analyses and is good practice. 

Note.  No static structural loading is required for this analysis because only the 

dynamic loading is considered during the results processing based on the results from 

the natural frequency analysis. 

The modelling will now be completed by defining the controls necessary to extract the 

natural frequencies. 

Defining Eigenvalue Controls 

Eigenvalue controls are defined as properties of the loadcase. 

 In the  Treeview expand Analysis 1 then right-click on Loadcase 1 and select 

Eigenvalue from the Controls menu.  

The Eigenvalue dialog will appear. 

 Set the Number of eigenvalues as 50 

 Ensure the Shift to be applied is set as 0 

 Ensure the Type of eigensolver is set as Default 

Note.  Eigenvalue normalisation is set to Mass by default. This is essential if the 

eigenvectors are to be used for subsequent IMD analysis. 

 Click the OK button to finish. 

 

 Save the model file. 

Running the Analysis 

 With the model loaded click the Solve button  and the Solve Now dialog will be 

displayed. 

 Click the OK button to run the analysis. 

A LUSAS Datafile will be created from the model information. The LUSAS Solver 

uses this datafile to perform the analysis. 

File 

Save As… 


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File 

Save 
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Viewing the Results 

If the analysis was run from within LUSAS Modeller the results will be loaded on top 

of the current model and the loadcase results for each eigenvalue can be seen in the 

Loadcase panel of the Treeview. Eigenvalue 1 is set to be active by default. 

Plotting Mode Shapes 

 Turn off the display of the Mesh, Geometry and Attributes layers in the  

Treeview. 

 With no features selected click the right-hand mouse button in a blank part of the 

graphics window and select the Deformed mesh option to add the deformed mesh 

layer to the  Treeview. Select the Visualise tab and turn off the Beam end 

releases option. Click the OK button to accept the remaining default values and 

display the deformed mesh for Eigenvalue 1. 

 At the bottom of the  Treeview select the Window summary option and click 

the Details... button. In the Window summary properties dialog set the position to 

(50,-10) and click the OK button to return to the graphics window. 

 

Note.  The mode shape may be inverted. This is because the sense is arbitrary since 

during vibration the deformed shape will appear in both directions. 

Note.  The window summary displays the values of the eigenvalue and the natural 

frequency and also a value for displacement at a node. It should be noted that the 


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displacement value is non-quantitative and is related to the amount of mass in a 

particular mode using the mass normalisation technique. Therefore the only items that 

can be found using a basic eigenvalue analysis are the frequency and the mode shape.  

By setting each Eigenvalue to be active the deformed mesh can be seen for all mode 

shapes. 

 In the  Treeview right-click on Eigenvalue 2 and select the Set Active option. 

The deformed mesh plot for Eigenvalue 2 will be displayed.  

Printing Eigenvalue Results 

Eigenvalue results for the whole structure can be displayed in the Text Output window. 

 Select Active and press Next 

 Select entity None of type Eigenvalues and click Finish 

The Eigenvalue results will be printed to the Text Output window. For inspection only 

the first 10 modes are shown here. Error norms may vary. 

     MODE    EIGENVALUE      FREQUENCY       ERROR NORM 

        1     143.134         1.90411        0.108045E-10 

        2     1479.54         6.12185        0.402905E-06 

        3     7142.50         13.4507        0.142970E-09 

        4     11469.1         17.0445        0.834811E-09 

        5     13603.1         18.5626        0.131186E-08 

        6     15305.2         19.6897        0.147175E-06 

        7     22093.1         23.6564        0.464346E-06 

        8     23569.4         24.4340        0.139975E-06 

        9     23646.6         24.4740        0.179723E-06 

       10     23787.5         24.5468        0.627557E-06 

Note.  The frequency in Hertz can be obtained by dividing the square root of the 

eigenvalue by 2, and the period of vibration in seconds is obtained using the reciprocal 

of frequency (1/frequency). Values of error norm may vary from those shown. 

Caution.  The system eigenvectors have been normalised (in this case with respect to 

mass) therefore any derived quantities such as displacement and moment are also 

normalised and are not true design values. 

 Close the text window by selecting the close button in the top right-hand corner of 

the window. 

Utilities 

Print Results 
Wizard… 
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Checking the Mass Participation Factor 

Note.  In order to carry out a successful IMDPlus analysis you should ensure that a 

significant proportion of the total mass has been accounted for in the analysis. This 

requires checking that around 90% of the total mass has been achieved in the global 

directions. If less than 90% has been achieved no further modes need to be included, if 

and only if, the modes of vibration omitted cannot be excited by the input acceleration 

time histories or a significant proportion of the structure is restrained by support in 

these directions and therefore cannot participate in the modes of vibration. The 

acceptability of the included modes of vibration will vary from analysis to analysis but 

failure to check that a significant proportion of the total mass has been accounted for 

may lead to important modes being missed and subsequent errors in the analysis results.   

 After selecting Active, ensure Sum Mass Participation Factors is displayed in the 

Type combo box and click Finish.  The Sum Mass Participation Factors results will 

be printed to the Text Output window. 

For inspection only modes 40 to 50 will be printed here. It can be seen that the 90% 

value has not been achieved and is discussed below. 

     MODE    SUM MASS X     SUM MASS Y       SUM MASS Z 

       40    0.812738        0.589605         0.00000 

       41    0.812738        0.668202         0.00000 

       42    0.812738        0.754026         0.00000 

       43    0.812739        0.754159         0.00000 

       44    0.812741        0.754160         0.00000 

       45    0.812744        0.757374         0.00000 

       46    0.812745        0.788122         0.00000 

       47    0.812747        0.788903         0.00000 

       48    0.812760        0.789672         0.00000 

       49    0.812760        0.789674         0.00000 

       50    0.812760        0.789731         0.00000 

Note.  In this analysis, a significant proportion of mass is restrained along the base of 

the elastic medium. For the 50 modes of vibration, 81.27% and 78.97% of the total 

mass is achieved in the horizontal and vertical directions. In order to achieve 90% total 

mass in both the horizontal and vertical directions 160 modes of vibration with an upper 

frequency equivalent to 97.2 Hz would actually be required. However, for the purposes 

of this example, the number of modes of vibration has been restricted to 50. 

 Close the text window by selecting the close button in the top right hand corner of 

the window. 

 Use the maximise button to increase the size of the graphics window. 



Utilities 

Print Results 
Wizard… 
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Seismic Response Analysis 

Seismic response calculations are performed using the IMDPlus (Interactive Modal 

Dynamics) facility.  This involves defining the excitation and specifying the results 

required. Initially, in this example, the response of the node at the top-right corner of 

the tower will be investigated. 

Note.  With a seismic response analysis, additional damping information may also be 

set. Unlike results from a natural frequency analysis, the output values obtained from a 

seismic response are design values. 

 Turn off the display of the Deformed Mesh layer in the  Treeview. 

 In the  Treeview double-click on the Mesh layer name. Select the Visualise tab 

and turn off the Beam end releases option. Click the OK button to accept all other 

settings. This will turn on the layer in the graphics window. 

 Zoom-in to the top of 

the tower and select 

only the top-right 

node. 

The main tower members 

have been meshed with 4 

line mesh divisions so 

each line will have 3 

nodes along its length in 

addition to one at either 

end. 

 

Defining the Seismic Parameters 

Note.  To simplify the use of IMDPlus (and provide an alternative to picking 

IMDPlus menu selections from the Utilities menu) for the rest of the example it is 

recommended that the IMDPlus toolbar is enabled in LUSAS Modeller. To do this 

select the View > Toolbars... menu command and enable the IMDPlus option in the 

list and click Close. 

 If the IMDPlus toolbar has been enabled then click on the  Seismic analysis 

button to enable the other relevant toolbar buttons (the seismic tool button) shortcuts 

to the IMDPlus dialogs. 

 



Select this node
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 Open the IMDPlus Seismic Analysis Control dialog through the menu or click on 

the  button in the toolbar. 

The input for the seismic analysis is defined on the IMDPlus Seismic Analysis Control 

dialog. The input consists of the earthquake acceleration records, included modes and 

damping along with interpolation options. 

 

 In the Earthquake Input section, for the X-Direction Earthquake Record(s) 

browse to the \<Lusas Installation Folder>\Examples\Modeller directory and 

select horizontal.prn 

 For the Y-Direction Earthquake Record(s) browse to the \<Lusas Installation 

Folder>\Examples\Modeller directory and select vertical.prn 

 Ensure the Direction Factors in the X and Y directions are set to 1 and 0.66667 

 In the Mode/Damping Control section, ensure Included modes is set to All. If this 

is not the case, click on the Modify… button and turn the All modes option on. 

 Ensure Default damping (5%) is selected. If a different damping is displayed, click 

on the Modify… button and set the Default damping to 5 

Utilities 

IMDPlus  >  

Seismic... 
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 In the Frequency Interpolation section, click on the Modify... button to change the 

advanced solution options. Click the Defaults button to set the default options and 

click the OK button. 

 Ensure the All frequencies included option is selected. 

 Click the Next button to proceed to the IMDPlus Output Control dialog. When 

prompted that less than 90% total mass participation has been detected choose Yes 

since we are aware of this (see Checking the Mass Participation Factor). 

The IMDPlus Output Control dialog will then be displayed.  

Notes relating to the IMDPlus Seismic Analysis Control dialog 

On the Seismic Analysis Control dialog the Browse buttons can be used instead of 

entering the directional earthquake file names. As each file is loaded, the contents are 

checked to ensure that they are in the correct format. 

Under the Modify dialog for the modes, individual modes can be included or excluded 

from the seismic analysis and total mass participations for the excitation directions are 

reported.  

Under the Modify dialog for the damping, control over the inclusion of over-damped 

modes can be adjusted if viscous modal damping has been included in the original 

eigenvalue analysis. To include viscous modal damping, Rayleigh damping parameters 

must be defined in the material properties assigned to the model or a separate damping 

attribute defined and assigned to the model. This allows direct mirroring of step-by-step 

dynamic solutions and the inclusion of frequency dependent damping. 

Under the Modify dialog for the advanced solution options, the time integration scheme 

used in the IMDPlus analysis can be selected. Either a Hilber Hughes Taylor (HHT) 

scheme or Duhamel’s integral can be utilised. 

Four methods of interpolation are available in IMDPlus. The default All frequencies 

included will solve the seismic analysis using all of the frequencies included in the 

eigenvalue analysis. Limit frequencies to Nyquist frequency will limit the included 

frequencies to the Nyquist frequency which is governed by the time step of the 

earthquake records and defined as 1/2t. Linear interpolation of records allows the 

specification of an alternative time step for the analysis where the earthquake records 

are linearly interpolated to this time step. Cubic spline interpolation of records allows 

the specification of an alternative time step for the analysis where the earthquake 

records are interpolated with a cubic spline to this time step. This last form of 

interpolation should generally not be used for measured earthquake records as it can 

smooth the peak responses but is often more appropriate for synthesised earthquake 

records. 
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Displacement Plots 

The displacement of the top of the tower will be investigated initially. Enter the 

following information into the IMDPlus Output Control dialog. 

 Select Node and select Extent as Individual 

 Choose Node number 939 from the drop-down list (or your node number if 

different). This is the node at the top-right of the tower. 

 Select results entity Displacement and component DX & DY 

 Ensure Individual items is selected. Sum of chosen items and Average of chosen 

items will not be available as an individual node is being processed. 

 Ensure Response time history is selected. 

 Select Peak response summary 

 Ensure Generate graphs in Modeller is selected and specify the Earthquake to 

graph as 1 

The dialog should look like this: 

 



Seismic Analysis of a 2D Frame (Time Domain) 

 70 

 Click the Apply button to proceed. 

An IMDPlus analysis will run and after a short while the horizontal (DX) and vertical 

(DY) displacements for the point at the top of the tower are displayed on the graph for 

the first 10 seconds of the 1940 El Centro earthquake. (Earthquake 1) 

Peak displacements are also output to Notepad and indicate absolute peak 

displacements of 0.085 m in the X-direction, 0.006 m in the Y-direction, a peak rotation 

of 0.003 radians and an absolute peak resultant displacement of 0.086 m (Record 1). 

 

 

Note.  Displacements are relative to the supports. 

 

 Close the Notepad application and graph window. 
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If the IMDPlus toolbar has been enabled, 

 Click on the  button in the toolbar to open the IMDPlus Output Control dialog 

If the IMDPlus toolbar is not enabled, 

 Open the IMDPlus Seismic Analysis Control dialog through the menu and click 

Next > to keep the existing analysis control settings and open the IMDPlus Output 

Control dialog. 

In the IMDPlus analysis we have analysed two earthquake combinations at the same 

time. We are therefore also interested in the displacement response of the top of the 

tower for the second earthquake.  

Enter the following information into the IMDPlus Output Control dialog: 

 Select earthquake 2 in the Earthquake to graph list box. 

 Click the Apply button to proceed. 

The horizontal (DX) and vertical (DY) displacements for the point at the top of the 

tower are displayed on the graph for the first 10 seconds of the 1994 Northridge 

earthquake. Peak displacements are also output to Notepad and indicate absolute peak 

displacements of 0.026 m in the X-direction, 0.002 m in the Y-direction, a peak rotation 

of 0.001 radians and an absolute peak resultant displacement of 0.026 m (Record 2).  

 

Utilities 

IMDPlus  >  

Seismic... 
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 Close the Notepad application and graph window. 

If the IMDPlus toolbar has been enabled, 

 Click on the  button in the toolbar to open the IMDPlus Output Control dialog 

If the IMDPlus toolbar is not enabled, 

 Open the IMDPlus Seismic Analysis Control dialog through the menu and click 

Next > to keep the existing analysis control settings and open the IMDPlus Output 

Control dialog. 

Velocity Plots 

In addition to the displacement response of the top of the tower we are also interested in 

the velocities experienced by the tower. Enter the following information into the output 

control dialog. 

 Select Velocity results of VX & VY 

 Select earthquake 1 in the Earthquake to graph list box 

 Click Apply to proceed 

The horizontal (VX) and vertical (VY) velocities of the top of the tower are displayed 

on the graph for the first 10 seconds of the 1940 El Centro earthquake. Peak velocities 

are also output to Notepad and indicate absolute peak velocities of 1.13 m/s in the X-

direction, 0.085 m/s in the Y-direction, a peak rotational velocity of 0.039 rad/s and an 

absolute peak resultant velocity of 1.13 m/s (Record 1). 

Utilities 

IMDPlus  >  

Seismic... 
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Note.  Velocities are relative to the supports. 

 

 Close the Notepad application and graph window. 

If the IMDPlus toolbar has been enabled, 

 Click on the  button in the toolbar to open the IMDPlus Output Control dialog 

If the IMDPlus toolbar is not enabled, 

 Open the IMDPlus Seismic Analysis Control dialog through the menu and click 

Next > to keep the existing analysis control settings and open the IMDPlus Output 

Control dialog. 


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IMDPlus  >  

Seismic... 
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Acceleration and Secondary Response Spectra Plots 

The acceleration response of the top of the tower is now required. Enter the following 

information into the output control dialog. 

 Select Acceleration results of AX & AY  

 Select Secondary Response Spectra (SRS) 

 Click on the Modify… button to bring up the SRS Control dialog. 

 On the SRS Control dialog set the Minimum damping and Maximum damping to 

5.0 and the Damping increment to 0.0 

 Click the OK button and Yes to confirm that only a single damping ratio is to be 

used 

 Click the Apply button to proceed.  

 When the IMDPlus analysis is finished select No when asked whether to show 

average, maximum and minimum SRS envelopes. 

The horizontal (AX) and vertical (AY) accelerations of the top of the tower are 

displayed on the graph for the first 10 seconds of the 1940 El Centro earthquake. Peak 

accelerations are also output to Notepad and indicate absolute peak accelerations of 

15.089 m/s
2
 in the X-direction, 5.937 m/s

2
 in the Y-direction, a peak rotational 

acceleration of 1.56 rad/s
2
 and an absolute peak acceleration of 15.24 m/s

2
 (Record 1). 
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Secondary Response Spectra are also generated for the horizontal and vertical 

directions in two additional graphs. These graphs represent the peak acceleration 

responses of a range of single degree of freedom oscillators with known natural 

frequencies and damping should they be attached to the node at the top of the tower. 
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 Close the Notepad application and graph windows. 

Displaying Individual Element Results 

In the previous section the displacement, velocity and acceleration response of the top 

of the tower were investigated. Now, forces and moments in one of the columns of the 

structure at ground level will be evaluated.  

 In the LUSAS graphics window re-

size the display to show the whole tower. 

 Zoom-in to the base of the tower and 

select the element immediately above 

ground level in the second column from 

the right. 

The main tower members have been 

meshed with 4 line mesh divisions so each 

line will have 4 elements along its length. 

 Click on the  button in the toolbar to open the IMDPlus Output Control dialog 

If the IMDPlus toolbar is not enabled, 

 Open the IMDPlus Seismic Analysis Control dialog through the menu and click 

Next > to keep the existing analysis control settings and open the IMDPlus Output 

Control dialog. 

Enter the following information into the IMDPlus Output Control dialog: 

Select this element

 

Utilities 

IMDPlus  >  

Seismic... 
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 Select Element and ensure Extent remains selected as Individual 

 Choose Element number 656 from the drop-down list (or your element number if 

different). 

 Select element End number 2 which corresponds to the ground level. (Note that line 

directions can be viewed to ascertain which is end 1 or end 2 of a line). 

 Select Force/Moment - Thick 2D Beam results of Fx 

 Ensure Individual items remains selected. Sum of chosen items and Average of 

chosen items will not be available as an individual element is being processed. 

 Deselect Peak response summary 

 Click the Apply button to proceed. 

The time history of the axial force (in N) in the column is displayed on the graph for the 

first 10 seconds of the 1940 El Centro earthquake. Similar graphs can also be generated 

for the shear force and bending moment by selecting Fy (in N) and Mz (in Nm) from 

the output control dialog. 

 

 Close the graph window. 

 Click on the  button in the toolbar to open the IMDPlus Output Control dialog 

If the IMDPlus toolbar is not enabled, 

 Open the IMDPlus Seismic Analysis Control dialog through the menu and click 

Next > to keep the existing analysis control settings and open the IMDPlus Output 

Control dialog. 

Utilities 

IMDPlus  >  

Seismic... 
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 Select Force/Moment - Thick 2D Beam results of Fy 

 Click the Apply button to proceed. 

 

 Close the graph window. 

 Click on the  button in the toolbar to open the IMDPlus Output Control dialog 

If the IMDPlus toolbar is not enabled, 

 Open the IMDPlus Seismic Analysis Control dialog through the menu and click 

Next > to keep the existing analysis control settings and open the IMDPlus Output 

Control dialog. 

 Select Force/Moment - Thick 2D Beam results of Mz 

 Click the Finish button to finish output processing of the individual element results. 

 Click Yes when asked whether to free up disk space by deleting the temporary files 

created by IMDPlus. 

Utilities 

IMDPlus  >  

Seismic... 
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 Close the graph window. 

Displaying Results for a Selected Set of Elements 

The example analyses presented in the previous sections have all utilised individual 

nodes or elements of the structure. In this section a set of beam elements will be 

selected and analysed in order to evaluate the average forces/moments and peak 

forces/moments from the bases of all the columns of the tower. 

 In the LUSAS graphics window re-size the display to show the whole tower. 

 With no features selected click the right-hand mouse button in a blank part of the 

graphics window and select the Labels option to add the labels to the Treeview. 

 On the Properties dialog select the Element > Name check box and the Label 

selected items only check box.  

 Click the Font... button and select Font: Arial, Font style: Bold, Size: 20 and click 

OK.  

 Click OK to return to the graphics window. 

 Zoom-in to the base of the frame and select the beam elements immediately above 

ground level for all of the columns in the structure, as shown in the following figure 

(your element numbers may be different from those shown in the diagram). 

Note.  Use the Ctrl or Alt keys to select multiple elements in the model. 

 

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Note.  Only elements of the same type, for example, thick beam elements, continuum 

elements or thick shell elements can be used in a set of IMDPlus elements. However, 

the element set may contain elements with different numbers of Gauss points or nodes. 

Select the elements shown

 

 

 Open the IMDPlus Seismic Analysis Control dialog through the menu or click on 

the  button in the toolbar 

 On the IMDPlus Seismic Analysis Control dialog click the Next button to accept the 

previously defined values. When prompted about the total mass participation click 

the Yes button to continue. 

Enter the following information into the IMDPlus Output Control dialog. 

 Select Element and change Extent to Selected using the drop-down list. This 

chooses the eight beam elements at the base of the frame for processing. These 

beams were selected in the preceding step. 

Note.  As Extent has been set to Selected the drop-down lists Element and End are 

not available for selection. In addition the element End is automatically set to All as 

multiple elements are going to be processed in a single analysis. 

 Select results entity Force/Moment – Thick 2D Beam of component Fx 

 Deselect Individual items and select Average of chosen items as the averaged 

results for the eight beam elements are going to be investigated. 

 Ensure Response time history is selected 

 Select Peak response summary and select Envelope 

 Ensure Generate graphs in Modeller is selected and Earthquake to graph is set 

to 1 



Utilities 

IMDPlus  >  

Seismic... 
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The dialog should look like this: 

 

 Click the Apply button to proceed. Click Yes when asked whether you want to 

process all of the selected elements. 

Note.  Any combination of the options Individual items, Sum of chosen items and 

Average of chosen items can be used in an IMDPlus analysis, although using the 

Individual items option when Extent is set to Selected or All (nodes or elements) may 

produce a large number of graphs, depending on the number of nodes or elements 

chosen for processing. 

Note.  Average of chosen items obtains results by first summing the results from the 

16 beam ends of the selected elements. A simple average of this summed result is 

obtained to give the element average time history of axial force from which the peak 

average results are obtained. 

The IMDPlus analysis will run and after a short while a graph showing the average 

axial (Fx) force obtained from the selected beam elements will be displayed for the first 

10 seconds of the 1940 El Centro earthquake (Earthquake 1). The average axial force in 

the beam elements is shown in the following figure. 




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Peak results for the averaged element forces and moments are displayed in Notepad in 

file peak_forceSet_Avg1.sum. These indicate a peak positive average axial (Fx) force 

of 32.7kN at solution time 0.98 seconds and a peak negative average axial (Fx) force of 

-36.1kN at 1.01 seconds for the 1940 El Centro earthquake (Record 1), as shown in the 

following figure. 

 

An envelope of the peak results from the selected beam elements is displayed in 

Notepad in file peak_forceSet1.sum. Results for the 1940 El Centro earthquake (Record 

1) are shown in the following figure. A peak positive axial (Fx) force of 1019.1kN 

occurs at time 2.13 seconds at end 1 of element 656. A peak negative axial (Fx) force of 

-956.0kN occurs at time 2.135 seconds at end 1 of element 648. 

Note.  The envelope of the peak results is obtained in IMDPlus by examining the 

individual results from all 16 ends of the chosen beam elements. This helps to quickly 

identify the locations where the peak results occur in the selected set of elements. 

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 Close the Notepad applications and graph windows. 

 Click on the  button in the toolbar to open the IMDPlus Output Control dialog 

If the IMDPlus toolbar is not enabled, 

 Open the IMDPlus Seismic Analysis Control dialog through the menu and click 

Next > to keep the existing analysis control settings and open the IMDPlus Output 

Control dialog. 

 Select Force/Moment - Thick 2D Beam results of Mz 

 Click the Finish button to finish output processing of the element results. Click Yes 

when asked whether you want to process all of the selected elements. 

 Click Yes when asked whether to free up disk space by deleting the temporary files 

created by IMDPlus. 

A graph of the average (Mz) moment obtained from the selected elements will be 

displayed, as shown in the following figure. 

 

Utilities 

IMDPlus  >  

Seismic... 
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All of the peak averaged results displayed in Notepad will be the same as those shown 

when the axial (Fx) force was analysed earlier. These indicate an average absolute peak 

(Mz) moment of 8.4kNm at time 2.145 seconds (Record 1). The envelope of the peak 

results indicates an absolute peak (Mz) moment of 15.6kNm occuring at time 2.905 

seconds in end 2 of element 640 (Record 1). 

 Close the Notepad applications and graph windows. 

Save the model 

 Save the model. This saves all load combinations that have been defined during 

the results processing operations. 

 

This completes the example. 

 

File 

Save… 
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Seismic Analysis of 

a 3D Frame (Time 

Domain) 

For software product(s):  All 

With product option(s): IMDPlus 

Note: The example exceeds the limits of the LUSAS Teaching and Training Version. 

Description 

This example examines the 

seismic response of a 2-storey 

3D frame in the time domain.  

The geometry of the structure has 

been simplified to a wire-frame 

or stick representation with each 

of the members of the structure 

being represented by a line 

feature. 

Units used are N, m, kg, s, C 

throughout. 

 

Objectives 

The output requirements of the analysis are: 

 Maximum deflections in the X-, Y- and Z-directions of a node at the top centre 

of the frame 

 Average deflections and peak deflections in the X-, Y- and Z-directions from all 

of the unrestrained nodes in the frame 
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 Peak axial force and bending moment from all of the frame beams and columns 

 Deformed mesh plots associated with the maximum deflections of a node at the 

top centre of the frame 

 Envelopes of axial force and bending moment from modal combinations. 

Keywords 

Seismic, time domain, response, interactive modal dynamics, excitation, 

eigenvalue, modal combination. 

  

Associated Files 

 IMDPlus 3D Frame.mdl  Model of the structure. 

 e-w.prn, n-s.prn and up.prn  define the east-west horizontal, north-south 

horizontal and vertical earthquake accelerations for the 1940 El Centro 

earthquake. 

Discussion 

The mesh definition used in a dynamic analysis is somewhat different from that used in 

a static stress analysis.  In a static analysis, and with experience, it is usually not too 

difficult to estimate where the high stresses are likely to occur.  These estimates can 

then be used to develop a meshing strategy with a fine mesh in high stress locations and 

a coarse mesh in less critical locations.  For a dynamic analysis the interaction between 

the stiffness and inertia forces will lead to deflected shapes which can be very different 

from those expected in a static analysis. 

In a dynamic analysis both stiffness and mass distribution has to be considered.  

Generally, the best strategy for a dynamic analysis is to have a uniform mesh over the 

entire structure. If refinement is to be carried out a coarser mesh can sometimes be used 

in stiff regions. In regions that are more flexible, or where heavy masses are located, the 

mesh should be more refined. 

In this example the global behaviour of the building is being considered for earthquake 

response. In this analysis the lower frequencies will be dominant and a relatively coarse 

mesh will suffice. If the higher frequencies are important, or if a local response for 

individual beams and columns is to be considered, a revised mesh with more elements 

would need to be used. 

The seismic response analysis is performed in two distinct stages. A natural frequency 

analysis is performed first. This is used here to calculate the first 30 natural modes of 

vibration of the structure. The eigenvalues (frequencies) and eigenvectors (mode 

shapes) are stored and used in the subsequent seismic response analysis.  In order to 

carry out a seismic analysis the eigenvectors must be normalised with respect to the 

mass. Although natural frequencies are obtained from an eigenvalue analysis any 

information regarding the magnitudes of deformations or moments is non-quantitative. 


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The second phase of the analysis utilises the IMDPlus option which performs enhanced 

time domain solutions using Interactive Modal Dynamics (IMD). This is an alternative 

to performing a spectral response analysis and allows the excitation of the structure 

using acceleration time histories instead of spectral excitation curves. In the IMDPlus 

solution, the structure is subjected to support excitation governed by time histories of 

acceleration in the model global axes. In this example, the seismic excitation is applied 

directly to the bases of the columns using the first 2.5 seconds of the 1940 El Centro 

earthquake. 

Modelling 

Running LUSAS Modeller 

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller 

in the Examples Manual Introduction. 

Building and loading the model 

 To create the model, open the file IMDPlus 3D Frame.mdl located in the 

\<LUSAS Installation Folder>\Examples\Modeller
 

directory. Click the OK 

button if the Open File From Previous Version dialog appears. 

After a short while the following isometric view of the model of the building will be 

displayed. 

 

File 

Open… 
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 In the \<LUSAS Installation Folder>\Projects\ folder create a new directory 

called IMDPlus 3D Frame 

 Save the model into this new folder as IMDPlus 3D Frame. This helps keep all 

relevant IMDPlus created files separate from other analyses and is good practice. 

Note.  No static structural loading is required for this analysis because only the 

dynamic loading is considered during the results processing.  

The modelling will now be completed by defining the controls necessary to extract the 

natural frequencies. 

Defining Eigenvalue controls 

Eigenvalue controls are defined as properties of the loadcase. 

 In the  Treeview expand Analysis 1 then right-click on Loadcase 1 and select 

Eigenvalue from the Controls menu.  

The Eigenvalue dialog will appear. 

 Set the Number of eigenvalues as 30 

 Ensure the Shift to be applied is set as 0 

 Ensure the Type of eigensolver is set as Default 

Note.  Eigenvalue normalisation is set to Mass by default. This is essential if the 

eigenvectors are to be used for subsequent IMD analysis. 

 Click the OK button to finish. 

 Save the model file. 

 

Running the Analysis 

 With the model loaded click the Solve button  and the Solve Now dialog will be 

displayed. 

 Click the OK button to run the analysis. 

A LUSAS Datafile will be created from the model information. The LUSAS Solver 

uses this datafile to perform the analysis. 

File 

Save As… 





File 

Save 
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Viewing the Results 

If the analysis was run from within LUSAS Modeller the results will be loaded on top 

of the current model and the loadcase results for each eigenvalue can be seen in the 

Loadcase panel of the Treeview with Eigenvalue 1 set to be active by default. 

Seismic Response Analysis 

Seismic response calculations are performed using the IMDPlus (Interactive Modal 

Dynamics) facility. This involves defining the excitation and specifying the results 

required.  With a seismic response analysis, additional damping information may also 

be set. Unlike results from a natural frequency analysis, the output values obtained from 

a seismic response are design values. 

Initially, in this example, the response of a node at the top and in the centre of the frame 

will be investigated. Node numbers will be added to the mesh display to allow 

selection. 

 Turn off the Geometry layer in the Treeview. 

 With no features selected click the right-hand mouse button in a blank part of the 

graphics window and select the Labels option to add the labels to the Treeview. 

 On the Properties dialog select the Node > Name check box and click OK 

 Select the node at the top and in the centre of the frame, node 61 as shown in the 

following diagram 

Select this node
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Defining the Seismic Parameters 

Note.  To simplify the use of IMDPlus (and provide an alternative to picking 

IMDPlus menu selections from the Utilities menu) for the rest of the example it is 

recommended that the IMDPlus toolbar is enabled in LUSAS Modeller. To do this 

select the View > Toolbars... menu command and enable the IMDPlus option in the 

list and click Close. 

 If the IMDPlus toolbar has been enabled then click on the  Seismic analysis 

button to enable the other relevant toolbar buttons (the seismic tool button) shortcuts 

to the IMDPlus dialogs. 

 Open the IMDPlus Seismic Analysis Control dialog through the menu or click on 

the  button in the toolbar. 

The input for the seismic analysis is defined on the IMDPlus Seismic Analysis Control 

dialog. The input consists of the earthquake acceleration records, included modes and 

damping along with interpolation options. 

 

 In the Earthquake Input section, for the X-Direction Earthquake Record(s) 

browse to the \<Lusas Installation Folder>\Examples\Modeller directory and 

select e-w.prn 



IMDPlus  >  

Seismic... 
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 For the Y-Direction Earthquake Record(s) browse to the \<Lusas Installation 

Folder>\Examples\Modeller directory and select n-s.prn 

 For the Z-Direction Earthquake Record(s) browse to the \<Lusas Installation 

Folder>\Examples\Modeller directory and select up.prn 

 Ensure that the Direction Factors are set to 1.0 in the X-Direction, 1.0 in the Y-

Direction and 0.66667 in the Z-Direction 

 Ensure Included modes is set to All. If this is not the case, click on the Modify… 

button and turn the All modes option on. 

 Ensure Default damping (5%) is selected. If a different damping is displayed, click 

on the Modify… button and set the Default damping to 5 

 In the Frequency Interpolation section, click on the Modify... button to change the 

advanced solution options. Click the Defaults button to set the default options and 

click the OK button. 

 Select the Linear interpolation of records option and enter a time step of 0.0025 

(Half the time step of the original earthquake records) 

 Click the Next button to proceed. When prompted about significant missing total 

mass choose Yes as only 31.22% is included in the Z-Direction (vertical) for 30 

modes. 

Individual Node Displacements 

The displacement of the top of the central column will be investigated initially. Enter 

the following information into the IMDPlus Output Control dialog. 

 Select Node and select Extent as Individual 

 Choose Node number 61 from the drop-down list.  

 Select Displacement results of DX, DY & DZ 

 Ensure Individual items is selected. Sum of chosen items and Average of chosen 

items will not be available as an individual node is being processed. 

 Select Response time history 

 Select Peak response summary 

 Select Modal combination/factor history and click on the Options… button.  

 Set the Minimum mass participation factor percentage to include to 1.0 and 

click on OK 
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 Select Generate textfile output 

The dialog should now look like this: 

 

 Click the Finish button to perform the analysis. 

 Click Yes when asked whether to free up disk space by deleting the temporary files 

created by IMDPlus. 

The horizontal (DX and DY) and vertical (DZ) displacement of the top of the column 

are displayed on the graph for the first 2.5 seconds of the 1940 El Centro earthquake.  
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Peak displacements are also output to Notepad and indicate absolute peak 

displacements of 0.0047 m in the X-direction, 0.0248 m in the Y-direction along with 

additional output for the Z-direction and rotations about each of these axes. From this 

output we can identify times of 2.4725 seconds and 2.49 seconds which correspond to 

the absolute peak displacements in the X and Y directions respectively. This 

information will be used in a later section to visualise the deformed shapes using modal 

combinations. 
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 Close the Notepad application and graph window. 

Average and Peak Displacements for a Selection of 

Nodes 

This section investigates results for a chosen set of nodes containing all of the 

unrestrained nodes in the model, that is, all of the nodes above ground level. The 

average displacements and peak displacements of the selected nodes will be obtained. 

 Rotate the model to view along the Y axis by clicking the status bar at the 

bottom of the Modeller window. 

 Using Select Nodes drag a box to select all of the 89 nodes above ground level, as 

shown in the following figure. 
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Drag a box to select

all the nodes above

ground level

 

 Open the IMDPlus Seismic Analysis Control dialog through the menu or click on 

the  button in the toolbar 

 On the IMDPlus Seismic Analysis Control dialog click the Next button to accept the 

previously defined values. When prompted about the total mass participation click 

the Yes button to continue. 

Enter the following information into the IMDPlus Output Control dialog. 

 Select Node and change Extent to Selected using the drop-down list. This chooses 

all 89 nodes above ground level that were selected in the preceding step. 

Note.  As Extent has been set to Selected the Node drop-down list will not be 

available for selection. 

 Select result entity Displacement and component DX, DY & DZ 

 Deselect Individual items and select Average of chosen items as the averaged 

results of the selected nodes are going to be investigated. 

 Ensure Response time history and Generate graphs in Modeller remain selected. 

 Ensure Peak response summary remains selected and also select Envelope 

 Deselect Modal combination/factor history and Generate textfile output 

The dialog should now look like this: 

Utilities 

IMDPlus  >  

Seismic... 


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 Click the Apply button to perform the analysis. Click Yes when asked whether you 

want to process all of the selected nodes. 

Note.  Any combination of the options Individual items, Sum of chosen items and 

Average of chosen items output can be used together in an IMDPlus analysis, 

although using the Individual items option when Extent is set to Selected or All 

(nodes or elements) may produce a large number of graphs, depending on the number 

of nodes or elements chosen for processing. 

Note.  Average of chosen items obtains results by first summing the results from the 

89 nodes selected. A simple average of these summed results is obtained to give the 

averaged node time histories from which the peak average results are obtained. 

A graph showing the average horizontal (DX and DY) and vertical (DZ) displacements 

for all of the selected nodes is displayed for the 1940 El Centro earthquake. The 

average node displacements are shown in the following figure. 




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The peak results for the averaged node displacements are displayed in Notepad in file 

peak_dspSet_Avg1.sum. These indicate absolute peak average displacements of 

0.0027m at time 2.4725 seconds in the X-direction and 0.0106m at time 2.485 seconds 

in the Y-direction.  
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An envelope of the peak results for the chosen nodes is displayed in Notepad in file 

peak_dspSet1.sum and is shown in the following figure. The peak X-displacement of 

0.0068m occurs at node 143 at time 2.745 seconds and the peak Y-displacement of 

0.0248m occurs at node 135 at time 2.49 seconds. 

Note.  The envelope of the peak results is obtained in IMDPlus by examining the 

individual results from the 89 unrestrained nodes. This helps to quickly identify the 

nodes of the model where the maximum and minimum displacements occur. 

 

 Close all of the Notepad applications and graph windows. 

Peak Axial Forces from All of the Elements in the Model 

In this section the peak results for a set of elements containing all of the 201 beam 

elements in the model will be investigated. 

Note.  Only elements of the same type, for example, thick beam elements, continuum 

elements or thick shell elements can be used in a set of IMDPlus elements. However, 

the element set may contain elements with different numbers of Gauss points or nodes. 

Note.  As all of the elements in the model are going to be processed there is no need 

to pre-select the elements in the graphics window prior to running the IMDPlus 

analysis. Instead the All option from the Extent drop down list will be utilised on the 

IMDPlus Output Control dialog. 

 Click on the  button in the toolbar to open the IMDPlus Output Control dialog 






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If the IMDPlus toolbar is not enabled, 

 Open the IMDPlus Seismic Analysis Control dialog through the menu and click 

Next > to keep the existing analysis control settings and open the IMDPlus Output 

Control dialog. 

Enter the following information into the IMDPlus Output Control dialog. 

 Select Element and change Extent to All using the drop-down list. This chooses all 

of the elements in the model. 

Note.  As Extent has been set to All the drop-down lists Element and End are not 

available for selection. In addition the element End is automatically set to All as 

multiple elements are going to be processed in a single analysis. 

 Select results entity Force/Moment – Thick 3D Beam and component Fx 

 Ensure Average of chosen items remains selected and Individual items and Sum 

of chosen items deselected as only the average results of the chosen elements are 

going to be investigated. 

 Deselect Response time history 

 Ensure Peak response summary and Envelope remain selected. 

The dialog should now look like this: 

 

Utilities 

IMDPlus  >  

Seismic... 
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 Click the Finish button to perform the analysis. Click Yes when asked whether you 

want to process all of the elements in the model. On modern computers this will take 

under 5 minutes. 

 Click Yes when asked whether to free up disk space by deleting the temporary files 

created by IMDPlus. 

Peak average results for the chosen set of elements are output to Notepad in file 

peak_forceSet_Ave2.sum. 

Note.  Average of chosen items obtains the element results by first summing the 

results from all of the beam ends in the model. A simple average of these summed 

results is obtained to give the average response time histories from which the peak 

average results are obtained. 

An envelope of the peak results for all of the elements in the model is displayed in 

Notepad in file peak_forceSet2.sum and is shown in the following figure. It can be seen 

that the peak compressive axial force (Fx) of -30.97kN occurs at end 1 of element 4 at 

time 2.3425 seconds. The peak bending moment (My) occurs at end 1 of element 133 at 

time 2.49 seconds and has a value of -46.42kNm. 

Note.  The envelope of the peak results is obtained in IMDPlus by examining the 

individual results for all of the beam elements in the model. This enables the locations 

of the elements with maximum and minimum results to be quickly identified. 

 

 Close the Notepad applications. 

The elements that contain the peak compressive axial force and peak bending moment 

will now be located in the model. 

 In the LUSAS graphics window click on the Isometric view button. 


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 Click the left-hand mouse button in a blank part of the graphics window to remove 

the node selection created in the preceding sections. 

 Double-click on the Labels layer name in the Treeview. 

 On the Properties dialog de-select the Node > Name check box, select the Element 

> Name check box and select the Label selected items only check box.  

 Click the OK button to accept all other settings. This will turn on the layer in the 

graphics window. 

 With no features selected click the right-hand mouse button in a blank part of the 

graphics window and select the Advanced Selection... option. 

 Select Type and Name, select Element from the drop-down list and enter element 

number 4 

 Select Add to selection and click the Apply button to accept all other settings. 

Beam element 4 will be highlighted in the graphics window.  

 Enter element number 133 and click the OK button. Beam element 133 will also be 

displayed in the graphics window, as shown in the following figure. 
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Displaying Deformed Mesh Plots from Modal 

Combinations 

When the IMDPlus analysis of node 61 was carried out in an earlier section, the Modal 

combination/factor history option was selected and caused IMDPlus to generate a 

command file in the \<LUSAS Installation Folder>\Projects\IMDPlus 3D 

Frame\Associated Model Data\IMDPlus 3D Frame directory called 

Modal_Combinations-rec001.vbs. These combinations can now be generated in 

Modeller by loading this command file. 

Modal_Combinations-rec001.vbs defines the modal combinations for all time 

steps in the seismic analysis. 

 Open the file Modal_Combinations-rec001.vbs located in the \<LUSAS 

Installation Folder>\Projects\IMDPlus 3D Frame\Associated Model 

Data\IMDPlus 3D Frame directory. 

The combinations will appear under the original model in the  Treeview. 

 Click the left-hand mouse button in a blank part of the graphics window to remove 

the element selection created in the previous section. 

 Turn off the display of the Labels and Attributes layers in the  Treeview. 

 In the  Treeview click the right-hand mouse button on the Local Coordinates 1 

entry and deselect Show definition 

 In the  Treeview click the right-hand mouse button on the Mesh and select 

Properties. Select the Choose pen… button and select a Green colour for the 

mesh. Select the Visualise tab and turn off the Beam end releases option. Click the 

OK button. 

 With no features selected click the right-hand mouse button in a blank part of the 

Graphics area and select the Deformed Mesh option to add the deformed mesh 

layer to the  Treeview. Select the Visualise tab and turn off the Beam end 

releases option. Click the OK button to accept the remaining default values and 

display the deformed mesh. 

 At the bottom of the  Treeview select the Window summary option and click 

the Details... button. In the Window summary properties dialog set the position to 

(50.0,-120.0) and click the OK button to return to the graphics window. 

 In the  Treeview right-click on the 991:Response Time = 2.472500000 dataset 

name and select the Set Active option to set this combination active. This is the 

time at which the absolute peak displacement in the X-direction occurred at node 



File 

Script > 

Run Script... 
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61. The deformed mesh will now be displayed for this instance in time as shown 

below. 

 

 In the  Treeview right-click on the 998:Response Time = 2.490000000 dataset 

name and select the Set Active option to set this combination active. This is the 

time at which the absolute peak displacement in the Y-direction occurred at node 

61. The deformed mesh will now be displayed for this instance in time as shown 

below. 
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Note.  Standard post-processing such as displaying contours can be performed on 

these modal combinations to allow the global behaviours at instances in time to be 

investigated. 

Displaying Envelopes for the Whole Earthquake 

Plots showing the maximum and minimum axial force and bending moment in the 

columns for the entire earthquake duration are to be displayed. 

Create an envelope 

 Enter Whole Earthquake for the name 

 Select model data from the drop-down list 

 Hold down the shift key and select combinations 2 to 1002 in the list and click on 

the >> ‘Add to’ button to add all combinations to the envelope 

 Click the OK button to create the max and min envelopes. 

 In the  Treeview right-click the group named Columns and Set as Only Visible 

to only view the column members. 

 Turn off the display of the Mesh and Deformed Mesh layers in the  Treeview. 

 In a blank part of the Graphics area, click the right-hand mouse button and select the 

Diagrams option to add the Diagrams layer to the  Treeview. 

 Select Force/Moment – Thick 3D Beam results of axial force Fx in the members. 

Select the Diagram display tab, select the Label values option and deselect the 

Peaks Only option. Plot values on 80% of the element length.  

 Click the OK button. 

 In the  Treeview right-click on the Whole Earthquake (Max) envelope and 

select the Set Active option to set this envelope active. 

 On the Set Active dialog select Force/Moment – Thick 3D Beam results of axial 

force Fx and click the OK button to finish.  

The envelope will now be assembled over the 1000 modal combinations generated by 

IMDPlus. On modern computers this will take under 5 minutes.  



Analyses 

Envelope… 
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For this central column Fx = 11.94E3

 

 In the  Treeview right-click on the Whole Earthquake (Max) envelope and 

select the Set Active option to set this envelope active. Select entity Force/Moment 

– Thick 3D Beam of component My and click the OK button. When informed that 

the component is different to the one used in the drawing layers click the Yes button 

to update the diagrams layer.  

The envelope will now be assembled over the 1000 modal combinations generated by 

IMDPlus. 

 

For this central column

My = 8.458E3 at top (My2)

My = 8.517E3 at bottom (My1)
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Displaying results for a selected member 

To check these previous results for Fx and My we will utilise IMDPlus again to check 

the response of the member in centre of the frame.  

 Turn off the display of the Diagrams and Annotation layers in the Treeview. 

 Turn on the display of the Mesh layer in the Treeview. 

Element numbers will be added to the mesh display to allow selection. 

 Double-click on the Labels layer name in the Treeview. On the Properties dialog 

de-select the Label selected items only check box and click OK. (This turns on the 

display of a turned-off layer.) 

  Select the element in the centre of the frame as shown in the following diagram. 

Select this element

 

 Open the IMDPlus Seismic Analysis Control dialog through the menu or click on 

the  button in the toolbar 

 On the IMDPlus Seismic Analysis Control dialog click the Next button to accept the 

previously defined values. When prompted about the total mass participation click 

the Yes button to continue. 

 On the IMDPlus Output Control dialog select Element change Extent to 

Individual 

Utilities 

IMDPlus  >  

Seismic... 



Viewing the Results 

 107 

 Select Element number 22 from the drop-down list and ensure End is set to All 

 Choose Force/Moment – Thick 3D Beam and component Fx. 

 Select Individual items. Sum of chosen items and Average of chosen items will 

not be available as an individual element is being processed. 

 Ensure Peak response summary is selected. 

 Click the Finish button and click the Yes button to confirm that both ends of the 

beam element are to be processed (because All ends has been previously set). 

 Click Yes when asked whether to free up disk space by deleting the temporary files 

created by IMDPlus. 

The peak forces and moments in element 22 will be output to a Notepad application in 

the format indicated below. 
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Comparison of the results for Fx and My for the central column show good agreement 

between the envelope and IMDPlus results. Exact agreement would have been obtained 

if all modes were included in the modal combinations used for the envelope instead of 

the 1% minimum participating mass selected earlier. 

 Close the Notepad application. 
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Note.  For an IMDPlus seismic analysis selecting Peak response summary will 

tabulate results for all components and not just the one selected (Fx). If Response time 

history is selected only the results for the selected component will be graphed. 

Save the model 

 Save the model. This saves all load combinations that have been defined during 

the results processing operations. 

 

This completes the example. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



File 

Save… 
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Train Induced 

Vibration of a 

Bridge 

For software product(s):  Any Plus version 

With product option(s): IMDPlus 

Note: The example exceeds the limits of the LUSAS Teaching and Training Version. 

Description 

This example examines the 

response of a steel rail bridge to 

the passage of a train. 

Units used are N, m, kg, s, C  

throughout. 

 

 

 

Objectives 

The output requirements of the analysis are: 

 Deflections in the X-, Y- and Z-directions for a train speed of 15 m/s 

 Accelerations in the vertical direction for a train speed of 70 m/s 

 Peak deflections and accelerations in the vertical direction for a speed range of 

15 m/s to 70 m/s in 5 m/s intervals 

 Stress resultants and peak stress resultants in main girder web. 

 Averaged and peak vertical displacements and resultant dynamic amplification 

factors from all of the nodes of the bridge structure 
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 Total summed reactions and peak reactions from all of the supported nodes of 

the bridge structure 

 Averaged and peak stresses for a side panel of the bridge structure 
  

Keywords 

Moving load, time domain, response, interactive, modal, dynamics,  IMDPlus, 

eigenvalue. 

  

Associated Files 

 IMDPlus Rail Bridge.mdl  Model of the structure. 
 

 ec1-3 Type3.lmd  Attribute library that contains the Eurocode ENV 1991-3 

Type 3 moving load train definition for the example. 

 ec1-3 Type3.xls Microsoft Excel spreadsheet that contains the axle 

positions and loads of the Eurocode ENV 1991-3 Type 3 train set. 
 

Modelling 

Running LUSAS Modeller 

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller 

in the Examples Manual Introduction. 

Building and loading the model 

To create the model, open the read-only file IMDPlus Rail Bridge.mdl located in the 

\<LUSAS Installation Folder>\Examples\Modeller
 
directory. Click the OK button if 

the Open File From Previous Version dialog appears. 

After a short while the following view of the model of the bridge will be displayed. 



File 

Open… 
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 In the \<LUSAS Installation Folder>\Projects\ folder create a new directory 

called IMDPlus Rail Bridge 

 Save the model into this new folder as IMDPlus Rail Bridge. This helps keep all 

relevant IMDPlus created files separate from other analyses and is good practice. 

 Turn off the display of the Attributes layer in the  Treeview. 

 

Note.  No static structural loading is required for this analysis because only the 

dynamic loading is considered during the results processing, which is defined later.  

File 

Save As… 


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Modelling Discussion 

The bridge is approximately 16.5m long and 4.75m wide and carries a single track with 

ballast and concrete sleepers. The primary structure is constructed from steel and is 

modelled using shell elements. For this analysis, modelling of the ballast/track-bridge 

interaction has been carried out using a full 3D solid representation of the ballast with 

the sleepers modelled with thick beam elements laid along the top of the ballast. The 

rails of the track have been modelled using thick beam elements spanning between the 

sleepers and the whole ballast/track model is connected to the bridge deck using a 

sliding-only slideline. For the purposes of this example the bridge and ballast model has 

been represented with a coarse mesh and therefore the results from this analysis will be 

inaccurate. For analysing actual structures it is recommended that a finer mesh be used 

which can capture both the vibration modes of the bridge and the movement of the load 

across the bridge more accurately. 

 

Bridge representation 
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Ballast representation 

To allow the loading of the rails to be distributed to the 3D solid elements using 

discrete point loads the track modelling uses weak, weightless shell elements which 

span between the beam elements representing the rails. The track representation is 

shown in the following figure.  

 

Track (sleepers and rails) representation 

Note that the line down the centre of the track (Line 12000) is used to define the path of 

the train across the bridge and will be used later in this example. In order to avoid any 
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adverse dynamic behaviour of the weak weightless shell elements, only one division is 

used to span between the two rails thus providing full support to the shells without 

adding stiffness to the model. 

Defining Eigenvalue Controls 

Eigenvalue controls are defined as properties of the loadcase. 

 In the  Treeview expand Analysis 1 then right-click on Loadcase 1 and select 

Eigenvalue from the Controls menu.  

The Eigenvalue dialog will appear. 

The following parameters need to be specified: 

 Set the Eigenvalues required to Range 

 Ensure the Range is set to Frequency 

 Set the Minimum frequency as 0 

 Set the Maximum frequency as 35 

 Set the Number of eigenvalues to 0 (this solves for ALL frequencies in the range) 

 Ensure the Type of eigensolver is set as Default 

Note.  Eigenvalue normalisation is set to Mass by default. This is essential if the 

eigenvectors are to be used for subsequent IMD analysis. 

 Click the OK button to finish. 

 Save the model file. 

 

Running the Analysis 

 With the model loaded click the Solve button  and the Solve Now dialog will be 

displayed. 

 Click the OK button to run the analysis. 

A LUSAS Datafile will be created from the model information. The LUSAS Solver 

uses this datafile to perform the analysis. 



File 

Save 
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Viewing the Results 

If the analysis was run from within LUSAS Modeller the results will be loaded on top 

of the current model and the loadcase results for each eigenvalue can be seen in the 

Loadcase layer. Eigenvalue 1 is set to be active by default. 

Checking the Mass Participation Factor 

Note.  In order to carry out a successful IMDPlus analysis you should ensure that a 

significant proportion of the total mass has been accounted for in the analysis. This 

requires checking that around 90% of the total mass has been achieved in the global 

directions. If less than 90% has been achieved no further modes need be included, if 

and only if, the modes of vibration omitted cannot be excited by the dynamic input or a 

significant proportion of the structure is restrained by support in these directions and 

therefore cannot participate in the modes of vibration. The acceptability of the included 

modes of vibration will vary from analysis to analysis but failure to check that a 

significant proportion of the total mass has been accounted for may lead to important 

modes being missed and subsequent errors in the analysis results.   

 Select Active and click Next. 

 Select Entity None and from the Type drop-down menu select Sum mass 

participation factors and then click Finish.  The Sum Mass Participation Factors 

results will be printed to the Text Output window.  

It can be seen that the 90% value has almost been achieved in all directions for this 

analysis. This is discussed in the note below. 

     MODE    SUM MASS X     SUM MASS Y       SUM MASS Z 

        1    0.110940E-01    0.117572E-04    0.707920 

        2    0.121970E-01    0.133845E-04    0.708029 

        3    0.125612E-01    0.182964        0.708274 

        4    0.131909E-01    0.182989        0.769089 

        5    0.290473E-01    0.352634        0.770999 

        6    0.430279E-01    0.813529        0.771960 

        7    0.177903        0.890132        0.806536 

        8    0.178201        0.892043        0.831905 

        9    0.188464        0.893014        0.832302 

       10    0.207253        0.893215        0.833539 

       11    0.864564        0.893542        0.861563 

       12    0.901000        0.938795        0.862830 

       13    0.901132        0.939785        0.862830 

       14    0.920871        0.940199        0.864118 



Utilities 

Print Results 
Wizard… 
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       15    0.920872        0.940360        0.881332 

       16    0.938299        0.940366        0.882002 

       17    0.938309        0.940637        0.882002 

       18    0.938347        0.940642        0.882003 

       19    0.938366        0.940708        0.882003 

Note.  In this analysis we are only including modes of vibration with frequencies up to 

and including 35 Hz with frequencies higher than this value considered insignificant for 

the analysis. In this analysis the printed results show that 93.8% of the total mass is 

achieved in the X-direction, 94.1% is achieved in the Y-direction and 88.2% is 

achieved in the Z-direction. 

 Close the text window by selecting the close button in the top right hand corner of 

the window. 

 

 Select Active and click Next. 

 Select Entity None and from the Type drop-down menu select Mass participation 

factors and then click Finish.  The Mass Participation Factors results will be 

printed to the Text Output window.  

     MODE     MASS PF X      MASS PF Y        MASS PF Z 

        1    0.110940E-01    0.117572E-04    0.707920 

        2    0.110297E-02    0.162728E-05    0.109262E-03 

        3    0.364226E-03    0.182951        0.245424E-03 

        4    0.629662E-03    0.241889E-04    0.608148E-01 

        5    0.158564E-01    0.169645        0.191047E-02 

        6    0.139805E-01    0.460895        0.960755E-03 

        7    0.134875        0.766029E-01    0.345759E-01 

        8    0.298085E-03    0.191048E-02    0.253685E-01 

        9    0.102626E-01    0.971036E-03    0.397193E-03 

       10    0.187893E-01    0.200908E-03    0.123754E-02 

       11    0.657310        0.327165E-03    0.280234E-01 

       12    0.364360E-01    0.452530E-01    0.126713E-02 

       13    0.132603E-03    0.990173E-03    0.130638E-07 

       14    0.197387E-01    0.413466E-03    0.128847E-02 

       15    0.797027E-06    0.161819E-03    0.172134E-01 

       16    0.174272E-01    0.517541E-05    0.670045E-03 

       17    0.100738E-04    0.271287E-03    0.727634E-06 

       18    0.383935E-04    0.473477E-05    0.479303E-07 



Utilities 

Print Results 
Wizard… 
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       19    0.185724E-04    0.667088E-04    0.664934E-07 

From these mass participation factors the major modes of vibration of the bridge can be 

seen to be mode 1 in the Z-direction (vertical) and modes 3, 5 and 6 in the Y-direction 

(lateral). 

 Close the text window by selecting the close button in the top right hand corner of 

the window. 

 Use the maximise button to increase the size of the graphics window. 

Plotting Mode Shapes 

 Turn off the display of the Mesh, and Geometry layers in the  Treeview. 

 With no features selected click the right-hand mouse button in a blank part of the 

Graphics area and select the Deformed mesh option to add the deformed mesh 

layer to the  Treeview. Click the OK button to accept the default values and 

display the deformed mesh for Eigenvalue 1. 

 In the panel at the bottom of the  Treeview select the Window summary option 

and click the Details... button. In the Window summary properties dialog set the 

position to (50,-10) and click the OK button to return to the graphics window. 

This mode of vibration is the primary mode in the vertical direction as determined in 

the Checking the Mass Participation Factor section. 
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By setting each Eigenvalue to be active the deformed mesh can be seen for all mode 

shapes.  

 In the  Treeview right-click on Eigenvalue 6 and select the Set Active option. 

The deformed mesh plot for Eigenvalue 6 will be displayed.  

This mode of vibration has the highest participating mass in the lateral (Y) direction for 

the whole bridge as determined in the Checking the Mass Participation Factor section. 

 

Note.  The window summary displays the values of the eigenvalue and the natural 

frequency and also a value for displacement at a node. It should be noted that the 

displacement value is non-quantitative and is related to the amount of mass in a 

particular mode using the mass normalisation technique. Therefore the only items that 

can be found using a basic eigenvalue analysis are the frequency and the mode shape. 

Note.  The mode shape may be inverted. This is because the sense is arbitrary since 

during vibration the deformed shape will appear in both directions. 

Selecting individual nodes and elements of interest 

Prior to running an IMDPlus analysis, individual node and element numbers for the 

locations of the structure that will be assessed should be ascertained. This can be done 

by selecting the locations of interest with the cursor and noting down the numbers of the 

node and elements concerned. 




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 Turn off the display of the Deformed mesh and Annotation layers in the  

Treeview. 

 In the  Treeview double-click on the Mesh layer name and click the OK button 

to accept the default settings. This will turn on the layer. 

To view just the bridge structure without the ballast and track: 

 In the  Treeview click the right-hand mouse button on the group name 

Bridge_Structure and select the Set as Only Visible option from the drop-down 

menu. 

By selecting or hovering the cursor over the node and element shown, the node or 

element number of interest can be obtained. For the first stage of this analysis we are 

interested in the node at the centre of the bridge deck and the element in the middle of 

the side girder, as shown in the following figures. 
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Defining the Eurocode ENV 1991-3 Type 3 Trainset 

Before the analysis can be performed we need to define the moving load representation 

of the Eurocode ENV 1991-3 Type 3 trainset in LUSAS Modeller. 

Note.  To simplify the use of IMDPlus for the rest of the example it is recommended 

that the IMDPlus toolbar is enabled in LUSAS Modeller. To do this select the View > 

Toolbars... menu command and enable the IMDPlus option in the list and click Close. 

 If the IMDPlus toolbar has been enabled then click on the  Moving Load 

analysis button in the toolbar to select a moving load analysis and enable the 

toolbutton shortcuts to the dialogs. 

 Open the IMDPlus Moving Load Vehicle Configuration dialog through the menu or 

click on the  button in the toolbar. The moving load vehicle is now defined 

using the positions of the axles relative to the front of train together with the moving 

load factors to be applied at each position. To simplify the definition of the vehicle 

the positions and loads are included in a Microsoft Excel spreadsheet so they can be 

copied and pasted into the dialog. 



Utilities 

IMDPlus  >  

Moving Load >  

Vehicle 
Configuration... 
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 Locate the ec1-3 Type3.xls 

spreadsheet in the 

\<LusasInstallationFolder

>\Examples\Modeller 

folder and open it. 

 Select all of the 60 positions 

and loads in the first and 

second columns and copy 

these to the clipboard using 

Ctrl+C 

 Select both the Position and 

Load headers of the grid in 

the dialog and paste these 

into the grid using Ctrl+V 

 Enter the name as ec1-3 

Type3 

Once finished the dialog should 

appear as shown. 

 Click OK to create the vehicle configuration. 

Note.  Alternatively each Position and Load in the table can be entered manually. 

 

Note.  The positions of the axles should be defined as negative values to ensure that 

the whole trainset passes over the structure. Negative values place the axles behind the 

front of the train which is at a position of 0. The movement of the front of the train will 

be calculated from the start of the path to the end of the path with additional time 

included in the IMDPlus solution to allow all of the axles with negative positions to 

pass along the path. 

If any axles are defined with positive values then these will already be the distance 

down the path equivalent to the position entered in the vehicle configuration. Those 

axles with positive positions may already be over the structure at the start of the 

IMDPlus analysis if the start of the path has not been defined to account for this. If any 

positive positions are used then always ensure that the lines defining the beginning of 

the path allow sufficient additional length in order to model the transition of the whole 

of the train onto the structure correctly. 

Note.  Once a trainset or vehicle has been defined it can be saved in a library so it can 

be imported and used in future analyses without the need to go through all of the 

 






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definition process above. This is achieved through the Library Browser accessed 

through the File > Import/Export Model Data... menu command. 

Importing a Vehicle  

If it proves time consuming or you are unable to obtain the same results shown later in 

the example the vehicle definition can be imported from the library provided in the 

\<LusasInstallationFolder>\Examples\Modeller folder. 

 The ec1-3 Type3.lmd  contains the vehicle library for the example.  
 
 

 Select the Import from library to model option 

 Click on the Choose file... button and browse to the ec1-3 Type3.lmd file in the 

\<LusasInstallationFolder>\Examples\Modeller folder. 

 Select the IMDPlus (1) entries in the tree 

 Click the OK button. 

 

After vehicle configuration attribute has been 

defined it will appear in the  Utilities 

treeview. 

To edit the vehicle configuration attribute 

simply double-click with the left mouse button 

or right-click and choose Edit Attribute... on 

the name of the attribute to bring up the original 

dialog. 

Moving Load Analysis 

Moving load calculations are performed using the IMDPlus (Interactive Modal 

Dynamics) facility. In order to carry out the moving load analysis of the train travelling 

across the bridge we need to carry out three stages: 

1. Define and set-up the path along which the moving loads will travel using a 

unit load defined as either a discrete point or patch load. For this example the 

unit axle load has already been defined as a discrete point load called Unit 

Axle Load which acts vertically 

2. Convert the loading along this path from this unit load into modal forces that 

are applied in the IMDPlus moving load analysis 



File 

Import/Export Model 
Data… 
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3. Run an IMDPlus moving load analysis to calculate the response of the bridge 

Note.  This process is similar to the IMDPlus moving mass analysis procedure but 

with the trainset / vehicle defined by constant forces rather than spring-mass systems. 

Note.  Before an IMDPlus analysis can be carried out the load that is going to pass 

over the structure must be defined using either discrete point or patch loads. For this 

example this has already been carried out with a single axle of unit load defined as a 

discrete point load. Defining a single axle allows multiple load configurations to be 

analysed through the composite axle definition method in IMDPlus without the need to 

carry out the path and modal force stages for each layout. For railways the axle lengths 

remain constant over all of the train set and this method would normally be used. For 

moving loads where axles are of different widths the full definition of the load must be 

carried out with the path and modal force stages carried out for each layout. 

Defining the Moving Load Path 

To solve for the passage of the train across the bridge the path for the moving load must 

be defined. Line 12000 (the line representing the path of the moving load) will be set to 

be the current selection. 

To view the complete model again: 

 In the  Treeview click the right-hand mouse button on the group name IMDPlus 

Rail Bridge.mdl and select the Visible option from the drop-down menu. Click Yes 

when asked whether to act on subgroups as well. 

 In the  Treeview double-click on the Geometry layer name and click the OK 

button to accept the default settings. This will also turn on the layer. 

 Select the line shown (line 12000) 







Train Induced Vibration of a Bridge 

 126 

 

 

Note.  The path can be built from multiple lines and arcs but these must form a 

continuous path without branching. 

 

 Open the IMDPlus Moving Load Generation dialog through the menu or click on 

the  button in the toolbar. 

On startup of the IMDPlus Moving Load Generation dialog, all valid discrete loads and 

search areas will be made available in the loading options along with information about 

the path defined by the current selection.  

In this example a single discrete load called Unit Axle Load which defines the unit 

loading from a single axle of the train is present along with a search area that is 

assigned to the weak weightless shells. 



Utilities 

IMDPlus  >  

Moving Load >  

Moving Load 
Generation... 
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 Ensure 1:Unit Axle Load is selected 

from the Moving load dataset list. 

 Ensure 1:Track_Search_Area is 

selected from the Search area ID for 

the assignment of the discrete 

loading. 

 Ensure Project over area is 

selected. 

 Click on the Advanced button to 

adjust the inclusion of load 

characteristics. On the Moving Load 

Advanced Options dialog choose the 

Include Full Load option for loads 

outside the search area and click the 

OK button. 

 On the IMDPlus Moving Load 

Generation dialog set the 

Incremental distance to 0.1 

Note.  Using search areas targets the application of the loading to the required 

features as described in the Modeller Reference Manual. 

Note.  By default the incremental distance is set to one tenth of the length of the line 

along which the load moves. 

 Click the OK button to proceed and choose Yes to accept the warnings and save the 

current model. 

The program will now generate the loading information for the 274 locations of the unit 

axle along the path before returning control back to LUSAS Modeller. This process will 

take only a minute or so on a modern computer and does not need to be repeated unless 

the lateral configuration of the load changes. For a railway this will not happen but it 

may be required for highway analyses where the axle lengths and tyre configurations 

could vary. 

Note.  The discrete loading locations defined by this dialog will be tabulated into 

three datafiles with a maximum of 100 loadcases each and the analyses will be 

performed automatically. These analyses will use the same file basename as the original 

model with a numeric indicator appended to it (e.g. _00001, _00002, etc). They are 

required for the modal force calculation stage. 

 






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Generating the Modal Force History for the Moving Load 

In the previous stage the passage of the train axle across the structure has been defined. 

The modal forces for the IMDPlus solution now need to be calculated using the Modal 

Force Calculator. 

 Open the IMDPlus Modal Force Calculator dialog through the menu or click on the 

 button 

 

 Click the OK button to accept 

the default information and 

proceed. 

Note.  This process will take 

only a minute or so on a modern 

computer and does not need to be 

repeated unless the moving load 

path or configuration in Stage 1 is 

changed. 

 

 

Defining the Moving Load Parameters 

All of the basic moving load information has now been defined for the IMDPlus 

analysis. The next stage is to define the included modes, damping and speed 

parameters. 

 Open the IMDPlus Moving Load Analysis Control dialog through the menu or click 

on the  button in the toolbar. 

 

Utilities 

IMDPlus  >  

Moving Load >  

Modal Force 
Calculator... 

 



Utilities 

IMDPlus  >  

Moving Load >  

Moving Load 
Analysis... 
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 Click on the 

Vehicle 

Configuration 

(Composite axle) 

option since we are 

using a unit load 

axle definition. 

 Ensure the Vehicle 

configuration 

contains 1:ec1-3 

Type3 

 Ensure that 

Included modes is 

set to All. If this is 

not the case, click 

on the Modify… 

button and ensure 

the All modes 

option is selected. 

 Ensure Default damping of 5.0 is selected. If a different damping is displayed, 

click on the Modify… button and set the Default damping to 5.0 

 In the Solution control section, click on the Modify... button to change the advanced 

solution options. Click the Defaults button to set the default options and click the 

OK button. 

 Enter the Minimum Speed as 15, the Maximum Speed as 70 and the Speed 

Increment as 5 

 Deselect the IMDPlus determining time step (Nyquist) option so we can specify 

the required time step 

 Enter the Solution time step as 1E-3 

 Click the Next button to proceed. When prompted about significant missing total 

mass choose Yes to continue. For this analysis we are only interested in the 

contributions of modes of vibration up to and including 35Hz which means that we 

are not going to achieve the 90% total mass target. 

The information entered above will analyse the passage of a Eurocode ENV 1991-3 

Type 3 train (with axle details as held in the file ec1-3 Type3.xls) across the bridge for 

a speed range of 15 m/s to 70 m/s in increments of 5 m/s (or 54 kph to 252 kph in 

increments of 18 kph). The quiet time allows for the decay of the response of the bridge 
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after the train has passed across and the solution time step forces the time step to be 

used in the analyses. 

Displaying Individual Node and Element Results for 

Moving Load Analysis 

The IMDPlus Output Control dialog will appear. This controls the results output for the 

model. 

Displacement and Acceleration Graphs 

The response of the mid-span of the bridge for the range of speeds selected will be 

investigated. Initially we will look at the displacements of the mid-span for a single 

speed of 15 m/s (or 54 kph). 

Enter the following information into the output control dialog: 

 Choose Node and 

select Extent as 

Individual 

 Enter Node number 

1672 (This is the 

node in the centre of 

the bridge deck at the 

mid-span of the 

bridge) 

 Select Displacement 

results of DX, DY & 

DZ 

 Ensure Individual 

items is selected. 

Sum of chosen items 

and Average of 

chosen items will not 

be available as an 

individual node is 

being processed. 

 Ensure Response time history is selected. 

 Ensure Generate graphs in Modeller is selected. 
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 Set the Speed to graph as 1:15.0 which indicates that the first speed of 15 m/s is 

being processed 

 Click the Apply to proceed.  

Note.  Clicking the Apply button instead of the Finish button keeps the IMDPlus 

Control Dialog accessible for subsequent graph plotting. 

The IMDPlus analysis will now run. 

 

 When the graph has been displayed, close the graph 

The vertical acceleration response of the mid-span for a single speed of 15 m/s (or 54 

kph) will now be investigated.  

If the IMDPlus toolbar has been enabled, 

 Click on the  button in the toolbar to open the IMDPlus Output Control dialog 

If the IMDPlus toolbar is not enabled, 

 Open the IMDPlus Moving Load Analysis Control dialog through the menu and 

click Next > to keep the existing analysis control settings and open the IMDPlus 

Output Control dialog. 

 



Utilities 

IMDPlus  >  

Moving Load >  

Moving Load 
Analysis... 
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 On the IMD Output 

Control dialog select 

Acceleration results 

of AZ for the vertical 

component only 

 Click the Apply 

button and not the 

Finish button to 

proceed.   

Note.  IMDPlus does 

not need to be rerun 

since the acceleration 

results were computed at 

the same time as the 

displacement results. 

 

 

 

 

 When the graph has been displayed, close the graph 

Previously we have investigated the displacement and acceleration response of the mid-

span of the bridge deck for a single train speed. We will now look at the peak positive 

and negative vertical displacement and acceleration responses of the mid-span over the 

speed range of 15 m/s to 70 m/s as specified previously in the moving load analysis 

control dialog. 
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If the IMDPlus toolbar has been enabled, 

 Click on the  button in the toolbar to open the IMDPlus Output Control dialog 

If the IMDPlus toolbar is not enabled, 

 Open the IMDPlus Moving Load Analysis Control dialog through the menu and 

click Next > to keep the existing analysis control settings and open the IMDPlus 

Output Control dialog. 

 

 On the IMDPlus 

Output Control 

dialog select 

Displacement results 

of DZ for the vertical 

component only. 

 Deselect the 

Response time 

history option 

 Select the Peak 

response summary 

option and select 

Positive/negative 

 Click the Apply 

button to proceed. 

 

 

The IMDPlus analysis will now run.  

Utilities 

IMDPlus  >  

Moving Load >  

Moving Load 
Analysis... 
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 When the graph has been displayed, close the graph 

 If the IMDPlus toolbar has been enabled, 

 Click on the  button in the toolbar to open the IMDPlus Output Control dialog 

If the IMDPlus toolbar is not enabled, 

 Open the IMDPlus Moving Load Analysis Control dialog through the menu and 

click Next > to keep the existing analysis control settings and open the IMDPlus 

Output Control dialog. 

 

 Select Acceleration results of AZ for the vertical component only 

 Click the Apply button to display a graph of acceleration versus speed at the mid-

span. 

Utilities 

IMDPlus  >  

Moving Load >  

Moving Load 
Analysis... 
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 When the graph has been displayed, close the graph 

Stress Resultant Graphs for Shells 

In the previous section the displacement and acceleration responses at the mid-span of 

the bridge were investigated. We will now look at the stress resultants in the web of one 

of the main girders. Results for element number 1193 in the centre of the web of the 

nearside girder will be investigated. 

If the IMDPlus toolbar has been enabled, 

 Click on the  button in the toolbar to open the IMDPlus Output Control dialog 

If the IMDPlus toolbar is not enabled, 

 Open the IMDPlus Moving Load Analysis Control dialog through the menu and 

click Next > to keep the existing analysis control settings and open the IMDPlus 

Output Control dialog. 

 

Enter the following information into the IMDPlus Output Control dialog. 

Utilities 

IMDPlus  >  

Moving Load >  

Moving Load 
Analysis... 
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 Select Element and 

ensure Extent 

remains set as 

Individual 

 Enter Element 

number 1193 and set 

Gauss Point to 1 

 Select 

Force/Moment – 

Thick Shell results 

of Nx which is the 

stress resultant in the 

longitudinal bridge 

direction. 

 Ensure Individual 

items is selected. 

Sum of chosen items 

and Average of 

chosen items will 

not be available as an individual element is being processed. 

 Ensure the Response time history option is selected. 

 Deselect the Peak response summary option. 

 Set the Speed to graph as 12:70.0 which indicates that the twelfth and last speed of 

70 m/s is being processed. 

 Click the Apply button to display a graph of Nx versus time for gauss point 1 of 

element 1193. 

The IMDPlus analysis will now run and a graph of Nx versus time for gauss point 1 of 

element 1193 will be displayed. 
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 When the graph has been displayed, close the graph 

If the IMDPlus toolbar has been enabled, 

 Click on the  button in the toolbar to open the IMDPlus Output Control dialog 

If the IMDPlus toolbar is not enabled, 

 Open the IMDPlus Moving Load Analysis Control dialog through the menu and 

click Next > to keep the existing analysis control settings and open the IMDPlus 

Output Control dialog. 

 

 Select Force/Moment – Thick Shell results of Mx which is the moment in the 

along bridge direction 

 Click the Apply button to proceed. 

After a short pause a graph of Mx versus time for gauss point 1 of element 1193 will be 

created. 

Utilities 

IMDPlus  >  

Moving Load >  

Moving Load 
Analysis... 
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 When the graph has been displayed, close the graph 

If the IMDPlus toolbar has been enabled, 

 Click on the  button in the toolbar to open the IMDPlus Output Control dialog 

If the IMDPlus toolbar is not enabled, 

 Open the IMDPlus Moving Load Analysis Control dialog through the menu and 

click Next > to keep the existing analysis control settings and open the IMDPlus 

Output Control dialog. 

 

 Deselect the Response time history option 

 Select the Peak response summary option and select Absolute 

 Click the Finish button. 

 Click Yes when asked whether to free up disk space by deleting the temporary files 

created by IMDPlus. 

A graph of absolute peak Mx versus speed for gauss point 1 of element 1193 will be 

generated. 

Utilities 

IMDPlus  >  

Moving Load >  

Moving Load 
Analysis... 
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 Close the graph window. 

Displaying Results for a Selection of Nodes and Elements 

In the preceding sections the analyses utilised individual nodes and elements of the 

structure. In the following sections chosen sets of nodes and elements will be used in 

order to investigate the following results for the bridge structure: 

 Averaged and peak displacements and dynamic amplification factors 

 Total summed reactions and peak reactions 

 Averaged and peak stresses in a side panel 

Averaged and Peak Displacements and Dynamic 

Amplification Factors for the Bridge Structure 

In order to examine the averaged and peak displacements and dynamic amplification 

factors, a selection of nodes needs to be created that contains all of the nodes of the 

bridge structure.  

 Turn off the Geometry layer in the Treeview. 

 In the  Treeview click the right-hand mouse button on the group name 

Bridge_Structure and select the Set as Only Visible option from the drop-down 

menu. 

 Using Select Nodes drag a box to select all of the 1665 nodes of the bridge 

structure, as shown in the following figure. 



Train Induced Vibration of a Bridge 

 140 

Drag a box to select all the

nodes of the bridge structure

 

 Open the IMDPlus Moving Load Analysis Control dialog through the menu or click 

on the  button in the toolbar. 

 On the IMDPlus Moving Load Analysis Control dialog click the Next button to 

accept the previously defined values. When prompted about the total mass 

participation click the Yes button to continue. 

Enter the following information into the IMDPlus Output Control dialog. 

Utilities 

IMDPlus  >  

Moving Load >  

Moving Load 
Analysis... 
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 Select Node and 

change Extent to 

Selected using the 

drop-down list. This 

chooses all 1665 

nodes of the bridge 

structure that were 

selected in the 

preceding step. 

 Select result entity 

Displacement and 

component DZ 

 Deselect Individual 

items and select 

Average of chosen 

items as only the 

averaged results for 

the selected nodes 

are going to be 

investigated. 

 Ensure Peak response summary remains selected, then select Positive/negative 

and Envelope 

 Ensure Generate graphs in Modeller remains selected 

 Click the Apply button to perform the analysis. Click Yes when asked whether you 

want to process all of the selected nodes. 

The IMDPlus analysis will now run. On modern computers this will take under 15 

minutes.  

Note.  Any combination of the options Individual items, Sum of chosen items and 

Average of chosen items output can be used together in an IMDPlus analysis, 

although using the Individual items option when Extent is set to Selected or All 

(nodes or elements) may produce a large number of graphs, depending on the number 

of nodes or elements chosen for processing. 

Note.  Average of chosen items obtains results by first summing the results from the 

selected nodes. A simple average of this summed result is obtained to give the averaged 

node time histories from which the peak average results are obtained. 

A graph of peak positive and negative results for the averaged vertical (DZ) 

displacements, for all of the speeds analysed, 15m/s to 70m/s, is displayed as shown in 

 


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the following figure. It can be seen that the largest peaks occur at a speed of 55m/s, 

with positive and negative peak values of 0.0013m and -0.0061m respectively. 

 

An envelope of the peak displacements and rotations for the selected nodes is displayed 

in Notepad in file peak_dspSet1.sum. By investigating all of the speeds analysed it can 

be seen that the individual peak vertical (DZ) displacements also occur at a moving 

load speed of 55m/s. These are shown in the following figure and both positive and 

negative peak Z-displacements occur at node 1624 with respective values of 0.0044m at 

time 4.656 seconds and -0.0204m at time 6.826 seconds. 

Note.  The envelope of the peak results is obtained in IMDPlus by examining the 

individual results from all of the nodes in the bridge structure. This enables the 

locations of the nodes with maximum and minimum results to be quickly identified. 

 

 Close the Notepad application and graph windows. 
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If the IMDPlus toolbar has been enabled, 

 Click on the  button in the toolbar to open the IMDPlus Output Control dialog 

If the IMDPlus toolbar is not enabled, 

 Open the IMDPlus Moving Load Analysis Control dialog through the menu and 

click Next > to keep the existing analysis control settings and open the IMDPlus 

Output Control dialog. 

 

Enter the following information into the IMDPlus Output Control dialog. 

 Select result entity Dynamic Amplification Factor and component DAF_RSLT 

 Ensure Peak response summary and Envelope remain selected and select 

Absolute 

 Click the Finish button. Click Yes when asked whether you want to process all of 

the selected nodes. 

 Click Yes when asked whether to free up disk space by deleting the temporary files 

created by IMDPlus. 

A graph showing the absolute peak of the average resultant dynamic amplification 

factor against speed is displayed, as shown in the following figure. This shows that a 

maximum averaged DAF of 1.215 occurs at speed 55m/s. 

Note.  Only averaged dynamic amplification factor results can be obtained for a set of 

nodes as summed results are meaningless for this result entity. 

 

Utilities 

IMDPlus  >  

Moving Load >  

Moving Load 
Analysis... 
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An envelope of the peak dynamic amplification factors for the selected nodes is 

displayed in Notepad in file Abs_peak_dafSet1.sum is. These results indicate that the 

individual peak resultant DAF occurs at a speed of 60m/s. A value of 1.71 is calculated 

at a solution time of 0.529 seconds at node 34. 

 

 Close the Notepad application and graph window. 

Total and Peak Reactions for the Bridge Structure 

The total sum of the reactions and the peak reactions that act on the bridge structure for 

each of the moving load speeds will now be investigated. The set of nodes from the 

preceding section could be utilised for this purpose. However, in order to improve the 

efficiency of the IMDPlus solution, the chosen selection of nodes will be reduced so 

that it only includes the geometric features that contain the supported nodes of the 

bridge structure. 

 Click the left-hand mouse button in a blank part of the graphics window to remove 

the node selection created in the preceding section. 

 In the LUSAS graphics window click on the Supports on/off button to show the 

supported nodes in the model. 

 In the  Treeview click the right-hand mouse button on the group name 

Bridge_Structure and select the Set as Only Visible option from the drop-down 

menu. 

 Turn on the Geometry layer in the Treeview. 

 Using Select Volumes drag a box around the entire bridge structure to select the 

volumes immediately above the bridge supports, as shown in the following figure. 
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Drag a box to select the

volumes of the bridge structure

 

 Click the right-hand mouse button in a blank part of the graphics window and select 

the Keep as Only Visible option. Only the selected volumes will remain visible. 

  Using Select Nodes drag a box to select the 120 visible nodes of the bridge 

structure, as shown in the following figure. 
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Drag a box to select all

of the visible nodes

 

 Open the IMDPlus Moving Load Analysis Control dialog through the menu or click 

on the  button in the toolbar. 

 On the IMDPlus Moving Load Analysis Control dialog click the Next button to 

accept the previously defined values. When prompted about the total mass 

participation click the Yes button to continue. 

Enter the following information into the IMDPlus Output Control dialog. 

Utilities 

IMDPlus  >  

Moving Load >  

Moving Load 
Analysis... 
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 Select Node and 

ensure Extent 

remains set to 

Selected. This 

chooses the 120 

visible nodes of the 

bridge structure that 

were selected in the 

preceding step. 

 Select result entity 

Reaction and 

component FZ 

 Deselect Average of 

chosen items and 

select Sum of chosen 

items. Ensure 

Individual items 

remains deselected. 

 Select Response 

time history 

 Ensure Peak response summary and Envelope remains selected and select 

Positive/negative 

 Ensure Generate graphs in Modeller remains selected. 

 Set the Speed to graph as 9:55.0 which indicates that the ninth and speed of 55 m/s 

is being processed 

 Click the Finish button to perform the analysis of the node set. Click Yes when 

asked whether you want to process all of the selected nodes. 

 Click Yes when asked whether to free up disk space by deleting the temporary files 

created by IMDPlus. 

Note.  Sum of chosen items adds together the results from the selected nodes to give 

the summed nodal time histories from which the peaks of the summed results are 

obtained.  

Note.  Average of chosen items obtains results by first summing the results from the 

selected nodes. A simple average of this summed result is obtained to give the averaged 

node time histories from which the peak average results are obtained. 

 


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The summed nodal results that give the total vertical reactions acting on the bridge 

structure are displayed. The graph of the peak positive and negative summed reaction in 

the Z-direction for all of the speeds analysed is shown in the following figure. 

Examining the results for each speed shows a positive peak reaction of 976.6kN at a 

train speed of 55m/s and a negative holding down peak reaction of -159.0kN at a speed 

of 60 m/s. 

 

In addition, the following figure shows the time history of the summed FZ reactions for 

the analysis speed of 55m/s. For this speed it can be seen that the positive peak value of 

976.6kN occurs at an analysis time of 6.81 seconds. 
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The envelope of the peak reactions from file peak_rctSet1.sum are displayed in a 

Notepad application. These give a summary of the peak reactions obtained from all of 

the individual nodes of the bridge structure for each of the moving load speeds 

analysed. The vertical (FZ) component of interest shows consistently that the maximum 

positive reaction (from a downward force) occurs at node 82 and the maximum 

negative reaction (from an upward force) occurs at node 112. Results for speeds of 

55m/s and 60m/s are shown in the following figure.  

 

The maximum positive reaction of 259.9kN occurs at a time 0.576 seconds for speed 

55m/s and the maximum negative reaction of -145.1kN occurs at a time 6.367 seconds 

for speed 60m/s. 

 Close the Notepad application and graph windows. 

The nodes 82 and 112 representing two of the vertical supports for the bearings of the 

bridge will now be located in the model. 

 Click the left-hand mouse button in a blank part of the graphics window to remove 

the node selection created in the preceding section. 
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 In the  Treeview click the right-hand mouse button on the group name 

Bridge_Structure and select the Set as Only Visible option from the drop-down 

menu. 

 Turn off the Geometry layer in the Treeview. 

 With no features selected click the right-hand mouse button in a blank part of the 

graphics window and select the Labels option to add the labels to the Treeview. 

 On the Properties dialog select the Name/Node and Label selected items only 

check boxes. 

 Click the Font... button and select Font: Arial, Font style: Bold, Size: 20 and click 

OK.  

 Click the OK button to accept all other settings. This will turn on the layer in the 

graphics window. 

 With no features selected click the right-hand mouse button in a blank part of the 

graphics window and select the Advanced Selection... option. 

 Select Type and Name, select Node from the drop-down list and enter node 

number 82 

 Select Add to selection and click the Apply button to accept all other settings. 

Node 82 will be highlighted in the graphics window.  

 Enter node number 112 and click the OK button. Node 112 will also be displayed in 

the graphics window, as shown in the following figure. 
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 Click the left-hand mouse button in a blank part of the graphics window to remove 

the node selection. 

 

Average and Peak Stresses in a Side Panel of the Bridge 

Structure 

Finally, the average peak and total peak in-plane shear stresses in a side panel of the 

bridge structure will be investigated. 

 Double-click on the Labels layer name in the Treeview. 

 On the Properties dialog de-select the Name/Node check box and select the 

Name/Element check box.  Click the OK button. 

 Select the six elements that form the side panel of the bridge structure shown in the 

following figure. 
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Note.  Only elements of the same type, for example, thick beam elements, continuum 

elements or thick shell elements can be used in a set of IMDPlus elements. However, 

the element set may contain elements with different numbers of Gauss points or nodes. 

 Open the IMDPlus Moving Load Analysis Control dialog through the menu or click 

on the  button in the toolbar. 

 On the IMDPlus Moving Load Analysis Control dialog click the Next button to 

accept the previously defined values. When prompted about the total mass 

participation click the Yes button to continue. 

Enter the following information into the IMDPlus Output Control dialog. 



Utilities 

IMDPlus  >  

Moving Load >  

Moving Load 
Analysis... 
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 Select Element and 

set Extent to 

Selected from the 

drop-down list. This 

chooses the 6 

elements of the 

bridge structure that 

were selected in the 

preceding step. 

 Select result entity 

Stress (middle) – 

Thick Shell and 

component Sxy 

 Deselect Sum of 

chosen items and 

select Average of 

chosen items. Ensure 

Individual Output 

remains deselected. 

 Deselect Response time history 

 Ensure Peak response summary, Positive/negative and Envelope all remain 

selected. 

 Ensure Generate graphs in Modeller remains selected. 

Note.  As Extent has been set to Selected the drop-down lists Element and Gauss 

Point are not available for selection. In addition the element Gauss Point is 

automatically set to All as multiple elements are going to be processed in a single 

analysis. 

 Click the Finish button to perform the analysis of the element set. Click Yes when 

asked whether you want to process all of the selected elements. 

 Click Yes when asked whether to free up disk space by deleting the temporary files 

created by IMDPlus. 

The graph shown in the following figure is displayed. It shows the peak positive and 

negative, average middle shear stress, Sxy, for the side panel of the bridge structure. 

The largest positive and negative peaks occur at a speed of 55m/s with values of 

2.05Mpa and -10.2MPa respectively. 

Note.  Average of chosen items obtains the element results by first summing the 

results from all of the Gauss points of the selected thick shell elements. A simple 

 


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average of these summed results is obtained to give the average element response time 

histories from which the peak average results are obtained. 

 

An envelope of the peak element stresses for each of the moving load speeds is 

displayed in Notepad in file peak_stressSet1.sum. This gives a summary of the peak 

stresses and stress resultants obtained by examining all of the individual Gauss point 

results of the selected elements. The results for speed 55m/s are shown in the following 

figure. The maximum positive and negative middle in-plane shear (Sxy) stress occurs at 

Gauss point 2 of element 560. Values of 2.69MPa at time 7.224 seconds and -13.6MPa 

at time 6.986 seconds are observed. 
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 Close the Notepad application and graph windows. 

 

Save the model 

Save the model. 

 

This completes the example. 

 

 

File 

Save… 
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High Speed Train 

Modelling through 

Sprung Masses 

For software product(s):  Any Plus version 

With product option(s): IMDPlus 

Note: The example exceeds the limits of the LUSAS Teaching and Training Version 

and requires approximately 4 GB of disk space. 

Description 

 

This example examines the response of a two-span continuous beam to the passage of a 

Chinese CRH high speed train modelled as sprung masses based on the paper by Wang 

et al, Latin Journal of Solids and Structures 7 (2010). 

Units used are N, m, kg, s, C throughout. 

Objectives 

The output requirements of the analysis are: 

 Vertical mid-span deflection response of the two spans for a train speed of 250 

kph 

 Peak mid-span vertical deflections in the Y-direction for train speeds between 25 

kph and 600 kph in 25 kph increments 
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 Vertical mid-span deflection response of the two spans for a train speed of 300 

kph, the critical velocity exciting the first resonant frequency of the continuous 

beam 

 Displacement time histories of the body and wheel of the first and last spring-

mass systems for a train speed of 300 kph and acceleration time histories of the 

bodies 

 Peak acceleration time histories of all locomotive and passenger bodies over the 

speed range of 25 kph to 600 kph 
  

Keywords 

Moving mass, time domain, response, interactive modal dynamics,  IMDPlus, 

eigenvalue. 

Associated Files 

 CRH Train.lmd  Attribute library that contains the CRH train definition for 

the example. 
  

 CRH_Wheelset_Positions.xls Microsoft Excel spreadsheet that 

contains the wheel positions and spring-mass system identifiers of the CRH train 

for the example. 

Modelling 

Running LUSAS Modeller 

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller 

in the Examples Manual Introduction. 

Note.  This example is written assuming a new LUSAS Modeller session has been 

started. If continuing from an existing Modeller session select the menu command File 

> New to start a new model file. Modeller will prompt for any unsaved data and display 

the New Model dialog. 

Creating a new model 

 Enter the file name as IMDPlus CRH High Speed Train 

 Choose User-defined and browse to the \<LUSAS Installation Folder>\Projects\ 

folder, click on the Make New Folder button and enter IMDPlus CRH Analysis as 

the folder name and click the OK button 

 Enter the title as IMDPlus Sprung Mass Modelling of CRH High Speed Train 

 Ensure the model units are N,m,kg,s,C 


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 Ensure the timescale units are Seconds 

 Ensure the analysis type is Structural 

 Ensure the Startup template is None 

 Select the Vertical Y axis option and click OK 

Feature Geometry 

 Enter coordinates of (0, 0), (20,0) and (40, 0) to define the lines representing the 

main features of the two-span continuous beam. 

This completes the geometry for the beam that the train will pass across. A further line 

must also be defined which will be used by IMDPlus to define the path that the train 

passes along since this line cannot form part of the physical structure. 

 Enter coordinates of (0, 10) and (40, 10) to define the line above the two-span 

continuous beam that represents the path of the train (line is defined above for ease of 

selecting, the train loading will be projected from this line vertically onto the structure). 

Meshing 

The Line features representing the two-span continuous beam are to be meshed using 

two-dimensional beam elements. 

 Select Thick beam, 2 dimensional, Linear elements.  

 Set the number of divisions to be 20 

 Enter the attribute name as Thick Beam then click OK 

 Select the lines defining the two-span continuous beam.  

 Drag and drop the mesh attribute Thick Beam from the  Treeview onto the 

selected model Lines. 

40 BEAM elements will be created along the lines. 

Material Properties 

The Line features representing the two-span continuous beam are to be assigned C50 

concrete in accordance with the China National Standard: Code for Design of Concrete 

Structures. 

Geometry 

Line > 

Coordinates… 

Geometry 

Line > 

Coordinates… 

Attributes 

Mesh > 

Line... 
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 Select Concrete China material. 

 Select GB50010-2002 C50 grade. 

 Click OK to define the material. 

 With the lines defining the two-span beam 

still selected, drag and drop the material 

attribute Iso1 (Concrete China 

GB50010-2002 C50) from the  

Treeview onto the selected model Lines. 

Geometric Properties 

The Line features representing the two-span continuous beam are to be assigned with a 

custom section equivalent to the properties used in the paper by Wang et al. In this 

paper the flexural rigidity EI value of 2.5E10 N/m
2
 and mass per unit length of 

3.4088E4 kg/m equate to the properties entered below. 

 Select the usage as 2D 

Thick Beam 

 Ensure the definition is set 

to Enter Properties  

 Set the Cross sectional 

area (A) as 13.368  

 Set the Second moment of 

area about z axis (Izz) as 

0.724638  

 Set the Effective shear 

area in y direction (Asy) 

as 13.368E3  

 Ensure the Eccentricity in 

y direction (ey) is set to 

0.0  

 Enter the attribute name as 

Cross-Section and click 

OK 

 With the lines defining the 

two-span beam still 

selected, drag and drop 

Attributes 

Material  > 

Material Library … 

 

Attributes 

Geometric  > 

Line … 
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the geometric attribute Cross-Section from the  Treeview onto the selected 

model Lines. 

Note.  The effective shear area has been set to 1000 times the area of the section to 

effectively remove shear deformation from the calculations of the beams. The paper 

uses Bernoulli-Euler beams which do not account for shear deformations. 

Supports 

The continuous beam is supported with a pinned support at the left-hand end and is 

supported by roller supports at the middle and right-hand end of the beam. 

 Set the Translation in X as Fixed 

 Set the Translation in Y as Fixed  

 Enter the attribute name as Pinned and click Apply 

 Set the Translation in X as Free 

 Leave the Translation in Y as Fixed 

 Enter the attribute name as Roller and click OK  

 Assign the Pinned support to the left-hand point, and the Roller support to the other 

two points on the model as indicated below, clicking OK to accept the defaults 

when the Assign Support dialog appears. 

 


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Loading 

To allow the IMDPlus moving mass analysis to be carried out a unit load representing 

the action of the spring-mass system on the beam needs to be included in the model so 

this can be passed across the beam to calculate the modal forces. 

 Click the left-hand mouse button in a blank part of the graphics window to remove 

all items from the selection. 

 On the Structural 

Loading dialog 

select the Point 

type from the 

Discrete loading 

section and click 

the Next button 

 Ensure that 

Arbitrary is 

selected 

 Ensure that the 

Untransformed load 

direction is set to Y  

 Ensure the Project 

in load direction is 

selected 

 Enter a single load 

into the grid with the X set to 0.0 , Y set to 0.0 , Z set to 0.0 and the Load set to -1 

so it acts downwards in the global Y axis direction 

 Enter the attribute name as Unit Wheelset Load and click Finish  

Search Area 

When the discrete load representing the single unit wheelset is passed across the 

structure it is best practice to target the action of this load to the model using a search 

area. 

 Set the attribute name as Continuous Beam and click OK   

 Select the lines defining the two-span continuous beam.  

Attributes 

Loading… 

 

Attributes 

Search Area… 
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 Drag and drop the search area attribute Continuous Beam from the  Treeview 

onto the selected model Lines. 

 Click the left-hand mouse button in a blank part of the graphics window to remove 

all items from the selection. 

Defining Eigenvalue Controls 

Eigenvalue controls are defined as properties of the loadcase. 

 In the  Treeview expand Analysis 1 then right-click on Loadcase 1 and select 

Eigenvalue from the Controls menu.  

The Eigenvalue dialog will appear. 

The following parameters need to be specified: 

 Ensure the Solution is set to Frequency 

 Set the Eigenvalues required to Range 

 Ensure the Range specified as is set to Frequency  

 Set the Minimum frequency as 0 

 Set the Maximum frequency as 50  

 Set the Number of eigenvalues as 0 to solve for all modes in the range 

 Ensure the Type of eigensolver is set as Default 

Note.  Eigenvalue normalisation is set to Mass by default. This is essential if the 

eigenvectors are to be used for subsequent IMD analyses. 

 Click the OK button to finish. 

 Save the model file. 

Running the Analysis 

 With the model loaded click the Solve button  and the Solve Now dialog will be 

displayed. 

 Click the OK button to run the analysis. 

A LUSAS Datafile will be created from the model information. The LUSAS Solver 

uses this datafile to perform the analysis. 


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Viewing the Results 

If the analysis was run from within LUSAS Modeller the results will be loaded on top 

of the current model and the loadcase results for each eigenvalue can be seen in the  

Treeview. Eigenvalue 1 is set to be active by default. 

Checking the Frequencies 

The Wang et al paper lists only the first two frequencies but the other vertical 

frequencies can be calculated from the equations in the paper. These frequencies of the 

vertical modes below 50 Hz of the Bernoulli-Euler beams are listed below: 

f1 = 3.363 Hz, f2 = 5.255 Hz, f3 = 13.452 Hz, f4 = 17.025 Hz, f5 = 30.267 Hz,                   

f6 = 35.522 Hz 

The frequencies obtained from the analysis are obtained from the Print Results Wizard. 

 Select Active and click Next. 

 Select Entity None and from the Type drop-down menu select Eigenvalues and 

then click Finish.  The eigenvalue / frequency results will be printed to the Text 

Output window.  

It can be seen that LUSAS has obtained 7 modes of vibration in the range of 0 to 50 Hz. 

All of the modes of vibration listed above for the Bernoulli-Euler beam are closely 

matched but with an additional mode of vibration, mode 5, at 22.990 Hz which was not 

captured in the paper. This will be shown to be a horizontal mode of vibration below 

which is not considered by Wang et al. 

     MODE    EIGENVALUE      FREQUENCY       ERROR NORM 

        1     445.894         3.36075        0.100680E-10 

        2     1087.93         5.24953        0.414174E-11 

        3     7105.85         13.4162        0.828539E-12 

        4     11376.9         16.9759        0.470560E-12 

        5     20866.7         22.9904        0.843402E-12 

        6     35737.0         30.0870        0.219183E-09 

        7     49189.1         35.2984        0.466222E-06 

Checking the Mass Participation Factor 

Note.  In order to carry out a successful IMDPlus analysis you should ensure that a 

significant proportion of the total mass has been accounted for in the analysis. Ideally 

this requires checking that around 90% of the total mass has been achieved in the global 

directions. If less than 90% has been achieved no further modes need be included if the 

Utilities 

Print Results 
Wizard… 
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modes of vibration omitted cannot be excited by the dynamic input or a significant 

proportion of the structure is restrained by support in these directions and therefore 

cannot participate in the modes of vibration. The acceptability of the included modes of 

vibration will vary from analysis to analysis but failure to check that a significant 

proportion of the total mass has been accounted for may lead to important modes being 

missed and subsequent errors in the analysis results.   

Note.  The mode shapes should also be checked as a mode can have a low mass 

participation factor and still be significant in the analysis. This often occurs with 

‘symmetrical modes’ where equal mass is moving in opposite directions in the mode 

shape. This is the case for the first mode in this analysis which is a simple sinusoid 

shape with one span moving up with the other of equal length and mass moving down. 

This mode has a zero mass participation factor in the Y-direction but is an important 

mode in the analysis (see the resonance of the beam to the train speed later in the 

example). A certain amount of engineering judgement is therefore required for the 

assessment of the importance of modes of vibration and this should be used in addition 

to the simple checks on the sum of the mass participation included in the analysis. 

 Select Active and click Next. 

 Select Entity None and from the Type drop-down menu select Sum mass 

participation factors and then click Finish.  The Sum Mass Participation Factors 

results will be printed to the Text Output window.  

In can be seen that the 90% value has almost been achieved in both the X- and Y-

directions and is discussed in the note below. 

     MODE    SUM MASS X     SUM MASS Y       SUM MASS Z 

        1    0.175061E-36    0.439835E-26     0.00000 

        2    0.135185E-34    0.738434         0.00000 

        3    0.178691E-30    0.738434         0.00000 

        4    0.338629E-29    0.745294         0.00000 

        5    0.810569        0.745294         0.00000 

        6    0.810569        0.745294         0.00000 

        7    0.810569        0.856006         0.00000 

Note.  In this analysis we are only including the first 7 modes of vibration with 

frequencies up to and including 50 Hz. These 7 modes include the 6 vertical modes 

considered by Wang et al and also an additional horizontal mode, mode 5, with 81.06% 

mass participation in the X-direction. If more than 7 modes of vibration were included 

then the sum mass participation would approach the 90% in all directions (solving from 

0 to 100 Hz will give 12 modes of vibration which will give 90.06% in the X-direction 

and 89.97% in the Y-direction but these higher modes may not be excited by the 


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passage of the trainset and may not significantly contribute to the vibration response of 

the structure). 

 Close the text windows by selecting the close button in the top right hand corner of 

the windows. 

 Use the maximise button to increase the size of the graphics window. 
  

Note.  To simplify the use of IMDPlus for the rest of the example it is recommended 

that the IMDPlus toolbar is enabled in LUSAS Modeller. To do this select the View > 

Toolbars... menu command and enable the IMDPlus option in the list and click Close. 

 

 If the IMDPlus toolbar has been enabled, click on the  Moving Mass analysis 

button in the toolbar to select a moving mass analysis and enable the toolbutton 

shortcuts to the dialogs. 

Defining the CRH Trainset 

Before the analysis can be performed we need to define the sprung mass representation 

of the CRH Chinese high speed trainset in LUSAS Modeller. This is a two stage 

process where  

1. the individual spring-mass definitions for the wheelsets / bogies / bodies need 

to be defined, 

2. the complete trainset configuration is defined. 

The spring-mass representation from the paper will be used for the analysis which 

includes only a single spring-mass definition that is used for all of the wheelsets of the 

trainset. 

 Open the IMDPlus Spring-Mass System Properties dialog through the menu or click 

on the  button in the toolbar. The wheelsets / bodies of the CRH train will be 

defined with the wheelset as the unsprung mass and the body as the first spring-

mass. 


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 Select Single sprung mass from the drop-down list.  

 Ensure Damping is selected. 

 Enter the Mass of the Unsprung mass as 3300 

 Enter the Mass of Sprung mass 1 as 9500 

 Enter the Elastic spring stiffness of Sprung mass 1 as 2.5E5 

 Enter the Viscosity coefficient of Sprung mass 1 as 4.5E4 

 Enter the Name as CRH Train Wheelset  

 Click the OK button. 

The Chinese CRH trainset in the paper consists of a total of eight cars. Using the 

dimensions shown in the paper results in the following spring-mass systems to define 

the total trainset. 

 

 



High Speed Train Modelling through Sprung Masses 

 168 

Car Distance from Previous Axle (m) Distance from front of train (m) 

Locomotive 0 0.0 

Locomotive 2.5 -2.5 

Locomotive 15 -17.5 

Locomotive 2.5 -20.0 

Passenger 1 5 -25.0 

Passenger 1 2.5 -27.5 

Passenger 1 15 -42.5 

Passenger 1 2.5 -45.0 

Passenger 2 5 -50.0 

Passenger 2 2.5 -52.5 

Passenger 2 15 -67.5 

Passenger 2 2.5 -70.0 

Passenger 3 5 -75.0 

Passenger 3 2.5 -77.5 

Passenger 3 15 -92.5 

Passenger 3 2.5 -95.0 

Passenger 4 5 -100.0 

Passenger 4 2.5 -102.5 

Passenger 4 15 -117.5 

Passenger 4 2.5 -120.0 

Passenger 5 5 -125.0 

Passenger 5 2.5 -127.5 

Passenger 5 15 -142.5 

Passenger 5 2.5 -145.0 

Passenger 6 5 -150.0 

Passenger 6 2.5 -152.5 

Passenger 6 15 -167.5 

Passenger 6 2.5 -170.0 

Locomotive 5 -175.0 

Locomotive 2.5 -177.5 

Locomotive 15 -192.5 

Locomotive 2.5 -195.0 

 

 Open the IMDPlus Moving Mass Vehicle Configuration dialog through the menu or 

click on the  button in the toolbar. 

The moving mass vehicle is now defined using the Distance from front of train in the 

table above and the spring-mass system. To simplify the definition of the vehicle the 

positions and identifiers of the spring-mass systems are included in a Microsoft Excel 

spreadsheet so they can be copied and pasted into the dialog. 

Utilities 

IMDPlus  >  

Moving Mass >  

Vehicle 
Configuration... 
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 Locate the 

CRH_Wheelset_Positions.xls 

spreadsheet in the 

\<LusasInstallationFolder>\

Examples\Modeller folder 

and open it. 

 Select all of the 32 positions 

and spring-mass system 

identifiers in the first and 

second columns and copy 

these to the clipboard using 

Ctrl+C 

 Select both the Position  and 

Spring-mass system headers 

of the grid in the dialog and 

paste these into the grid using 

Ctrl+V 

 Enter the Name as CRH Train 

Once finished the dialog should appear as shown. 

   Click OK to create the vehicle configuration. 

Note.  Alternatively each Position in the table can be entered manually and the 

Spring-mass system associated with each of the wheelset/body positions can be 

selected from the drop-down lists containing the available spring-mass system property 

attributes. 

Note.  The positions of the wheelsets should be defined as negative values to ensure 

that the whole trainset passes over the structure. Negative values place the wheelsets 

behind the front of the train which is at a position of 0. The movement of the front of 

the train will be calculated from the start of the path to the end of the path with 

additional time included in the IMDPlus solution to allow all of the wheelsets with 

negative positions to pass along the path. 

If any wheelsets are defined with positive values then these will already be the distance 

down the path equivalent to the position entered in the trainset definition. Those 

wheelsets with positive positions may already be over the structure at the start of the 

IMDPlus analysis if the start of the path has not been defined to account for this. If any 

positive positions are used then always ensure that the lines defining the beginning of 

the path allow sufficient additional length in order to model the transition of the whole 

of the train onto the structure correctly. 

 


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Note.  Once a trainset or vehicle has been defined it can be saved in a library so it can 

be imported and used in future analyses without the need to go through all of the 

definition process above. This is achieved through the Library Browser accessed 

through the File > Import/Export Model Data... menu command. 

Importing a Vehicle  

If it proves time consuming or you are unable to obtain the same results shown later in 

the example the spring-mass system and vehicle definition can be imported from the 

library provided in the \<LusasInstallationFolder>\Examples\Modeller folder. 

 CRH Train.lmd  contains the vehicle library for the example.  
 
 

 Select the Import from library to model option 

 Click on the Choose file... button and browse to the CRH Train.lmd file in the 

\<LusasInstallationFolder>\Examples\Modeller folder. 

 Select the IMDPlus (2) entries in the tree 

 Click the OK button. 

 

After the spring-mass systems and vehicle 

attributes have been defined they will appear in 

the Utilities  treeview. 

To edit the spring-mass system or vehicle 

attributes simply double-click with the left 

mouse button or right-click and choose Edit 

Attribute... on the name of the attribute to bring 

up the original dialog. 

Moving Mass Analysis 

Moving mass calculations are performed using the IMDPlus (Interactive Modal 

Dynamics) facility. In order to carry out the moving mass analysis of the train travelling 

across the structure we need to carry out three stages: 

4. Define and set-up the path along which the spring-mass systems will travel 

using a unit load defined as either a discrete point or patch load. For this 

example the unit wheelset load has already been defined as a discrete point 

load called Unit Wheelset Load which acts vertically 


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5. Convert the loading along this path from this unit load into modal forces that 

are applied in the IMDPlus moving mass analysis, to compute the dynamic 

effects of the spring-mass systems on the response of the structure 

6. Run an IMDPlus moving mass analysis to calculate the response of the 

structure and the spring-mass systems 

Note.  This process is similar to the IMDPlus moving load analysis procedure but 

with the trainset / vehicle defined by the spring-mass systems rather than constant 

forces. 

Defining the Moving Mass Path 

To solve for the passage of the CRH train across the structure the path for the moving 

mass must be defined. Line 3 (the line representing the path of the moving mass) will be 

set to be the current selection. 

To ensure the whole model is visible: 

 In the  Treeview click the right-hand mouse button on the group name IMDPlus 

CRH High Speed Train.mdl and select the Visible option from the drop-down 

menu. 

 In the  Treeview click the right-hand mouse button and choose the On/Off option 

if it has been turned off or alternatively double-click on the Geometry layer name 

and click the OK button to accept the default settings if it was turned off. 

 Select the line shown (line 3) 

 

Note.  The path can be built from multiple lines and arcs but these must form a 

continuous path without branching. 
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 Open the IMDPlus Moving Load Generation dialog through the menu or click on 

the  button in the toolbar. 

On startup of the IMDPlus Moving Load Generation dialog, all valid discrete loads and 

search areas will be made available in the loading options along with information about 

the path defined by the current selection.  

In this example a single discrete load called Unit Wheelset Load which defines the unit 

loading from a single wheelset of the train is present along with a search area that is 

assigned to the bridge structure. 

 Ensure 1:Unit Wheelset Load is 

selected from the Moving load 

dataset list. 

 Ensure 1:Continuous Beam is 

selected from the Search area ID for 

the assignment of the discrete 

loading. 

 Ensure Project onto line is selected 

(the analysis is 2D so this should be 

the only option). 

 Click on the Advanced button to 

adjust the inclusion of load 

characteristics. On the Moving Load 

Advanced Options dialog choose the 

Exclude all load option for loads 

outside the search area, ensure the 

load factor is 1.0 and click the OK 

button. 

 On the IMDPlus Moving Load Generation dialog set the Incremental distance to 0.1 

Note.  Using search areas targets the application of the loading to the required 

features as described in the Modeller Reference Manual. 

Note.  By default the incremental distance is set to one tenth of the length of the line 

along which the load moves. 

 Leave all other settings as their defaults and click the OK button to proceed and 

choose Yes to save the current model. 

The program will now generate the loading information for the 401 locations of the unit 

wheelset along the path before returning control back to LUSAS Modeller. 

Utilities 

IMDPlus  >  

Moving Mass >  

Moving Load 
Generation... 
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Note.  The discrete loading locations defined by this dialog will be tabulated into five 

datafiles with a maximum of 100 loadcases each and the analyses will be performed 

automatically. These analyses will use the same file basename as the original model 

with a numeric indicator appended to it (e.g. _00001, _00002, etc). They are required 

for the modal force calculation stage. 

Generating the Modal Force History for the Moving Mass 

In the previous stage the passage of the unit train wheelset across the structure has been 

defined. The modal forces for the IMDPlus solution now need to be calculated using 

the Modal Force Calculator. 

 Open the IMDPlus Modal Force Calculator dialog through the menu or click on the 

 button in the toolbar. 

 Click the OK button to accept 

the default information and 

proceed. 

 

 

 

 

 

Identification of Output Nodes 

In this example all of the output relates to the mid-spans of the two-span continuous 

beam model. If the model is identical then these node numbers should be node 11 for 

the first span and node 31 for the second span as shown below. These nodes will be 

entered into the IMDPlus dialogs later. 
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Defining the Moving Mass Parameters 

All of the basic moving mass information has now been defined for the IMDPlus 

analysis. The next stage is to define the included modes, damping and speed 

parameters. 

 Open the IMDPlus Moving Mass Analysis Control dialog through the menu or click 

on the  button in the toolbar. 

 Ensure the Vehicle 

configuration contains 

1:CRH Train  

 Ensure that the Path 

surface profile is not 

selected. 

 Ensure that Included 

modes is set to All. If this 

is not the case, click on the 

Modify… button and 

ensure the All modes 

option is selected. 

 Click on the Modify... 

button to change the 

Default damping. Enter 

2.5 for the default 

damping and click the OK 

button. 

 In the Solution control 

section, click on the 

Utilities 

IMDPlus  >  

Moving Mass >  

Moving Mass 
Analysis... 
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Modify... button to change the advanced solution options. Click the Defaults button 

to set the default options and click the OK button. 

 Enter the Minimum Speed as 69.44, the Maximum Speed as 69.44 and the Speed 

Increment as 0 to analyse a single speed of 69.44 m/s which is equivalent to 250 

kph. 

 Enter the Quiet time after passage of load as 5  

 Deselect the IMDPlus determining time step (Nyquist) option so we can specify 

the required time step. 

 Enter the Solution time step as 2E-3 

 Click the Next button to proceed. When prompted about missing total mass due to 

mass participation factors below 90% choose Yes to continue. For this analysis we 

are only interested in the contributions of modes of vibration up to and including the 

first 7 modes (0 to 50 Hz) which means that we are not going to achieve the 90% 

total mass target. 

Vertical Mid-Span Displacement Responses 

The IMDPlus Output Control dialog will appear. This controls the results output for the 

model. The vertical displacement response at the mid-span of the two spans of the 

continuous beam, nodes 11 and 31, for a speed of 250 kph will be investigated. The 

first span, node 11 is investigated first. 

 Choose Node and select Extent as Individual 
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 Enter Node number 11 

(This is the node in the 

mid-span of the first span)  

 Select Displacement 

results of DY 

 Ensure Individual items 

is selected. Sum of chosen 

items and Average of 

chosen items will not be 

available as an individual 

node is being processed. 

 Ensure Response time 

history is selected. 

 Ensure Generate graphs 

in Modeller is selected. 

 Click the Apply to 

proceed with the analysis.  

 

Note.  Clicking the Apply button instead of the Finish button keeps the IMDPlus 

session active for subsequent graph plotting. 
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The graph generated shows the vertical displacement response at the mid-span of the 

first span of the continuous beam for the passage of the CRH trainset at 250 kph. The 

peak downwards deflection of the beam is approximately 2.6 mm and the peak upwards 

deflection approximately 1.7 mm. The quiet time after the passage of the trainset allows 

the decay of the response to be observed with most of the dynamic response damped 

out at around 8.5 seconds after the trainset first enters the continuous beam. The 

response matches the response of the first span in the Wang et al paper, noting that the 

sign conventions are opposite to the paper which has a positive vertical displacement in 

the downwards direction. 

 When the graph has been displayed, close the graph 

The vertical displacement response at the mid-span of the second span of the 

continuous beam for the speed of 250 kph will now be investigated. 

If the IMDPlus toolbar has been enabled, 

 Click on the  button in the toolbar to open the IMDPlus Output Control dialog 

If the IMDPlus toolbar is not enabled, 

 Open the IMDPlus Moving Mass Analysis Control dialog through the menu and 

click Next > to keep the existing analysis control settings and open the IMDPlus 

Output Control dialog. 

  
 Ensure Node and Extent as Individual are still selected 

 Enter Node number 31 (This is the node in the mid-span of the second span)  

 Ensure all other dialog input is unchanged. 

 Click the Finish to proceed.  

The IMDPlus will now proceed for the second span. The solution time for this analysis 

will be quicker than for the first node because of the presence of binary results 

databases that are saved to the disk. 

 Click No when asked whether to free up disk space by deleting the temporary files 

created by IMDPlus. Choosing no will save data extraction times for subsequent 

analyses at the cost of some disk space. 

Utilities 

IMDPlus  >  

Moving Mass >  

Moving Mass 
Analysis... 
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The graph generated shows the vertical displacement response at the mid-span of the 

second span of the continuous beam for the passage of the CRH trainset at 250 kph. 

The peak downwards deflection of the beam is approximately 3 mm and the peak 

upwards deflection approximately 1.6 mm. The response again matches the response of 

the second span in the Wang et al paper, noting that the sign conventions are opposite 

to the paper which has a positive vertical displacement in the downwards direction. 

 When the graph has been displayed, close the graph 

Peak Vertical Displacement of Mid-Spans for Multiple 

Speeds 

The response of the two spans of the continuous beam were investigated for a single 

speed of 250 kph. The response of these two spans for a range of speeds between 25 

kph and 600 kph (in 25 kph increments) is now investigated to determine the worst 

speeds for the response of the beam. 

 Open the IMDPlus Moving Mass Analysis Control dialog through the menu or click 

on the  button in the toolbar. 

Utilities 

IMDPlus  >  

Moving Mass >  

Moving Mass 
Analysis... 
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 Ensure that the Moving 

mass input and 

Mode/damping control 

sections of the dialog are 

unchanged from the 

previous analyses  

 Enter the Minimum Speed 

as 6.944, the Maximum 

Speed as 166.667 and the 

Speed Increment as 6.944 

to analyse a range of 

speeds between 6.944 m/s 

(25 kph) and 166.667 m/s 

(600 kph) in increments of 

6.944 m/s (25 kph). 

 Ensure the Quiet time after 

passage of load is 5  

 Ensure the IMDPlus 

determining time step 

(Nyquist) option is 

deselected and the 

Solution time step is 2E-3 

 Click the Next button to proceed. When asked whether the speed range is correct 

choose Yes to continue. When prompted about missing total mass due to mass 

participation factors below 90% choose Yes to continue.  
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 Ensure Node and Extent 

as Individual are still 

selected  

 Enter Node number 11  

 Ensure Displacement 

results of DY is selected. 

 Ensure Individual items 

is selected. 

 Deselect Response time 

history . 

 Select Peak response 

summary and Absolute  

 Ensure Generate graphs 

in Modeller is selected. 

 Click the Apply to 

proceed.  

 

IMDPlus will now calculate the sprung-mass and continuous beam interaction 

behaviours for all 24 of the speeds chosen in the 25 kph to 600 kph range. 

Note.  Due to the complexity of the equilibrium calculations of the compatible 

responses of the 32 spring-mass systems and the continuous beam as they pass along the 

path for the 24 speeds, the first analysis will take extra time to complete. Once this is 

done, so long as no changes to the modal information or analysis options are made, all 

subsequent solutions will be considerably faster due to the presence of binary results 

databases on disk. 
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The graph shows that the worst vertical displacement response of the first span occurs 

around 83.328 m/s which is equivalent to a train speed of 300 kph. At this speed the 

peak vertical displacement response is approximately 7 mm. A second peak is observed 

between speeds of 124.992 m/s (450 kph) and 131.936 m/s (475 kph). Both of these 

peaks agree with the Wang et al paper which states that the speeds where resonance is 

induced in the beam for the first two modes of vibration are 302.67 kph and 472.98 

kph. The magnitudes of the two peaks are also in agreement with Wang et al. 

 When the graph has been displayed, close the graph 

The peak vertical displacement response at the mid-span of the second span of the 

continuous beam for the same speed range will now be investigated. 

If the IMDPlus toolbar has been enabled, 

 Click on the  button in the toolbar to open the IMDPlus Output Control dialog 

If the IMDPlus toolbar is not enabled, 

 Open the IMDPlus Moving Mass Analysis Control dialog through the menu and 

click Next > to keep the existing analysis control settings and open the IMDPlus 

Output Control dialog. 

  
 Ensure Node and Extent as Individual are still selected 

 Enter Node number 31 

 Ensure all other dialog input is unchanged. 

 Click the Apply to proceed.  

Utilities 

IMDPlus  >  

Moving Mass >  

Moving Mass 
Analysis... 



High Speed Train Modelling through Sprung Masses 

 182 

The IMDPlus analysis will now proceed for the second span. The solution time for this 

analysis over the range of speeds will be much quicker than for the first node because of 

the presence of binary results databases that are saved to the disk. 

 

The graph shows that the worst vertical displacement response of the second span 

occurs again around 83.328 m/s which is equivalent to a train speed of 300 kph. At this 

speed the peak vertical displacement response is approximately 8.7 mm. A second peak 

is again observed between speeds of 124.992 m/s (450 kph) and 131.936 m/s (475 kph). 

Both of these peaks agree with the Wang et al paper and a more refined speed range 

would provide the same smooth curves in the paper. 

 When the graph has been displayed, close the graph 

Note.  The Wang et al paper considered speeds between 5 kph and 600 kph in very 

small increments and therefore appears much smoother than the two graphs above. If 

this analysis is conducted with a similar resolution of speed increment then the 

following graphs are obtained from IMDPlus which agree with those in the paper 

(plotted together in Microsoft Excel for a minimum speed of 5 kph, a maximum speed 

of 600 kph and a speed increment of 1 kph). 


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Resonant Response of Mid-Spans at 300 kph 

The train speed of 300 kph (83.328 m/s) showed that there was a resonant response in 

the continuous beam at around this speed. The time history response of the two mid-

span nodes of the continuous beam will now be investigated at this speed. 

 Click on a blank part of the model window to deselect the line (if it is still selected) 

 Right click on a blank part of the model window and choose Advanced Selection... 

 Set the Type and name as Node and enter 11,31 in the textbox 

 Click on OK to select both mid-span nodes 

 Open the IMDPlus Moving Mass Analysis Control dialog through the menu or click 

on the  button in the toolbar. 

Utilities 

IMDPlus  >  

Moving Mass >  

Moving Mass 
Analysis... 
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 Ensure that the Moving 

mass input and 

Mode/damping control 

sections of the dialog are 

unchanged from the 

previous analyses  

 Enter the Minimum Speed 

as 83.328, the Maximum 

Speed as 83.328 and the 

Speed Increment as 0 to 

analyse a single speed of 

83.328 m/s which is 

equivalent to 300 kph. 

 Ensure the Quiet time after 

passage of load is 5  

 Ensure the IMDPlus 

determining time step 

(Nyquist) option is 

deselected and the 

Solution time step is 2E-3  

 Click the Next button to proceed and click Yes when informed about the analysis 

having a mass participation below 90%. 
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 Choose Node and Extent 

as Selected  

 Ensure Displacement 

results of DY is selected 

 Ensure Individual items 

is selected 

 Ensure Sum of chosen 

items and Average of 

chosen items are 

deselected 

 Select Response time 

history 

 Deselect Peak response 

summary  

 Ensure Generate graphs 

in Modeller is selected 

 Ensure the Speed to graph 

is set to 1:83.328 

(equivalent to 300 kph) 

 Click the Apply to proceed 

 Choose Yes when asked whether you wish to process all selected nodes 

The responses of the two mid-span nodes are shown below, firstly for the first span 

(node 11) and secondly for the second span (node 31). In both figures the resonance of 

the continuous beam is observed until the departure of the last wheelset of the train 

from the structure after 2.82 seconds. After this time the damping causes the decay of 

the vertical response of the beam which will eventually return to a static state. 
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 When the graphs have been displayed, close the graphs 

Displacement Time Histories of First and Last Spring-

Mass Systems 

In the previous analyses attention was focused on the vertical displacement response of 

the continuous beam from the passage of the CRH trainset over a range of speeds. The 

response of the actual train is now investigated. 

If the IMDPlus toolbar has been enabled, 
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 Click on the  button in the toolbar to open the IMDPlus Output Control dialog 

If the IMDPlus toolbar is not enabled, 

 Open the IMDPlus Moving Mass Analysis Control dialog through the menu and 

click Next > to keep the existing analysis control settings and open the IMDPlus 

Output Control dialog. 

  
 Select Spring-mass 

system and Extent as 

Individual   

 Set the System to                 

1 (0.0) CRH Train 

Wheelset   

 Set the Result to 

Unsprung mass  

 Set the Entity to 

Displacement  

 Ensure all of the selections 

in the Output control are 

identical to the previous 

analysis 

 Click the Apply to 

proceed.  

 

 

 

The plotting of the results will now proceed. IMDPlus should not need to resolve the 

analysis since the spring-mass system results should already be available. 

Utilities 

IMDPlus  >  

Moving Mass >  

Moving Mass 
Analysis... 
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The second graph shows the curve after zooming into the first 0.5 seconds of the time 

history. This indicates that the displacement of the unsprung mass returns to zero (i.e. 

the first spring-mass system has left the structure) after about 0.48 seconds. This can be 

confirmed by dividing the total length of the continuous beam by the speed, 40 / 83.328 

= 0.48 seconds. 

 When the graph has been displayed, close the graph 

If the IMDPlus toolbar has been enabled, 

 Click on the  button in the toolbar to open the IMDPlus Output Control dialog 
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If the IMDPlus toolbar is not enabled, 

 Open the IMDPlus Moving Mass Analysis Control dialog through the menu and 

click Next > to keep the existing analysis control settings and open the IMDPlus 

Output Control dialog. 

  
 Ensure Spring-mass 

system is selected  

 Ensure Extent is set to 

Individual  

 Ensure the System is set     

1 (0.0) CRH Train 

Wheelset   

 Set the Result to Sprung 

mass 1  

 Ensure the Entity is set to 

Displacement  

 Ensure all of the selections 

in the Output control are 

identical to the previous 

analysis 

 Click the Apply to 

proceed.  

 

Utilities 

IMDPlus  >  

Moving Mass >  

Moving Mass 
Analysis... 
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The graph shows that the sprung mass representing the body of the first wheelset of the 

train displaces just over 2 mm from its static position 0.43 seconds after it first enters 

the continuous beam and the viscous damping of the spring-mass system quickly damps 

out the body motion within 2 to 2.5 seconds after the wheelset leaves the structure 

(which occurs at 0.48 seconds). 

 When the graph has been displayed, close the graph 

Note.  All results for the sprung masses are with respect to their static equilibrium 

positions. Static displacements of the sprung masses are summarised in the 

IMDPlus.log file at the beginning of the analysis. 

 

The last spring-mass system is 195 m behind the first one and therefore the continuous 

beam will have received dynamic input from 31 spring-mass systems by the time it 

enters the beam. As a result, the vertical displacement of the unsprung and sprung 

masses are expected to be different from the graphs presented above. 

If the IMDPlus toolbar has been enabled, 

 Click on the  button in the toolbar to open the IMDPlus Output Control dialog 

If the IMDPlus toolbar is not enabled, 

 Open the IMDPlus Moving Mass Analysis Control dialog through the menu and 

click Next > to keep the existing analysis control settings and open the IMDPlus 

Output Control dialog. 

  



Utilities 

IMDPlus  >  

Moving Mass >  

Moving Mass 
Analysis... 
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 Ensure Spring-mass 

system is selected  

 Ensure Extent is set to 

Individual  

 Set the System to              

32 (-195.0) CRH Train 

Wheelset   

 Set the Result to 

Unsprung mass  

 Ensure the Entity is set to 

Displacement  

 Ensure all of the selections 

in the Output control are 

identical to the previous 

analysis 

 Click the Apply to 

proceed.  

 

 

The graphs show the vertical displacement of the last sprung mass for the whole time 

history and having zoomed into the region where the dynamic behaviour is observed. 

This indicates that the displacement of the unsprung mass is zero until it enters the 

structure at about 2.34 seconds and returns to zero after it has left the structure at about 

2.8 seconds. Comparison of the vertical displacement response while the spring-mass 

system is over the beam with the first unsprung mass system above shows how the 

existing vibration of the continuous beam has altered the unsprung behaviour. 
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 When the graph has been displayed, close the graph 

If the IMDPlus toolbar has been enabled, 

 Click on the  button in the toolbar to open the IMDPlus Output Control dialog 

If the IMDPlus toolbar is not enabled, 

 Open the IMDPlus Moving Mass Analysis Control dialog through the menu and 

click Next > to keep the existing analysis control settings and open the IMDPlus 

Output Control dialog. 

  

Utilities 

IMDPlus  >  

Moving Mass >  

Moving Mass 
Analysis... 
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 Ensure Spring-mass 

system is selected  

 Ensure Extent is set to 

Individual  

 Ensure the System is set 

32 (-195.0) CRH Train 

Wheelset   

 Set the Result to Sprung 

mass 1  

 Ensure the Entity is set to 

Displacement  

 Ensure all of the selections 

in the Output control are 

identical to the previous 

analysis 

 Click the Apply to 

proceed.  

 

 

The graph shows that the sprung mass representing the body of the last wheelset of the 

train displaces almost 6.5 mm from its static position while it is over the continuous 

beam before the damping of the spring-mass system quickly damps out the body motion 

after the wheelset leaves the structure. 
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 When the graph has been displayed, close the graph 

Acceleration Time Histories of First and Last Spring-Mass 

System Bodies 

The acceleration response of the sprung masses representing the bodies of train 

locomotives and passenger cars can be used to assess the comfort level that would be 

experienced by passengers. The accelerations of the sprung mass for the first and last 

sprung mass systems will be investigated. 

If the IMDPlus toolbar has been enabled, 

 Click on the  button in the toolbar to open the IMDPlus Output Control dialog 

If the IMDPlus toolbar is not enabled, 

 Open the IMDPlus Moving Mass Analysis Control dialog through the menu and 

click Next > to keep the existing analysis control settings and open the IMDPlus 

Output Control dialog. 

  
 Ensure Spring-mass 

system is selected  

 Ensure Extent is set to 

Individual  

 Set the System to                 

1 (0.0) CRH Train 

Wheelset   

 Ensure the Result is set to 

Sprung mass 1  

 Set the Entity to 

Acceleration  

 Ensure all of the selections 

in the Output control are 

identical to the previous 

analysis 

 Click the Apply to 

proceed.  

 

Utilities 

IMDPlus  >  

Moving Mass >  

Moving Mass 
Analysis... 
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The graph shows the vertical acceleration response of the body of the first wheelset 

which experiences a maximum acceleration of +0.174 m/s
2
 or 0.018 g as it is about to 

leave the continuous beam. This peak acceleration for the first wheelset occurs while 

the dynamic response of the continuous beam is still increasing and therefore a higher 

peak acceleration might be expected for subsequent wheelsets of the train. 

 

 When the graph has been displayed, close the graph 

If the IMDPlus toolbar has been enabled, 

 Click on the  button in the toolbar to open the IMDPlus Output Control dialog 

If the IMDPlus toolbar is not enabled, 

 Open the IMDPlus Moving Mass Analysis Control dialog through the menu and 

click Next > to keep the existing analysis control settings and open the IMDPlus 

Output Control dialog. 

  

Utilities 

IMDPlus  >  

Moving Mass >  

Moving Mass 
Analysis... 
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 Ensure Spring-mass 

system is selected  

 Ensure Extent is set to 

Individual  

 Set the System to                 

32 (-195.0) CRH Train 

Wheelset   

 Ensure the Result is set to 

Sprung mass 1  

 Ensure the Entity is set to 

Acceleration  

 Ensure all of the selections 

in the Output control are 

identical to the previous 

analysis 

 Click the Finish to 

proceed. Click No when 

asked whether to free up 

disk space. 

 

The graph shows the vertical acceleration response of the body of the last wheelset and 

indicates that it experiences a maximum acceleration of -0.582 m/s
2
 or -0.059 g while it 

is about to leave the continuous beam. This peak acceleration for the last wheelset is 

significantly higher than the first wheelset as might be expected for subsequent 
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wheelsets of the train since the beam has already experienced excitation from all of the 

previous wheelsets. 

 When the graph has been displayed, close the graph 

Peak Acceleration Response of All Train Bodies 

In the previous graphs the acceleration response of the sprung masses representing the 

bodies of the first and last wheelsets representing the train were inspected. The peak 

vertical acceleration response of all of the sprung masses representing the bodies of the 

train is now inspected for the 25 kph to 600 kph speed range. 

 Open the IMDPlus Moving Mass Analysis Control dialog through the menu or click 

on the  button in the toolbar. 

 

 Ensure that the Moving 

mass input and 

Mode/damping control 

sections of the dialog are 

unchanged from the 

previous analyses  

 Enter the Minimum Speed 

as 6.944, the Maximum 

Speed as 166.667 and the 

Speed Increment as 6.944 

to analyse a range of 

speeds between 6.944 m/s 

(25 kph) and 166.667 m/s 

(600 kph) in increments of 

6.944 m/s (25 kph). 

 Ensure the Quiet time after 

passage of load is 5  

 Ensure the IMDPlus 

determining time step 

(Nyquist) option is 

deselected and the 

Solution time step is 2E-3 

 Click the Next button to proceed. When asked whether the speed range is correct 

choose Yes to continue. When prompted about missing total mass due to mass 

participation factors below 90% choose Yes to continue.  

Utilities 

IMDPlus  >  

Moving Mass >  

Moving Mass 
Analysis... 
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 Ensure Spring-mass 

system is selected  

 Set Extent to All  

 Ensure the Result is set to 

Sprung mass 1  

 Ensure the Entity is set to 

Acceleration  

 Deselect Response time 

history  

 Select Peak response 

summary and Absolute  

 Ensure all of the selections 

in the Output control are 

identical to the previous 

analysis 

 Click the Finish to 

proceed.  

 Click Yes when asked 

whether to free up disk space by deleting the temporary files created by IMDPlus. 

 

IMDPlus will perform the analysis and the graphs for all 32 of the spring-mass systems 

will be displayed and can be printed out. A sample of the graphs are shown below 

demonstrating the different behaviours of each of the sprung bodies of the train (first 

spring-mass system, sixteenth spring-mass system and the last spring-mass system). 
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The graphs of the absolute peak vertical acceleration of the sprung bodies over the 

speed range appears to indicate that the peak acceleration increases as the number of 

wheelset spring-mass systems which have already passed along the beam increases. 

This is roughly true but from inspection of each wheelset spring-mass system it can be 

seen that the absolute peak acceleration out of the whole 32 wheelsets of the train 

actually occurs at the 30
th

 wheelset, indicated in the graph below. 

For the 30
th

 wheelset the absolute peak acceleration is observed at the first resonant 

frequency equivalent to a train speed of 300 kph and is approximately 0.78 m/s
2
 or 

almost 0.08 g.  
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 Close all of the graph windows. 

Save the model 

Save the model. 

 

This completes the example. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

File 

Save… 
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